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CHAPTER 1

Welcome
Use Condor 3 to 
Explore Earth’s Digital Activity

•  144.8%billion%emails%sent%worldwide%per%day%
•  1%billion%web%sites%in%2013,%doubling%every%

18<24%months%
•  1.19%billion%Facebook%monthly%acBve%users%
•  200%million%TwiDer%monthly%acBve%users%

who%tweet%500%million%tweets%per%day%
•  32%million%pages%in%Wikipedia%with%4%million%

arBcles%

Welcome to Condor 3!

Condor 3 is a software program devel-
oped by galaxyadvisors, which enables a 
single user, a team, or a company to  
visualize and measure the structure,  
content, sentiment and influence of  
social communication networks over 
time. 
Condor 3 is available in both a desktop 
version and a server version called  
CondorCore, which is expected to be re-
leased in 2015.

See: http://www.internetlivestats.com

http://www.internetlivestats.com
http://www.internetlivestats.com


CONDOR 3:

1. Has the ability to generate interactive movies 
of communication flows for in-depth analysis.

2. Enables you to analyze different social media 
channels including: The Web, Email, 
Facebook, Twitter, Wikipedia, and more, all in 
a single visualization.

3. Runs on a Mac, a Windows PC, Linux,  
and in the Cloud.

4. Is menu driven, no programming required.

5. Can export data easily to other software 
packages for additional analysis, graphing or 
mapping.

SECTION 1

Key Features
Condor 3

Handles Gigabytes of data:

• Load: 1 million nodes / 

             20 million edges

• Process: 100,000 nodes /

                   500,000 edges 

• Visualize: 5000 nodes /

                     50,000 edges

   . . . From one or multiple sources.
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Why use Condor 3?

Condor 3 is a dynamic network analysis software package 
that can help researchers and business practitioners under-
stand social networks both inside and outside the firm.  
For example:

• Organizational communication networks and their rela-
tionship to performance at the inter-organizational,  
organization, team, and individual levels

• Innovation networks for creativity and diffusion of  
innovations

• The influence of individual members of the network
• Network reach to the community of stakeholders outside 

the organization
• How the structure of networks and the content that 

flows through them relate to each other
• Where possible bottlenecks or vulnerabilities might lie 

or where new opportunities for collaboration might be 
possible

• What customers and the media are saying about a firm’s 
products or services

• Who the major players are in a given industry or domain
• How best to communicate and through whom to get a 

message out
Condor provides the ability to visualize, monitor, measure 
and manage communication networks dynamically, over 
time.
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SECTION 2

Cost

Please contact: Peter Gloor at pgloor@galaxyadvisors.com
for commercial pricing and use.

Condor 3 is free for academic use, when users show proof of 
their academic status, such as, a web url, “name.edu” address, 
and describe the research purpose of their project.
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mailto:pgloor@MIT.edu
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1. General: Peter Gloor at 
pgloor@galaxyadvisors.com

2. This user manual: Ken Riopelle at 
kenriopelle@me.com

SECTION 3

Contacts
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Welcome Page 1 References:
Email: 
http://mashable.com/2012/11/27/email-stats-infographic/
Websites: 
http://toni.org/2012/05/03/1-billion-web-sites-in-2013/
Facebook: 
http://thenextweb.com/facebook/2013/10/30/facebook-pas
ses-1-19-billion-monthly-active-users-874-million-mobile-us
ers-728-million-daily-users/#!uCYWl
Twitter: 
http://abcnews.go.com/Business/twitter-ipo-filing-reveals-
500-million-tweets-day/story?id=20460493
Wikipedia: 
http://en.wikipedia.org/wiki/Wikipedia:Statistics

For additional internet stats see: 
http://www.internetlivestats.com

mailto:pgloor@galaxyadvisors.com
mailto:pgloor@galaxyadvisors.com
mailto:kenriopelle@me.com
mailto:kenriopelle@me.com
http://mashable.com/2012/11/27/email-stats-infographic/
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http://toni.org/2012/05/03/1-billion-web-sites-in-2013/
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://thenextweb.com/facebook/2013/10/30/facebook-passes-1-19-billion-monthly-active-users-874-million-mobile-users-728-million-daily-users/#!uCYWl
http://abcnews.go.com/Business/twitter-ipo-filing-reveals-500-million-tweets-day/story?id=20460493
http://abcnews.go.com/Business/twitter-ipo-filing-reveals-500-million-tweets-day/story?id=20460493
http://abcnews.go.com/Business/twitter-ipo-filing-reveals-500-million-tweets-day/story?id=20460493
http://abcnews.go.com/Business/twitter-ipo-filing-reveals-500-million-tweets-day/story?id=20460493
http://en.wikipedia.org/wiki/Wikipedia:Statistics
http://en.wikipedia.org/wiki/Wikipedia:Statistics
http://www.internetlivestats.com
http://www.internetlivestats.com


CHAPTER 2

Overview
Condor 3’s Main Menu

Condor 3 is a software program for the  
research analyst. As such, it is under  
continuous development and, therefore, 
requires a mindset of experimentation. 
This user manual will get you started and 
enable you to visualize and measure the 
structure, content, sentiment and  
influence of social or communication  
networks over time. 



SECTION 1

About this User Manual

This user manual is divided into nineteen chapters:

Chapter 1 Welcome 
provides a welcome message and highlights the key features of 
of the software, reasons for using it, its costs, and key  
contacts.

Chapter 2 Overview  
provides an overview of the entire manual.

Chapter 3 Installation on a Mac  
describes how to install Condor 3 on a Mac and the software 
pre-requisites of Java, MySQL database server, and the Con-
dor 3~.jar program itself. Three additional optional installa-
tions are covered which include: the free Google Custom 
Search Engine (CSE) API Key, the four free Twitter API Keys, 
and the free MySQL Workbench graphical user interface for 
the MySQL database server. Navicat is another MySQL GUI 
option, but does cost.

Chapter 4 Starting Condor 3 on a Mac  
describes two ways to start Condor 3 on a Mac.  The first 
method is via the Condor 3 ~.jar and the second method is via 
the Terminal app, which assigns a designated amount of mem-
ory to help analyze very large datasets.

Chapter 5 Installation on a PC  
describes how to install Condor 3 on a PC and the software 
pre-requisites of Java, MySQL database server, and the Con-
dor 3~.jar program itself. See Chapter 3 to learn how to install 
he free Google Custom Search Engine (CSE) API Key, the four 
free Twitter API Keys, Note: For a PC the MySQL Workbench 
is installed when MySQL is installed and does not need a sepa-
rate installation.

Chapter 6 Starting Condor 3 on a PC  
explains two different methods to start Condor 3 on a PC. The 
first method is via the Condor 3 ~.jar and the second method 
is via a .bat command file, which sets the Java path and as-
signs a designated amount of memory to help analyze very 
large datasets.

Chapter 7 Main Menu 
highlights the seven main menu items and their functions.  
Review this chapter to get an idea of all the menus and sub-
menu options.

Chapter 8 Graphical user Interface 
highlights the graphical user interface or GUI to refine your 
visualizations.
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Chapter 9 Examples 
provides examples of the types of data analysis possible includ-
ing: Email, Facebook, Web, Twitter, Twitter Account, Wiki 
Evolution and Wiki Categories. A suggested series of analysis 
steps are provided along with sample visualizations and user 
tips.

Chapter 10 Condor 3 Updates 
Documents recent Condor 3 updates in chronological order. 
As of August 3, 2015 the current version is 3.2.0 Build 1913.

Chapter 11 Bing Map for Geocoding 
explains how to use the website: 
http://www.gpsvisualizer.com/geocoder/ to find a city’s geo-
codes, map it and draw a range ring around it to have a sense 
of the geographic coverage of your Twitter Fetch. It also ex-
plains how to obtain a free Bing Map key to obtain 5 or more 
city geocodes at one time.

Chapter 12 - Nodes and Edge Properties 
Names the node and edge properties by data sources, such as , 
email, Facebook, Twitter, Twitter Accounts, Wiki Evolution 
and Wiki Categories.

Chapter 13 - Structure and Content Measures 
defines Condor 3‘s network Structure and Content Measures. 
The first section defines Structure measures or centralities for 
individual measures: betweenness, closeness and degree; and 
the group measures: group betweenness, group degree and  
density. The second section defines the five content measures: 
activity, sentiment, emotionality complexity, and influence. 

Section three articulates the Coolhunting and Coolfarming Col-
laborative Innovation Networks (COINs) and their analytics 
as described in the introduction movie by Peter Gloor.

Chapter 14 - YouTube Links  
provides the YouTube Playlists and video links for installation  
on a Mac or PC, including examples of fetching and analysis 
for Email, Facebook, Web, Twitter, Twitter Account, Wiki Evo-
lution and Wiki Categories, Social Network Basics, obtaining a 
BING May Key, a Google Map key and creating a Google Earth 
.kml file or a Google Earth zip .kmz file.

Chapter 15 - Social Network Basics 
Review this chapter if you are not familiar with the basic so-
cial network concepts of nodes and links, degree, betweenness 
centrality, etc. and popular social network books.

Chapter 16 - COINs Conferences, Websites & Publica-
tions  
lists the COINSs Conferences by year along with links to web-
sites and publications.

Chapter 17 - Recommended Books

Chapter 18 - CondorConverter  
explains how to download and use CondorConverter.  
Condor Converter is java program that coverts older Condor 
2.6.6 databases and datasets to the newer Condor 3 universal 
database and dataset format.

Chapter 19 - Frequently Asked Questions (FAQ)

8
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CHAPTER 3

Installation 
on a Mac

Condor 3 depends upon many software programs to run:
• At the lowest level is the computer’s operating system (Mac OS X, 

Windows, or Linux)
• Next is the Java Runtime Environment (JRE)
• The MySQL database server is where Condor 3 stores all the network 

data nodes and links from Facebook, Web, Twitter, Wikipedia, and 
Email. 

• MySQL Workbench acts a graphical user interface for MySQL data-
base server

• Last, the Application Program Interfaces or APIs from Google and 
Twitter enable custom query fetching.

Condor&3&So)ware&Building&Blocks&

Opera&ng)systems)(Mac)OSX,)Windows,)Linux)

Java)Run&me)Environment)(JRE))

MySQL)Database)
Server)

Google))
CSE)API)

TwiKer)
API)

Condor&3&

MySQL)Workbench)

 To install Condor 3 on a Mac requires 
Lion (10.7) or higher and the installation 
of Java 7 or 8, the MySQL database 
server, and finally the Condor 3 ~.jar.  
Note: Java 6 is not supported.
In addition, we recommend users install 
a graphical user interface for MySQL, 
such as, the free MySQL Workbench or 
other software, obtain the free Google 
Custom Search Engine (CSE) API Key to 
conduct a Google Web CSE search, and 
the four free Twitter API Keys to conduct 
a Twitter search.



SECTION 1

Install Java on a Mac
What is Java?

Java is a programming language and computing platform first 
released by Sun Microsystems in 1995. 1 

In January 2010, Oracle purchased Sun Microsystems and 
now maintains Oracle Java.

Condor 3 requires Java 7 or 8 to run. Java 6 is not supported.

1 http://www.java.com/en/download/faq/whatis_java.xml
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JAVA INSTALLATION

1. At a minimum, Mac users need Lion (10.7) or 
higher  and Java 7 or 8 Runtime Edition (JRE) 
installed. 

2. For Mac’s with Yosemite (10.10) to start 
Condor 3 from the Terminal app with a set 
amount of memory, users need to install the 
Java 8 Update 25 or later SE Development Kit 
(JDK), which is strongly recommended, 
especially when working with large networks.

3. Macs purchased on or after October 20, 2010 
do not have Java preinstalled,  
which means users need to install Oracle Java 
7 or 8,  for Lion 10.7, Mt. Lion 10.8, Mavericks 
10.9, or Yosemite 10.10.

4. Macs purchased before October 20, 2010 with 
Snow Leopard 10.6 and below need to upgrade 
to Lion 10.7 or higher and install Java 7 or  
Java 8.

Condor 3 needs Lion OS X 10.7 at a minimum.

http://www.java.com/en/download/faq/whatis_java.xml
http://www.java.com/en/download/faq/whatis_java.xml
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1. Click on the black Apple 
    in the upper left corner of your Mac

2. Click on “About this Mac

3. If your Mac OS X version is 10.7.3 or higher, then 
install Oracle Java 7 or 8 higher

4. For Mac OS X 10.6 (Snow Leopard) and below you 
need to upgrade to Lion (10.7.3) or higher to install  
Oracle Java 7 or later, and only on 64 bit systems.2

Then proceed to Step 17 and download and install 
Java 7 or 8.
  2  http://www.java.com/en/download/faq/java_mac.xml#java6

Now, for Macs with OS X 
Lion (10.7), Mt. Lion 10.8), Mavericks (10.9), 
Yosemite (10.10)

5. Click on the black Apple in the upper left 
corner of your Mac

6. Click on “System Preferences …”

http://www.java.com/en/download/faq/java_mac.xml#java6
http://www.java.com/en/download/faq/java_mac.xml#java6
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7. The System Preferences window opens

8. Do you have the Java icon? If yes, click on it

9. If you do see the Java icon, and you clicked on it, 
then Java is installed and a message appears, indi-
cating that the Java Control Panel will open in a 
separate window. Note: if you do not see the Java 
icon, then go to step 17 on page 13 and download 
Java.

10. The Java Control Panel opens
11. Click on the Update tab

12. Update Java, if needed.
Java needs updatingJava up-to-date
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Note: Continue to step 13, if Java needs updating.
13. Click Install Update 

14. Click Install and Relaunch

15. Enter Computer password, Click Install Helper

16. Click OK

17. If you do not see the Java icon in the System Pref-
erences window, then download Java at this url. 

http://java.com/en/download/manual.jsp#mac

Note: At step 16, Java is installed and updated, 
skip to install MySQL on page 14

Continue to step 17, if Java is not installed.

http://java.com/en/download/manual.jsp#mac
http://java.com/en/download/manual.jsp#mac
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19. Double click on Java package icon to install

18. Go to your Downloads folder and Double click on 
jre~.dmg file to install

20. Click “Continue” at the install window. 

21. Click “Install.” 

Java package opens
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22. Click “Close, “after Install Succeeded. 

23. Test you Java installation with this test applet at:

http://java.com/en/download/installed.jsp

24. Click “Run.”

25. Java is verified, Congratulations

http://java.com/en/download/installed.jsp
http://java.com/en/download/installed.jsp


26. If you have Yosemite (10.10), then we recommend you  
install the Java Development Kit (JDK)  8 update 25 or 
later, in order start Condor using the Terminal app to set 
a memory allocation for better response when working 
with large networks.

To install the Java JDK 8 follow these steps:

27. Download the Java 8 JDK at this link: 
http://www.oracle.com/technetwork/java/javase/downlo
ads/jdk8-downloads-2133151.html 

16

The file will be similar to :“jdk-8u25-macosx-x64.dmg”.  
The update version may change.

28. Click to Accept License Agreement. 
29. Goto your downloads folder and double click on the 

jdk-8u25-macosx-64.dmg to begin the install and fol-
low the on screen instructions. 

Then when using the Terminal app and entering this Java 
command:
 Java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar

Condor 3 will start. In this example the “2G” means allo-
cate 2 gigabyte of memory to run Condor 3.  
Change the memory allocation based upon your com-
puter’s memory installation leaving at least 1 GB for other 
operations.



SECTION 2

Install MySQL on a Mac
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The first step is to determine if your machine in run-
ning a 32 or 64 bit kernel.
1. Open a Finder window, click on Applications, scroll down 
to the Utilities folder, and then scroll down and click on the 
Terminal.app

2. Double Click the Terminal.app:

A Terminal.app window will open

MYSQL INSTALLATION STEPS

1. Identify your Mac kernel as 32 or 64 bit.  
(Don’t worry this step is easy)

2. Download and install the appropriate MySQL 
version

3. For the older MySQL 10.7 package install the 
MySQL preference pane to manually Start and 
Stop the MySQL server or enable it to start 
automatically when your Mac starts.

NOTE: The newer versions of MySQL

“MAC OS X 10.9 or 10.8 (x86, 64bit) DMG” 
files have only has one package, which 
includes the preference pane. There is no 
separate preference pane package 
installation.
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3. At the terminal prompt type:   uname –a

If you see “x86_64” at the end you are running 
64 bit, thus download and use the MySQL 64 ver-
sion.

If you see “i386” that means a 32 bit kernel, thus 

4. To download MySQL, click on this link: 

5. Login, Sign Up or, 
No thanks, just start my download

http://dev.mysql.com/downloads/mysql/

Select the appropriate Mac OS X ~.dmg file
Note: For Yosemite (10.10) download MySQL 
(10.9)

Note: Do not download the Compressed TAR 

Lion 10.7, Mt. Lion 10.8, Mavericks 10.9, Yosemite 10.10 

Apple OS X  

Select the appropriate Mac OS X ~.dmg file
Note: For Yosemite (10.10) download MySQL 
(10.9)

http://dev.mysql.com/downloads/mysql/
http://dev.mysql.com/downloads/mysql/
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6. After downloading,  
double click the .dmg file 

A window will open with one file. 

Note: The System Preferences MySQL 
prefPane will be installed with 
this one package. 

6. After downloading,  
double click the .dmg file 

Main pkg Start/Stop Only for auto start 

Note: if you are installing the older 10.7  
version, then four files will appear.

7. Double click on  your package: 
mysql-5.6.19-osx10.9-x86_64.pkg 
mysql-5.6.19-osx10.8-x86_64.pkg 
mysql-5.6.19-osx10.7-x86_64.pkg 
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10. Select English, click “Continue.”8. An installation window will open,  
    click “Continue.”

9. Click, “Continue.”
11. Click “Agree.”

Note: The newer MySQL Mac OS X 10.9 or 10.8 
installation steps have a slightly different win-
dow sequence.  
Just click through the steps.
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15. A series of installation messages will appear, with 
a final Success message. Click “Close.”

12. Click “Install.”

13. Type your computer’s password. 
14. Click, “Install Software.”

At the Installation Summary page you may get a  
message that “The Installation Failed.”
This is not true. Click Close and 
Skip to Step 19 to Start MySQL
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16. Next install MySQL PrefPane

Note: If you are installing an older version of MySQL 
(OS X 10.7 ) then install the preference pane.
Newer versions, such as, MAC OS X 10.9 or 10.8 
have the preference pane installed with the base 
package and this step is not needed.
Skip to step 19.

Note: The MySQL.prefPane enables you to Start and 
Stop the MySQL server

17. Again, double click the dmg file. 
 

A set of four files will appear. 
 

Main pkg Start/Stop Only for auto start 

18. Double click the MySQL.prefPane. 
 

Follow the install instructions. 
Note: you only need to install this once. 
 

Note: This completes the one time MySQL installation. 
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To start the MySQL server:
 
19. Click the Black Apple in the upper left corner.

20. Click “System Preferences ...”

21. Under Other, click the MySQL icon 

22. At the prompt, Click “Ok.”

23. Click the “Start MySQL Server” button 
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24. Enter your computer’s password. 
25. Click, “OK.”  

26. A message will appear stating that MySQL server 
instance is running 

To learn more about MySQL go to:

Note: To Stop the MySQL server, click the “Stop 
MySQL Server” button.
If you wish, you can automatically have the MySQL 
start on Startup by checking that option.

27. https://www.youtube.com/ 
28. In the YouTube search box, type in: 
 how to get started with mysql

Note: Here you will find a number of MySQL video tutorials

Other online MySQL Resources are:
Manuals:
http://dev.mysql.com/doc/

www.MySQL.com

www.Oracle.com

https://www.youtube.com
https://www.youtube.com
http://dev.mysql.com/doc/
http://dev.mysql.com/doc/
http://www.MySQL.com
http://www.MySQL.com
http://www.Oracle.com
http://www.Oracle.com


CONDOR 3 INSTALLATION STEPS

1. Complete Condor 3’s Sign up Form to obtain 
your license key.

2. Validate your email address

3. Download Condor 3 from the License Manager.

4. Start Condor 3 and enter your license key.

5. After the 14 day trial period ends, users need to 
email Peter Gloor at: 
pgloor@galaxyadvisors.com and request a 
yearly license for a commercial use or a free 
academic license.

With the installation of Java, MySQL, and the Condor 3 
~.jar, this will complete the minimum requirements to 
start Condor 3.

Note: it is recommended to continue and install the 
Google CSE API Key, the four Twitter API Keys, and 

SECTION 3

Install the Condor 3~.jar
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1. Complete Condor 3’s Sign up Form to obtain 
your license key at:

http://guardian.galaxyadvisors.com/guardian/

A Welcome message appears 
Click Sign up 

mailto:pgloor@galaxyadvisors.com
mailto:pgloor@galaxyadvisors.com
http://guardian.galaxyadvisors.com/guardian/
http://guardian.galaxyadvisors.com/guardian/
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2. Complete Condor 3’s Sign up form, and
     Then click “Sign up.”

3. A validation message displays, click OK. 

4. Check your email and validate your email  
    address. Click “Verify email address.”



A License Confirmation email sent 

Note: You may return to the License Manager link to Sign in, 
  Reset your password, or Download an updated version 

5. Download the latest version of Condor 3  
from the License Manager link

6. Select and Copy your License key

27

Important Note:
After the 14 day trial period ends, users need to email Peter 
Gloor at: pgloor@galaxyadvisors.com and request a yearly 
license for:
• A commercial license for commercial use, or
• A free academic license showing proof of their academic 

status, such as, a web url, “name.edu” address, and de-
scribe the research purpose of their project.

After your request is approved and processed, you will re-
ceive a confirmation email. Users may Login to the Condor 
License Manager at 
http://guardian.galaxyadvisors.com/guardian/
and confirm their license type has been updated from 
“TRIAL” to “YEAR”. Then the next time you start Condor 3 
with an internet connection, your updated user license will 
be authenticated and Condor 3 will be available for use.

mailto:pgloor@galaxyadvisors.com
mailto:pgloor@galaxyadvisors.com
http://guardian.galaxyadvisors.com/guardian/
http://guardian.galaxyadvisors.com/guardian/


7.  After the file is downloaded you will see 
the Condor 3 jar in your Mac 
Downloads 

 

8.  Using Finder create a New Folder, 
such as “Condor3” and then copy and 
paste the Condor 3~. jar file” into it. 

 
You should see a file similar to this in your “Condor3” 
folder: 

9.  Remember to Start MySQL if you have 
not done so. 

10. In the Condor folder, 
Right Click the “Condor-3 ~.jar.” 
Select “Open With” and “Jar Launcher” 

  

11. Click, Open. 

Note: You only have to do this the first time. 
Afterwards you can just double click the Condor 3 ~ jar. 
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12. Condor 3’s loading screen appears 
 
 
13. Enter or paste in your license key,  

Click OK. Note: you only do this once. 

14. Next, a set database credentials 
window opens. Enter your MySQL 
password, if you have one, or just click, 
OK. 

Condor 3’s Main Menu 

This completes the Condor 3 installation steps. 
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GOOGLE CSE API INSTALLATION STEPS

NOTE: UPDATED AS OF 8/11/2015.

1. Create a Google account, if you do not already 
have one

 https://accounts.google.com/signup?service=mail

2. Sign in to the Google Console and create a CSE 
API Key

 https://code.google.com/apis/console/

3. Start Condor 3, do a Web Fetch and enter in 
your Google CSE API Key and the Condor CX 
Key. Only required first time.

SECTION 4

Install Google CSE API Key
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Create a Google Account, if you do not have one.
If you have a Google account, such as, a gmail email 
address, then skip to step 2.

1. Go to this Google accounts URL and sign up:
https://accounts.google.com/signup?service=mail

2. Go to this Google console URL and sign in:
https://code.google.com/apis/console/

Note: The next web page that displays depends upon your 
Google account and existing projects.

3.  

Click 

https://accounts.google.com/signup?service=mail
https://accounts.google.com/signup?service=mail
https://code.google.com/apis/console/
https://code.google.com/apis/console/
https://accounts.google.com/signup?service=mail
https://accounts.google.com/signup?service=mail
https://code.google.com/apis/console/
https://code.google.com/apis/console/
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4. Enter “Custom Search API”  into the search box
5. Click on Custom Search API link

6. Click on the blue Enable API

7. The Custom Search API is now enabled
The hot link terms: Overview, Usage, Quotas
will provide additional information

Enter 

Click 

Click 

Usage Quotas 

NOTE: First 100 searches per day are free
For more information on billing, see: 
https://developers.google.com/console/help/new/#billing

https://developers.google.com/console/help/new/#billing
https://developers.google.com/console/help/new/#billing
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9. Save your Google CSE API Key 

Next Steps
• Start Condor 3 do a Web Fetch
• Enter your Google CSE API Key, and
• Enter the Condor CX Key:
 000229616349723713761:mlcaolv1mpw
Note: these keys will be saved in a file called 
“condor.properties”

10. Start Condor 3
• Remember to start MySQL first
11. Create or switch to your database and open an ex-

isting dataset or create a new one.

8. Now, click “Credentials” on the left under
“APIs & auth”

Click 

AIxxxxxxxxxxxxxxxxxxxxxxxxxxx 

Your name@gmail.com 
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Do a Web Fetch
12. Select Google CSE
13. Enter your Google CSE Key:
14. Enter the Condor CX key: 

Note: Alternatively, after you obtain your Google 
CSE API key, you can edit the “condor.properties” 
file located in the your folder where the Condor 
3~.jar is found and paste in your Google CSE API 
Key and the Condor CX API Key.

Sample Condor 3 Google CSE Web Fetch Results

The CSE and CX Keys are saved in 
condor.properties file

XXXXXXXXXXXXXXX 

XXXXXXXXXXXXXXX Your personal key 

Condor Provided Key 

Note: Return to the Google Console for APIs Reports
https://code.google.com/apis/console

Usage Quotas 

https://code.google.com/apis/console
https://code.google.com/apis/console


TWITTER API KEYS INSTALLATION STEPS

1. Create a Twitter account, if you do not already 
have one.

  https://twitter.com/login

2. Create a new Twitter app, which enables you to 
obtain the four Twitter API Keys.

 https://apps.twitter.com 

3. Copy the four required Twitter API Keys into the 
“condor.properties” file

Note: You only do this once.

After the four Twitter Keys are entered into the 
“condor.properties” file then you can do a Condor3 
Twitter Fetch.

 

SECTION 5

Install Twitter API Keys
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Preliminary Step
To create the “condor.properties” file:
• Start MySQL, start Condor 3
• Switch or create to your desired database and cre-

ate or open a dataset.
• Select Fetch Twitter under the Fetch menu 

This will create the “condor.properties” file, which is 
located in the same folder where the Condor 3~.jar 
is found.
Note: you only have to do this once.

condor.properties file

https://twitter.com/login
https://twitter.com/login
https://apps.twitter.com
https://apps.twitter.com
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1. Create a Twitter account, if you do not have one
2.Click on this link and  select Sign up now.
https://twitter.com/login

2. Sign in to create a new Twitter app

If  you do have a Twitter account, skip to step 2.

3. Enter your Twitter Username or email and pass-
word

https://apps.twitter.com

4. Click, Create New App

https://twitter.com/login
https://twitter.com/login
https://apps.twitter.com
https://apps.twitter.com
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6. Scroll down, and check I agree

5. Click, Create New App

7. Scroll to the bottom of the form,

8. Click, Keys and Access Tokens, or  

Note: Needs to be a unique name 

Note: Leave blank 

9. At bottom of page, under “Token Actions,”  
Click “Create my access token”

Two of the four Twitter app API Keys are created.
Another step will create two more Token Access 
Keys.

This will create the remaining two  Token Access 
Keys.
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10. Click, “Refresh” in the Status message 

11. After page refreshes, the four Twitter API Keys 
are now created to use with Condor 3’s Twitter 
Fetch:

Be careful to match the correct key, they are not in 
the same order.
Paste each API Key on the right side of the “=“ sign.

Or, when doing a Twitter Fetch, a window will open, 
and 
Enter your four Twitter API keys.

Be careful to match the correct key, they are not in 
the same order.
Note: the next time your four Twitter API Keys will 
be displayed.

13. Sign out

To Log back in:
https://apps.twitter.com

XXXXXXXXXXXXXXX 

XXXXXXXXXXXXXXXXXX 

XXXXXXXXXXXXXXXXXX 

XXXXXXXXXXXXXX 

12. Copy and paste the 4 
keys one at a time into 
“condor.properties” file 

XXXXXXXXXXXXXXXXXX 

XXXXXXXXXXXXXXXXXX 

condor.proeprties Names 

twitter.oauth.accessToken= 

twitter.oauth.consumerSecret= 

twitter.oauth.consumerKey= 

twitter.oauth.accessTokenSecret= 
 

XXXXXXXXXXXXXXX 

XXXXXXXXXXXXXX 

XXXXXXXXXXXXXXX 

XXXXXXXXXXXXXX 

XXXXXXXXXXXXXXXXXX 

XXXXXXXXXXXXXXXXXX 

condor.proeprties Names 

https://apps.twitter.com
https://apps.twitter.com
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14. Start Condor 3
Remember to start MySQL first
15. Create or switch to your database and open and 
existing dataset or create a new one.

17. Your four Twitter Keys will be displayed, or enter 
them, click Next

Do a Twitter Fetch
16. Enter  a query, click Next

Condor 3 Twitter Fetch Results



39

A few additional notes about the Twitter API

Note: New Twitter Rate Limits for V1.1 
“Rate limits in version 1.1 of the API are divided into 15 minute 
intervals, which is a change from the 60 minute blocks in version 1.0.” 
 
“Search will be rate limited at 180 queries per 15 minute window for 
the time being.” 
 

See: https://dev.twitter.com/docs/rate-limiting/1.1

You may get a Twitter error message , like the follow-
ing.  If so, just wait 15 minutes and try again.

https://dev.twitter.com/docs/rate-limiting/1.1
https://dev.twitter.com/docs/rate-limiting/1.1


MYSQL WORKBENCH INSTALLATION STEPS

Note: MySQL Workbench is free and available for 
Windows, Mac OS X and Linux. These 
instructions  are for a Mac OS X.

1. Download MySQL Workbench at:

http://dev.mysql.com/downloads/workbench/

2. Select your Operating System platform: 
Windows, Mac OS X,  or Linux, choose Mac

3. Begin Download by Login, Sign Up,  
or No Thanks option

4. Locate “msql-workbench~.dmg file in 
Downloads Folder

5. Double click on file to install

6. Drag icon to Applications

7. MySQL Workbench is now installed in 
Applications folder

SECTION 6

Install MySQL Workbench
On a Mac
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http://dev.mysql.com/downloads/workbench/
http://dev.mysql.com/downloads/workbench/


What%is%MySQL%Workbench?%

MySQL%Workbench%is%a%unified%visual%tool%for%database%architects,%developers,%and%
DBAs.%MySQL%Workbench%provides%data%modeling,%SQL%development,%and%
comprehensive%administraCon%tools%for%server%configuraCon,%user%administraCon,%
backup,%and%much%more.%MySQL%Workbench%is%available%on%Windows,%Linux%and%
Mac%OS%X.%

Installation Steps:

4.#Begin#Download#by#Login,#Sign#Up,#or#No#Thanks#

5.#Locate#“msql/workbench~.dmg#file#in#Downloads#Folder#

6.#Double#Click#on#file#to#Install#

7.#Drag#icon#to#
ApplicaDons#
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1.#Download#MySQL#Workbench#at:#

2.#Select#your#Opera=ng#System#plaAorm#
#####Windows,#Mac#OS#X,#Linux,#choose#Mac#OS#X#
3.#Click#Download#

http://www.mysql.com/products/workbench/

http://www.mysql.com/products/workbench/
http://www.mysql.com/products/workbench/


8.#A#copy#message#appears#

9.#When#completed,#the#MySQLWorkbench.app#is#in#
applica>ons#folder#

10.#Start#your#MySQL#server#
11.#Double#click#on#MySQLWorkbench.app#to#start#
12.#Click#Open#at#message#

13.$The$MySQL$Workbench$Main$Screen$appears$
14.$Click$on$Local$Instance,$which$displays$local$port$#$

15.$MySQL$WorkBench$Local$Instance$Window$opens$
16.$Click$on$SCHEMAS$expand$double$arrow$icon$to$expand$

Click$on$SCHEMAS$
Expand$arrow$to$expand$
Then,$Click$on$your$desired$$
Database/Schema$

17.$Select$a$Database$
18.$Expand$Tables$

19.$Review$Tables$and$Columns$
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20#.#Right#click#on#a#Table,#
21.#Choose#“Select#Rows#–#Limit#1000”#
Then#Table#data#appears#in#window#

Right#Click#on#a##
Table#Name#

22.#For##14#minute#MySQL#Workbench#Tutorial#see:#

23.$Download$the$372$page$MySQL$Workbench$manual$at:$
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https://www.youtube.com/watch?v=X_umYKqKaF0

http://downloads.mysql.com/docs/workbench-en.pdf

https://www.youtube.com/watch?v=X_umYKqKaF0
https://www.youtube.com/watch?v=X_umYKqKaF0
http://downloads.mysql.com/docs/workbench-en.pdf
http://downloads.mysql.com/docs/workbench-en.pdf


SECTION 7

Install Navicat for Mac 
MySQL
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Install Navicat for Mac MySQL 
1. Start your browser
2. Go to this URL:
http://www.navicat.com/download/navicat-for-mys
ql
3. Click on a Navicat for MySQL Download location 
button.

4. Note: if you wish free 30-day support, register be-
fore downloading at:

https://customer.navicat.com

NAVICAT FOR MAC MYSQL INSTALLATION STEPS

NOTE: Navicat is optional and not required.  
It is alternative to the MySQL WorkBench.

1. Check System Requirements to confirm you 
have Mac OS X 10.6 (Snow Leopard) or higher.

2.  Download free 30-day trial at:

 http://www.navicat.com/download/navicat-
for-mysql

3. Double click on navicat~.dmg to install

4. Agree to enduser agreement

5. Drag Navicat to Applications folder

Note: Remember to start MySQL before starting 
Navicat. If purchased, enter 16 digit registration 
key and click Activate for online activation.

Navicat Pricing at:

http://www.navicat.com/store/navicat-for-mysql

http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
https://customer.navicat.com
https://customer.navicat.com
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/download/navicat-for-mysql
http://www.navicat.com/store/navicat-for-mysql
http://www.navicat.com/store/navicat-for-mysql


45

5. After downloading, go to your downloads folder 
and double click on the “navicat~.dmg” file to start 
the install process.

6. Click, “Agree” to end user agreement.

8. Next, to start Navicat, first start your MySQL 
server, if it is not configured to start automatically  
Recall,  
a. Click the black Apple in the upper left corner 
b. Click “System Preferences …”  
c. Double click the MySQL icon  
d. Click “OK” at the message  

e. Click “Start My SQL server”

 f. Enter your Computer password  

7. Drag Navicat to your Applications folder to install.
 Note: A copy message will appear. After the file 
has been copied, close the window, Navicat for 
MySQL is now installed in your Applications folder.
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MySQL is now running. 

Continue to Start Navicat for MySQL
9. In the Applications folder, double click on the 
“Navicat for MySQL.app” to start it.

10. Click Open at the message 

11. Click “Trial,”
       Or “Registration,” if purchased.

 Note: if purchased, when first started, enter the 16 
digit Registration Key and click Activate.

12. Click on “localhost” to see databases
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Next time you start Navicat ...
a. Start MySQL server, if needed
b. In the Applications folder double click on the 
“Navicat for MySQL.app” to start it.
c. Enter your MySQL server password, if you have  
one, or just press return.
Navicat starts

13. Enter your MySQL password,  
       If you have one.
14. Click, “OK.”

Navicat is ready to use

MySQL 

Note: Navicat for Mac MySQL Prices at:
http://www.navicat.com/store/navicat-for-mysql

http://www.navicat.com/store/navicat-for-mysql
http://www.navicat.com/store/navicat-for-mysql


CHAPTER 4

Starting 
Condor 3 on 
a Mac 3
There are two ways to start Condor 3:
1. Click on the Condor 3~.jar
2.Use a Java Terminal.app command

Note: Remember to start MySQL first

It is recommended to start Condor 3 
with the Terminal.app because it is not 
only more efficient, but Java often does 
not allocate sufficient memory to work 
with large files.



STARTING CONDOR 3 VIA THE .JAR

1. Right click on the Condor ~3.jar

2. Open with the “Jar Launcher”

Note: Remember to start MySQL first

You only have to do this the first time.

Afterwards you can just double click the

Condor 3 ~ jar. 

SECTION 1

Starting Condor 3 via .jar
Remember to start MySQL if you have not done so.
1.In the Condor folder, 
Right Click the “Condor-3 ~.jar.”  
Select “Open With” and “Jar Launcher”

2. Click, Open.

Note: You only have to do this the first time.
Afterwards you can just double click the
Condor 3 ~ jar.
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3. Condor 3’s loading screen appears



4. Enter or paste in your License Key:
Note: you only have do this once.
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5. Next, a set database credentials window opens. 
     Enter your MySQL password, if you have one.
     Or, just click, “OK.”

Condor 3’s Main Menu Opens

Next it is recommended to . . .
•  Install the Google CSE API Key, 
• Install the Twitter API Keys, and 
• Install the MySQL WorkBench GUI in-

terface for the Mac.  
Note: On a PC, the MySQL WorkBench 
is automatically installed with the 
MySQL database server



STARTING CONDOR 2 VIA THE TERMINAL.APP

1. Use the Terminal.app with a Java command 
that allocates a set amount of memory to run 
Condor 3. 

For example, 

java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar

The “2G” sets the memory use.

2. Create a text file, such as, 
“Condor3_Terminal.txt” to save the Java 
command for reuse.

It is recommended to start Condor 3 with the 
Terminal.app because it is not only more efficient, 
because Java often does not allocate sufficient 
memory to work with large files.

Note: MAC users with Java 8 need to install the 
Java Development Kit (JDK) to start Condor with 
the Terminal app. See Chapter 3 for details.

SECTION 2

Starting Condor 3 via Ter-
minal App Terminal.app

Remember to start MySQL if you have not done so.
Use the Terminal.app with a Java command that allo-
cates a set amount of memory to run Condor 3.
 Allocating more memory is more efficient to work with 
large files 
1. Create a text file, such as , “Condor3_Terminal.txt” 

with this java command:
java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar
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Note: In this example, 2GB on a MacBook Pro with 
4GB of memory will be used to run Condor 3 
Condor 3 has been run with 100s of GB in the cloud

2. Click on the Spotlight magnifying glass, in the upper 
right corner, and type in the word: Terminal

3.  Click on the Terminal.app, to start it

A Terminal window will open
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4. In the Terminal window, type:     cd  
and then press the space bar once.
 “cd” means “change directory”
5. Next, use Finder to select your Condor3 folder 
and drag it over into the Terminal window, which 
will be indicated by a green + and the folder name, 
and release, and press return/enter.

You should see your Condor 3 directory or folder name in 
the file path, such as, Condor3 underlined in red above.

6.  Copy and paste the Java command :
java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar
into the Terminal window. Press enter/return

Condor will now start with the specified memory allocation

The Condor loading screen appears

7. Next, a set database credentials window opens. 
     Enter your MySQL password, if you have one.
     Or, just click, “OK.”

Condor 3’s Main Menu Opens



CHAPTER 5

Installation 
on a PC
There are four steps to installing 
Condor 3 on a PC:
1.Check to make sure you have all the Mi-

crosoft High Priority Updates installed
2.Check to make sure you have the latest 

Java 7 or 8 update installed.
Note: Java 6 is not supported.

3.Install the MySQL database server, and 
4.Install the Condor 3 software

Note: The MySQL Workbench software 
which acts as graphical user interface for 
the MySQL server will be installed with 
the MySQL installation.

Condor&3&So)ware&Building&Blocks&

Opera&ng)systems)(Mac)OSX,)Windows,)Linux)

Java)Run&me)Environment)(JRE))

MySQL)Database)
Server)

Google))
CSE)API)

TwiKer)
API)

Condor&3&

MySQL)Workbench)

Condor 3 depends upon many software programs to run:
• At the lowest level is the computer’s operating system (Mac OS X, 

Windows, Linux)
• Next is the Java Runtime Environment (JRE)
• The MySQL database server is where Condor 3 stores all the network 

data nodes and links from Facebook, Web, Twitter, Wikipedia, and 
Email. 

• MySQL Workbench acts a graphical user interface for MySQL data-
base server

• Last, the Application Program Interfaces or APIs from Google and 
Twitter enable custom query fetching.



INSTALL MICROSOFT UPDATES

This section describes how to install Microsoft 
updates. 

SECTION 1

Install Microsoft Updates
Note: 

This illustration uses AWS Workspaces.

A Windows 8 or higher version may vary slightly. 

Amazon Workspaces uses a Windows Server 2008 R2 SP1, 
(version 6.1 Build: 7601, SP1).

To identify what version of Windows you are running, 

go to Start and type in:     winver         and press Enter.

A window will pop up with the Windows version you are run-
ning.  Windows 7 is version 6.1 (Build: 7601, SP1)
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http://en.wikipedia.org/wiki/Windows_7

http://en.wikipedia.org/wiki/Windows_7
http://en.wikipedia.org/wiki/Windows_7


Step 1: Check that your Microsoft High 
Priority Updates are installed 

1. Click, the Windows Start (a) > All Programs (b)> Windows Update (c) 

a.  

b.  

c.  

2. In the left hand panel, Click Check for updates  

3. If needed, install updates until Windows is up to date. 
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INSTALL JAVA ON A PC

This section describes how to install or update 
Java on a PC.

Java 7 or 8 is requited. Java 6 is not supported.

What is Java?

Java is a programming language and computing 
platform first released by Sun Microsystems in 
1995. 1 

In January 2010, Oracle purchased Sun 
Microsystems and now maintains Oracle Java. 
Condor 3 requires Java to run.

1 http://www.java.com/en/download/faq/
whatis_java.xml

Java is free.

SECTION 2

Install Java on a PC
Step 2: Install or update Java

1.  Start your browser, such as Safari, 
Firefox, IE, etc. 

2.  Go to this URL: 
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http://www.java.com/en/download/testjava.jsp

http://www.java.com/en/download/faq/whatis_java.xml
http://www.java.com/en/download/faq/whatis_java.xml
http://www.java.com/en/download/faq/whatis_java.xml
http://www.java.com/en/download/faq/whatis_java.xml
http://www.java.com/en/download/testjava.jsp
http://www.java.com/en/download/testjava.jsp


3.  Click Agree and Continue 

If the latest version of Java is installed, then you 
will get a message like this. 

4. If not, Click GO 
The next series of steps will install Java  

5. Click Free Java Download 
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http://www.java.com/en/

http://www.java.com/en/
http://www.java.com/en/


6. Click on Windows Offline 32-bit 

7. Click Save 

8. Go to your Downloads Folder and 
double click on the jre~.exe file 

9. Click Yes 

10. Click Install 
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http://www.java.com/en/download/manual.jsp?lo
cale=en

http://www.java.com/en/download/manual.jsp?locale=en
http://www.java.com/en/download/manual.jsp?locale=en
http://www.java.com/en/download/manual.jsp?locale=en
http://www.java.com/en/download/manual.jsp?locale=en


11. A Java Setup Process bar appears 

12. A Java Complete messages appears 
that you have successfully installed Java 

13. Click Close 

14. Click Start  > All Programs >Java > 
Check for Updates” 

15. Click Update Tab, Update Now. 

To check for Java Updates 

You have completed two of the four steps to installing 
Condor 3 on a PC. 
1.  All the Microsoft High Priority Updates are installed 
2.  The latest Java update is installed. 
 
The Next two steps are: 
1.  Install the MySQL database server 
2.  Install the Condor 3 software 
 

✔ 

✔ 
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INSTALL MYSQL ON A PC

This section describes how to install MySQL on a 
PC. 

You have completed two of the four steps to installing 
Condor 3 on a PC. 
1.  All the Microsoft High Priority Updates are installed 
2.  The latest Java update is installed. 
 

The Next two steps are: 
3.  Install the MySQL database server, and 
4.  Install the Condor 3 software 
 

Note: The MySQL Workbench software which acts as 
graphical user interface for the MySQL server will be 
installed with the MySQL installation. 
 

✔ 

✔ 

SECTION 3

Install MySQL on a PC
Step 3: Install MySQL

1.  Start your browser: IE, Safari, Firefox, etc. 

2.  Go to this URL: 
 
 

3.  Click the Download button for MySQL 
Installer 5.6 for Windows 

Note:  
Different browsers have slightly different 
page rendering and security messages 
prompts, but the following steps will serve 
as a close guide for you to follow. 
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http://dev.mysql.com/downloads/mysql/

http://dev.mysql.com/downloads/mysql/
http://dev.mysql.com/downloads/mysql/


4. Click, Download 
Note: The “web-community” option assumes you have an internet 

connection to your PC or AWS Workspace during installation 

5. Click: Login, Sign up, or  
“No thanks, just start my download” 

6. Click Save 
 
 
 
7. Go to your Downloads Folder and double 

click on the file “mysql~.msi” file 
 
 

8. Click Run 
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http://dev.mysql.com/downloads/windows/installer/5

http://dev.mysql.com/downloads/windows/installer/5.6.html
http://dev.mysql.com/downloads/windows/installer/5.6.html


9. Click Yes 

10. Click Install MySQL Products 

11. Check the box, “I accept the license terms” 
12. Click Next. 

 
 

13. Click Execute 
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14. Click Next (after “operation is complete) 
 

15. Choose Developer, Click Next 
 

Installs the MySQL Server and the tools required for MySQL application 
development. This is useful if you intend to develop applications for an existing Note 
 
This Setup Type includes: 
•  MySQL Server 

•  * MySQL Workbench 
The GUI application to develop for and manage the server. 
 
* MySQL Visual Studio Plugin 
To work with the MySQL Server from VS. 
 
* MySQL Connectors 
Connector/Net, Java, C/C++, OBDC and others. 
 
* Examples and tutorials 
To help you get started with your development. 
 
* Documentation 
Allows you to read the documentation offline. 

Note: Developer Installs the following: 
 

16. Click Execute, to add required software 
Note: The required list of software will vary depending upon your 
existing software installation. 
Here are two examples. 
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18. Click Finish 
 

Note: If you have more than one added pre-requisite software to install, 
you will be stepped through additional installations. 
 
For example, here is second required installation and the four next screens 
(a ,b, c and d). 

a.  b.  

c. d. 

19. Click Next (final requirement installed) 
 

64

17. Check “I have …”, and Click Install 
 



20. Click Execute 

21. Click Yes (Note: you did not need this to run Condor 3) 

22. Click Next after all the files have been downloaded 

23. Click Next 

65



24. Click Next 

25. Click Next 

26. Create a Root Password is required 
27. Add a User Account and Password 
28. Click Next 
Note: this screen may vary, with asking for the current root password and others not. 

29. Click Next 
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30. Click Next, Note: ignore error if present 

31. Click Finish 

32. MySQL Workbench starts after a short time 

33. Click on Instance 

34. Click on Management, Server Status 
This Confirms MySQL is running ☺ 
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Note: The MySQL 5.6 Server Reference Manual 
(31.5 MB) can be downloaded at: 

You have completed three of the four steps to installing 
Condor 3 on a PC. 
1.  All the Microsoft High Priority Updates are installed 
2.  The latest Java update is installed. 
3.  Install the MySQL database server 
 
Next, and last step: 
4.  Install the Condor 3 software 
 

✔ 

✔ 

✔ 
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http://downloads.mysql.com/docs/refman-5.6-en.a4.pdf
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INSTALL THE CONDOR 3~.JAR

This section describes how to install the Condor 3 
~.jar software.

You have completed three of the four steps to installing 
Condor 3 on a PC. 
1.  All the Microsoft High Priority Updates are installed 
2.  The latest Java update is installed. 
3.  Install the MySQL database server 
 
Next, and last step: 
4.  Install the Condor 3 software 
 

✔ 

✔ 

✔ 

 

SECTION 4

Install the Condor 3 ~.jar 
on a PC

Install Condor 3 - Overall Steps

http://guardian.galaxyadvisors.com/guardian/ 
 

1.  Complete Condor 3’s Sign up Form to obtain your license key: 

2.  Validate your email address 

4. Start Condor 3 and enter your license key: 

3. Download Condor 3 from the License Manager link  

69

Note: 
After the 14 day Condor 3 trial period ends, users need 
to email Peter Gloor at: pgloor@galaxyadvisors.com 
and request a yearly license for a commercial use or a 
free academic license.

mailto:pgloor@galaxyadvisors.com
mailto:pgloor@galaxyadvisors.com


1.  Complete Condor 3’s Sign up Form 
to obtain your license key: 

A Welcome message appears 
Click Sign up 

2. Complete Condor 3’s Sign up form, and
     Then click “Sign up.”
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3.  A validation message displays, 
Click Ok. 

4.  Check your email and validate your 
email address 

A License Confirmation email sent 

Important Note: 
After the 14 day trial period ends, users need to email Peter Gloor at: 
pgloor@galaxyadvisors.com and request a yearly license for: 
•  A commercial license for commercial use, or 
•  A free academic license showing proof of their academic status, 

such as, a web url, “name.edu” address, and describe the research 
purpose of their project. 

 
After your request is approved and processed, you will receive a 
confirmation email. Users may Login to the Condor License Manager 
at http://guardian.galaxyadvisors.com/guardian/ 
and confirm their license type has been updated from “TRIAL” to 
“YEAR”. Then the next time you start Condor 3 with an internet 
connection, your updated user license will be authenticated and 
Condor 3 will be available for use. 
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5.  Download the latest version of Condor 3  
from the License Manager link 

6.  Select and Copy your License key 

Note: You may return to the License Manager link to Sign in, 
  Reset your password, or Download an updated version 

http://guardian.galaxyadvisors.com/guardian/ 
 

7.  Under My Documents, create a new 
folder “Condor3” 

8.  4. Move the Condor3~.jar into that folder 

72



CHAPTER 6

Starting 
Condor 3 on 
a PC
There are two options to start Condor 3:
1. Double Click on the Condor~.jar, Or
2. Use a Condor3.bat command file and 
set the Java path and memory
It is recommended to use the .bat com-
mand file to ensure Condor 3 has enough 
memory to use, especially when working 
with large files.
Note: Before starting Condor 3 make sure your 
computer has an internet connection for the Con-
dor server to validate your License and MySQL is 
running.

Starting Condor 3 on a PC:
Option 1

1. Double Click on the Condor~.jar 

2. Loading Condor message appears 

3.  Enter or paste in your license key,  
Click OK. Note: you only do this once. 



4.  Next, a set database credentials 
window opens. Enter your MySQL 
password, if you have one, or just click, 
OK. 

 Note: If you received the error on MySQL Install step about “using 

        password: Yes”, then no Password is needed. Just click OK. 
 

5. Condor 3 starts and is ready to use 

Starting Condor 3 on a PC: 
Option 2

1.  Save the following two Java commands in 
a file called: Condor3.bat 

set path=%path%;C:\Program Files (x86)\Java\jre7\bin

java –Xmx2G -jar Condor-3.2.0.jar

2. Double click on the Condor3.bat file to start  
Condor 3 with a set memory 

Note: Change the “2G” to the desired memory allocation. 
And, adjust the set path depending upon what version of Java you 
have installed, such as, “jre8” , where it is located, and the Condor 
jar version. 
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3.  Enter or paste in your license key,  
Click OK. Note: you only do this once. 

4.  Next, a set database credentials 
window opens. Enter your MySQL 
password, if you have one, or just click, 
OK. 

 Note: If you received the error on MySQL Install step about “using 

        password: Yes”, then no Password is needed. Just click OK. 
 

5.  Condor 3 starts and is ready to use 
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CHAPTER 7

Main Menu

Condor 3 is menu driven software  
program. 

No programming is required. 

The purpose of this chapter is to reveal 
Condor 3’s menu structure and  
fundamental process steps.

Note: Review Chapter 10 for up-
dates to the menus and submenus.



CONDOR 3’S MAIN MENU

There are seven main menu choices

1. File - create and use databases and datasets

2. Fetch - retrieve social network data

3. Process dataset - filter, calculate, annotate

4. View - visualize static, dynamic, geographic, word, 
actor, adjacency, activity, sentiment and social 
surface views

5. Analyze - create collapse graph, term graph, and 
CoolPeople

6. Export - data and measures

7. Help - Condor 3 version and manual download links

Note: use these seven menus and their sub-menus to 
retrieve, visualize and measure the structure, 
content,sentiment, and influence of social 
communication networks over time. Import and export 
datasets using the Condor Data format (.cdf) for easy 
sharing and backup. Export dataset and measures to 
other software for additional analysis.

SECTION 1

Main Menu At-a-Glance
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Condor&3’s&Main&Menu&At1A1Glance&

1. File: Create and switch databases; create, open, delete and 
merge datasets; Open a dataset with a two stage filtering se-
quence, which includes the use of  Boolean logic to restrict Ac-
tors and/or Links; Import/Export Condor~.cdf files;  
Import CSV node and edge files; Import MySQL files, and 
Exit the program.

2. Fetch: Email, Outlook Exchange Calendar and email, Face-
book, Web, Twitter, Twitter Accounts, Wiki Evolution, Wikipe-
dia categories

3. Process dataset: 
a. Prune, merge, remove, sample and filter by properties
b. Calculate centralities, oscillations, contribution index, 

AWVCI, turn-taking, graph density, sentiment and influ-
ence measures

c. Annotate by language, location, or remove all HTML
4. View: 
 a. Create: static and dynamic visualizations and word clouds

b. Plot: Actor Scatter Plot, Adjacency Matrix Plot, Contribu-
tion index, Group Centrality Measures (degree, between-
ness, density), and 

c. Graph: Activity, Sentiment, Emotionality, Complexity, 
      Temporal Social Surface view, Geographic view and  
       Word Usage over time
5. Analyze: Create a collapse graph, term graph; CoolPeople
6. Export: Data as CSV, time series, MySQL dump, turn-taking, 

and dataset properties
7. Help: About Condor 3: version name, release date and build 

number, manual download links and unregister license to mi-
grate to another device.. 
 



CONDOR 3’S BASIC PROCESS STEPS

1. File: The first step is to use the File menu to create or switch to a new 
project Database and create a new Dataset or Open an existing dataset, 
which has a two stage filter sequence, that includes the use of  Boolean 
logic to restrict Actors and/or Links. The File menu can also be used to 
Import/Export Condor ~.cdf (condor data format) files; Import CSV 
node and edge files; Import MySQL files, and Exit the program.

2. Data Fetching: use the Fetch menu to collect the desired data. Use the 
File menu again to repeat creating a new dataset and then use the 
Fetch menu to collect another type of data. Google CSE web fetching 
and Twitter fetching require free API keys.

3.  Process data, View and Analyze: This third step is where users will 
spend the most time.  The Process data menu enables a user to filter or 
subset a network by pruning, merging, removing, sampling, or filtering 
datasets by properties. This can be done before and/or after visualizing 
a dataset(s). Use the View menu to create a static or dynamic 
visualization depending upon the data type. The View menu enables 
users to Plot: Actor Scatter Plot, Contribution index, Group Centrality 
Measures (degree, betweenness, density), and Graph: Activity, 
Sentiment, Emotionality, Complexity and Word Usage over time. 
Datasets which have been filtered or modified can be saved for later re-
use. The Analyze menu will create a collapse graph, term graph and 
CoolPeople.

4. Export Data: Last, users may export data for additional analysis, 
graphing or mapping in other software, such as, Excel, SPSS, Gephi 
etc.

Note: Condor 3 uses a standardize data structure across all the 
various data sources for integrated BIG DATA analysis.

SECTION 2

Menu Process Steps
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a. Use File menu to Create/Access a Project Database, and its Dataset(s); 
Import/Export .cdf (condor data format) dataset files;  
Import .CSV node and link files, and Import MySQL files;  
File > Dataset > Open Dataset has a robust 2 stage filter sequence for 
node/edge selection

b. Use Fetch menu to harvest desired data: Email, Outlook Exchange Cal-
endar and email, Facebook, Web, Twitter, Twitter Accounts, Wiki Evolu-
tion, Wikipedia categories, etc.

c. Use View menu to create static or dynamic visualizations; calculate and 
graph measures

d. Use Process Dataset menu to filter or subset data before and/or after 
visualizing

e. Use Analyze menu menu to create a collapse graph, term graph and 
CoolPeople

f. Use Export menu to export datasets and network measures after custom-
izing a network with View & Process Data menus

What%are%the%basic%Condor%3%process%menu%driven%steps?%

2.#Fetch#Data#a,#b#

4.#Export#f#

File# Fetch#

3.#File,#Process#Data,#View,#and#Analyze#a,#c,#d,#e#

1.#File#a#

Analyze#

View#

Process#Data#

Export#

=#OpAonal#

File#
2#Stage#Filter#
Sequence#



CONDOR 3 FORM WIZARD

Condor 3 uses a form wizard, always located in the 
lower left corner, that, when needed, steps the 
users through a sequence of forms that are needed 
to complete a task and that indicates when Condor 
is processing a command.  

SECTION 3

The Form Wizard
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Condor 3 Form Wizard

Form Wizard

TIP:
Sometimes an active form may disappear behind the 
main Condor window. To bring the active form to the 
front, just click on the double window insert in the Ac-
tive Wizard.



FILE MENU OVERVIEW 

The File Menu is used to manage databases and datasets.

• Users can create and switch databases.

• Datasets can be created, opened deleted, and merged

• Condor datasets can be imported and exported using the 
Condor Data Format (.cdf) for transfer to other computers or to 
share with other Condor users

• External network datasets can be imported using .CSV node 
and edge files, and MySQL files

• The File > Dataset > Open Dataset sub-menu has a robust 2 
stage filter sequence for node/edge selection, which includes 
the use of Boolean logic to Restrict Actors and Links.

• Last, Exit Condor from the File menu.

Note: There is no database delete command. 

Users need to use a MySQL command to delete a database or use 
another GUI, such as, MySQL Workbench, Navicat or 
phpMyAdmin.

SECTION 4

File Menu
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File%menu%1st%Level%%
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File%menu%
Dataset%%2st%Level%
And%3rd%+%Levels%%

Open%Dataset%–2%stage%filter%sequence%

Note:%Boolean%logic%
can%be%used%to%
Restrict%Actors%and/
or%Links.%
%

1.% 2.%
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The$File$>$Dataset$>$Open$Dataset$sub2menu$has$a$two$stage$
filter$sequence:$

1st$Stage$offers$filtering$by$a$combina@on$of$:$

Start$or$End$date,$Actor$or$Link$content,$Top$Actor$

Communica@on$Frequency,$and$$op@onally$loading$parallel$links$

or$serial$communica@on.$Boolean$logic$can$be$used$to$Restrict$
Actors$and/or$Links.$

$

Open$Dataset$

1st$Stage$Filter$Op@ons$

2nd$Stage$Actor$Filter$Op@ons$ The$next$$2nd$$Stage$Actor$Filter$enables$users$to$select$actors$
manually$or$by$including/excluding$their$“uuids”$loaded$from$

a$CSV$file.$

$

Note:$ASer$a$dataset$is$open,$use$the$Process$Dataset$menu$

for$addi@onal$filtering$op@ons.$$
$
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Note:&Users&can&use&Boolean&Logic&in&the&Open&dataset&menu&to&&
Restrict&search&for&Actors&and/or&Links&
!

Kean!OR!Shelk!

Kean!AND!!Shelk!
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[4#Op&ons:#New,#Open#with#2#stage#filter,#Delete,#Merge#]##

File%menu%%
2nd%Level%

Note:#The#File#menu#import/#
export#dataset#uses#only#the#
Condor#Data#Format#(.cdf)#to#
transfer#files#to#other#
computers#or#to#share#with#
other#Condor#users.#

Note:#Import#
CSV#requires#
two#files:#a#
node#file#and#
an#edge#file.#
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File%menu%1st%Level%%

1.%Dataset%%

2.%Parameters%

3.%Pick%Required%Fields%

4.%Import%CSV%Node%
&%Edge%Messages%Note:&Import&CSV&

requires&two&files:&&
1.&A&node&file&
2.&&An&edge&file&

Note: Condor 3.2.0 enables the import of numeric fields in addition to 
string variables with .CSV files. See Chapter 10 for updates.
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1.## 2.##

3.## 4.## 5.##
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NEW File > Import MySQL 
 

Tip: Open an existing Condor 3 Database/Dataset and Export it using the 
Export > Export MySQL Dump and then use the File > Import MySQL. 

Suggested Steps: 
1.  Use MySQL Workbench to identify the existing Condor 3 Database 

“characterset” and “collation,” such as, latin1 and latin1_swedish_ci  
2.  Start Condor 3 and open the existing Database/dataset and Export 

using the Export > Export MySQL to a “name.sql” file 
3.  Use MySQL Workbench to create a new Database and import the 

“name.sql” file and set the “characterset” and “collation” with the 
previous values 

4.  Use Condor 3 to create a new database and then import the MySQL 
file created in step 3 with the File > Import MySQL menu and follow 
the prompts.   
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1.#Switch#to#database#and#open#dataset#

2.#Select#or#create#a#file#to#export#to#

Note:#
The#.cdf#file#extension#is#added#
(Condor#data#format)#



FETCH MENU OVERVIEW

The Fetch Menu enables the user to collect 
Email, Outlook Exchange Calendar and email, 
Facebook, Web, Twitter, Twitter Accounts, Wiki 
Evolution, and Wikipedia categories

SECTION 5

Fetch Menu
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The Fetch Menu  enables the user to collect Email, Outlook Exchange Calendar and email, Facebook, Web, Twitter, Twitter Accounts, Wiki 
Evolution, and Wikipedia categories.

Fetch Mailbox can use Pop, IMAP or Exchange Web Service (EWS) protocols, Secure Sockets Layer (SSL), and ability to select Start/Stop 
time frames, individual folders with or without content. Collecting content does take more time.

Fetch Facebook profile menu has options to collect Groups and Likes. Collecting Groups and Likes does take more time, especially if a 
Group has a large number of users. It is recommended to uncheck these two options on the first Fetch.

Fetch Web, menu offers a search choice of Google AJAX or Google’s Custom Search Engine (CSE). The Google CSE adds the capability to 
restrict websites, which have been crawled in a previous time unit of days, weeks, months or years.  A web query can be limited to a domain 
level.  The Google CSE requires users to obtain a free Google CSE API Key. 

Fetch Twitter menu has the option of doing repetitive searching with a user defined delay in minutes or hours.  Query filtering options in-
clude: the number of results, and  geolocation using latitude and longitude coordinates with a user defined search radius in miles or kilome-
ters. The Twitter Fetcher requires the user to obtain 4 free Twitter API Keys. To obtain geolocations see: 
http://www.gpsvisualizer.com/geocoder/. In addition, tweets from specified Twitter Accounts can be collected.

Fetch Wiki Evolution menu collects articles that have been linked to one another based upon a user-defined query. Because articles and 
links are time stamped, the evolution of a topic can be recreated. Query options include: language, choice of seed articles, static fetcher, dy-
namic fetcher, both static and dynamic fetcher, bidirectional links, no content, full content, or a snippet.

Fetch Wikipedia Categories collects a category tree, which help users to find information, even if they don't know what exists or what it's 
called. Query options include: Language, Category, and Depth. For example, see the category: Emotion. 
http://en.wikipedia.org/wiki/Category:Emotion

http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://en.wikipedia.org/wiki/Category:Emotion
http://en.wikipedia.org/wiki/Category:Emotion


Fetch&Menu&1st&Level&
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1.#Dataset#Name#

2.#Email#Parameters#

3.#Select#Email#Folders#

4.#Processing##
#####Message#

Note:##
To#use#the#Fetch#Menu,#
first#use#the#File#Menu#to#create#or#
switch#to#a#Database#and#create#or#
open#a#dataset.#
#
Otherwise,#users#will##get#this#error#
message.#

There#is#a#sequence#of#4#windows.#

Use#for#
Outlook#Exchange#
Email,#
Includes#Start/End#
Date#restricLons#
#
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3.#Authorize#
Galaxy#
Or,#if#have.#Okay.##Important,*first*

Logout*of*Facebook.*

Note:**
To*use*the*Fetch*Menu,*
first*use*the*File*Menu*to*create*or*switch*
to*a*Database*and*create*or*open*a*
dataset*
*

1.#Dataset##

2.#Login#to##
Facebook##

4.#Logout#
of#

Facebook##

5.#Click#Next##

7.#OpGons##

7.#Process#Status###

6.#Login##to#Facebook##
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&
or&switch&to&a&Database&and&
create&or&open&a&dataset&

1.#Dataset##

2.#Parameters#

3.#Select#
#####First#Layer#

4.#Process#
#####Message#

Note:&&
Google&CSE&requires&
an&API&Key.&
&
&
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&&
Twi:er&requires&
&4&Twi:er&API&Keys.&

1.#Dataset##

3.#Twi-er#4#Keys#
6.#Process#Message#

4.#Repe::ve#Op:ons#

7.#Wait#Message#
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&&
Twi:er&Accounts&requires&
&4&Twi:er&API&Keys:&

1.#Dataset##

2.#Parameters#

3.#Twi1er#4#Keys#

4.#Process#Message#

Note:&Collect&one&or&more&
Twi0er&Accounts&with&a&
single&query&by&separa;ng&
Id(s)&with&a&comma&“,”&
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

1.#Dataset##

2.#Language#

3.#Query#

4.#Ar4cle#Selec4on#

5.#Limita4on#Op4ons##

6.#Sta4c/Dynamic##

7.#Bidirec4onal#

8.#Content#Op4ons#

9.#Process#Message#



99

http://en.wikipedia.org/wiki/Portal:Contents/Categories

Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&
For&details&on&Wikipedia&Categories:&
See:&

1.#Dataset##

2.#Language,#Category,#Depth#

3.#Process#Message#

http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories


Microsoft Outlook Exchange Calendar import  
 

a. Fetch > Exchange calendar 

b. Select Dataset (New/Open)  

c. Complete Exchange Calendar form 

100



PROCESS DATASET MENU

Use the Process dataset menu to: 
a. Prune, merge, remove, sample and filter a 

dataset by node or link properties
b. Calculate centralities, oscillations, contribu-

tion index, Average Weighted Value Contri-
bution Index (AWCI), turn-taking, graph 
density, sentiment and influence measures

c. Annotate a field by language or location and 
remove all HTML.

SECTION 6

Process Dataset Menu
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The$Process$dataset$menu$enables$users$to$filter$or$subset$a$network$by$graph$pruning$using$
node$or$link$proper9es$,$removing$specific$nodes,$sampling,$and$node$merging$either$manually$
or$automa9cally.$The$Process$dataset$menu$items$can$be$executed$before$and/or$a@er$
visualizing$a$dataset(s).$This$Process$dataset$filtering$and$subseDng$are$powerful$capabili9es,$
especially$when$working$with$very$large$networks.$
$
In$addi9on,$the$Process$dataset$menu$can$annotate$the$dataset’s$nodes$and$edges$with$over$
34$calcula9ons,$which$include:$centrali9es,$oscilla9ons,$the$contribu9on$index,$turnJtaking,$
AWVCI,$sen9ment$and$influence$measures.$It$can$also$perform$a$language$annota9on,$which$
iden9fies$the$language$of$node$or$edge$data$fields.$All$these$values$can$be$used$to$prune$or$
filter$the$network$and$used$in$graphing$to$change$a$node’s$size,$labels$and$edge$labels.$Also,$
there$is$an$op9on$to$remove$all$HTML.$
$
The$Process$dataset$menu$is$op9onal,$but$it$is$o@en$used$in$an$itera9ve$way$with$the$View$
menu.$For$example,$by$using$the$File$Menu$to$select$a$database$and$dataset(s)$with$the$robust$
2$stage$filter$op9ons,$users$can$go$directly$to$the$View$menu$and$map$a$dataset(s).$Then,$users$
may$wish$to$apply$more$filters$to$the$network$and/or$annotate$with$one$or$more$of$the$34$
available$measures$by$using$the$Process$dataset$Graph$Pruning$sub$menu$op9ons.$$
$
Last,$a@er$a$dataset$is$filtered$or$modified,$a$blue$icon$$$$$$$$$$$will$appear$in$the$upper$le@$corner$
of$the$selected$dataset.$Users$may$wish$to$save$this$modified$dataset$for$reJuse.$
$



Process'dataset'menu'1st'Level''
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1.#Graph#Pruning#Filter#Op3ons#

2.#Processing#Message#Appears#

Note:##Graph#Pruning#
op3ons#can#be#increased#by#
Using#the#Process#dataset#>#
Annotate#to#calculate#
Centrality,#Oscilla3on,#Turn#
Taking,#and##Contribu3on#
Index#measures.#!
!
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Process'Dataset'Summary'of'34+'Annota5ons''
Available'to'vary'a'Graph’s'Node,'Size'and'Labeling'Measures''!

A.'Centrality'annota5ons:'
1.  Betweenness!Centrality!
2.  Betweenness!Centrality![Weighted]!!

Note:!(same!name,!only!one!value!saved)!
3.  Closeness!Centrality!
4.  Degree!Centrality!
5.  Degree!Centrality![Weighted]!

!Note:!(same!name,!only!one!value!saved)!

B.'Oscilla5on'annota5ons'
1. Betweenness!oscillaEon!
2. ContribuEon!Index!oscillaEon!

C.'Contribu5on'Index'Annota5ons'
1. ContribuEon!Index!value!(I1!!to!+1)!
2. Messages!Total!count!
3. Messages!received!count!
4. Messages!sent!count!

D.'Turn'Taking'Annota5ons'
1. Avg.!Nudges!unEl!responses!
2. Avg.!!ART![h]!

E.'Graph'Density'Annota5on'
1. Graph!Density!!
Note:!only!a!single!graph!value,!not!
available!for!pruning,!or!graphing.!

F.'Sen5ment'Node'Annota5ons'
1.  Avg.!complexity!
2.  Avg.!emoEonality!
3.  Avg.!senEment!

G.'Sen5ment'Edge'Annota5ons'
1.  SenEment!Words![list!of!top!4!words!and!

values]!
2.  Keywords![top!8!words!and!values]!
3.  EmoEonality!score!
4.  Language!AnnotaEon,!such!as,!“en”!
5.  Complexity!score!
6.  SenEment!score!

H.'Influence'Node'annota5ons'
1.  most!influenEal!words!
2.  average!influence!per!

message!
3.  messages!sent!
4.  avg.!SenEment!
5.  total!Influence!
6.  most!common!word!

I.'Influence'Edge'annota5ons'
1.  influence!other!

direcEon!
2.  influence!
3.  language!
4.  senEment!
5.  senEment!words!
6.  keywords!

Annotate+Node+Measures++ Sen1ment+Measures++

Influence+Measures++



Process'dataset'menu'2nd'Level''

Note:&&
1.&A*er&a&node&annota/on&is&computed,&use&the&Process&dataset&menu&>&Graph&
Pruning&submenu&to&con/nue&and&prune&a&dataset,&and&/or&

2.&Use&the&annota/on&values&to&vary&the&node&size&and&node&labels&in&the&graph.'
'
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2.#Sample#Actor#Mapper#File#Output#

1.   Manual##
######Node#merging#Actor#Mapper#
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1.   Sample)Probability)

Note:&Automa+cally&creates&a&
new&dataset&name,&which&users&may&
change.&
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1.   Remove(specific(actors(
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A.#Centrality#annota.ons:#
1. Betweenness)Centrality)
2. Betweenness)Centrality)

[Weighted])Note:)(same)name,)
only)one)value)saved))

3. Closeness)Centrality)
)Note:)Does)not)show)up)in)Node)
Size)right)away)

4. Degree)Centrality)
5. Degree)Centrality)[Weighted])
Note:)(same)name,)only)one)value)

saved))
# Note:&&

1.&A*er&a&node&&annota/on&is&computed,&use&the&Process&
dataset&menu&>&Graph&Pruning&to&con/nue&and&prune&a&
dataset,&and&/or&
2.&Use&the&annota/on&values&to&vary&the&node&size&and&node&
labels&in&the&graph.#

B.#Oscilla.on#annota.ons#
1. Betweenness)oscillaHon)
2. ContribuHon)Index)oscillaHon)

C.#Contribu.on#Index#Annota.ons#
1. ContribuHon)Index)value)(L1))to)+1))
2. Messages)Total)count)
3. Messages)received)count)
4. Messages)sent)count)

D.#Turn#Taking#Annota.ons#
1. Avg.)Nudges)unHl)responses)
2. Avg.))ART)[h])

E.#Graph#Density#Annota.on#
1. Graph)Density))
Note:)only)a)single)graph)value,)not)
available)for)pruning,)or)graphing.)
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1.#Select#Centrality#Measure#

2.#Processing#Message#Appears#

Note:&
Closeness&centrality&is&not&
supported&at&this&4me.&



1.   Automa)c++
++++++Node+merging+Actor+Mapper+

•  2.+Sample+Actor+Mapper+Output+
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1.#Pick#Deduplicate#edge#op2on#

Note:#Use#Process#dataset#menu#>#Graph#Pruning#to#use#Contribu2on#Index#values#
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1.#AWVCI#annota-ons#op-ons#

Note:#Use#Process#dataset#menu#>#Graph#Pruning#to#use#Contribu-on#Index#values#

Note:&&
Deduplicate&edges&by&
op3ons&varies&by&
dataset&type&

AWVCI = Average Weighted Value Contribution Index



1.#Set#Oscilla-on#Parameters#

Note:#Use#Process#dataset#menu#>#Graph#Pruning#to#use#Oscilla-on##values#
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Note:&Graph&density&is&a&single&value&and&not&available&for&pruning,&or&graphing.&
! !Use&Export&>&Export&&Dataset&proper>es&to&view&the&graph&density&value.&
& &Here&is&a&sample&output.&

!!
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1.   Language)Node)and)Edge)Criteria)
Note:&a&Language&annota,on&iden,fies&the&language&of&
data&fields.&&

Note:)Use)Process)dataset)menu)>)Graph)Pruning)to)use)Language)values)
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1.   Sen&ment)Mapper)Op&ons)

2.)Process)Messages)Appear)

Note:)Use)Process)dataset)menu)>)Graph)Pruning)to)use)Sen&ment)values)
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Sen$ment'Node'Annota$ons'
1.  Avg.&complexity&
2.  Avg.&emo2onality&
3.  Avg.&sen2ment&
'
Sen$ment'Edge'Annota$ons'
1.  Sen2ment&Words&[list&of&top&4&words&and&values]&
2.  Keywords&[top&8&words&and&values]&
3.  Emo2onality&score&
4.  Language&Annota2on,&such&as,&“en”&
5.  Complexity&score&
6.  Sen2ment&score&
'Note:&A(er&the&Sen-ment&annota-ons&are&calculated&do&one&or&more&of&the&following:&

1.&Use&the&Process&dataset&menu&>&Graph&Pruning&to&con-nue&and&prune&a&dataset’s&nodes&
2.&Use&the&Node&Sen-ment&annota-on&values&to&vary&the&node&size&and&node&labels&in&the&graph&
3.&Use&the&Edge&Sen-ment&values&&for&edge&labels&in&the&graph&
4.&Use&the&View&menu&>&Sen-ment&Over&-me&to&graph&the&Ac-vity,&Sen-ment,&Emo-onality,&Complexity,&
and&op-onally&export&the&results&to&a&.CSV&file.&
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A"er%Process%dataset%>%Calculate%Sen3ment,%use%View%menu%>%Sen3ment%Over%3me%%!
%to%graph%the%Ac3vity,%Sen3ment,%Emo3onality,%and%Complexity%
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Export'Sen+ment'Ac+vity'results'to'a'.CSV'file'

Sample'output'



1.#Set#Turn#taking#parameters#

Note:#Use#Process#dataset#menu#>#Graph#Pruning#to#use#Turn#Taking#values#
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Influence'Node'annota+ons'
1.  most'influen-al'words'
2.  average'influence'per'message'
3.  messages'sent'
4.  avg.'Sen-ment'
5.  total'Influence'
6.  most'common'word'

Influence'Edge'annota+ons'
1.  influence'other'direc-on'
2.  influence'
3.  language'
4.  sen-ment'
5.  sen-ment'words'
6.  keywords'
'

Note:&A(er&the&Influence&annota1ons&are&calculated&do&one&or&more&of&the&following:&
1.&Use&the&Process&dataset&menu&>&Graph&Pruning&to&con1nue&and&prune&a&dataset’s&nodes&
2.&Use&the&Node&Influence&annota1on&values&to&vary&the&node&size&and&node&labels&in&the&graph&
3.&Use&the&Edge&Influence&values&&for&edge&labels&in&the&graph&



1.#Calculate#Influence#Calculator#

2.#Process#Message#Appears##

Note:&Influence&is&a&diffusion&measure&of&the&usage&of&new&words&by&
message&recipients,&and&how&rapidly&they&used&these&words&once&exposed&
to&them.&

Note:#Use#Process#dataset#menu#>#Graph#Pruning#to#use#Influence#values#
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1.   Remove(html(op-ons(

2.(Process(message(
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 [Process dataset] Endpoint based edge filters (Link Properties Option) 
 

a. Process dataset > Link filter 

b. Select Link Filter option: 

c. Select Link Properties 
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 [Process dataset] Endpoint based edge filters (Boolean Option) 
 

a. Process dataset > Link filter 

b. Select Link Filter option: 

c. Select Link Properties 
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VIEW MENU OVERVIEW

Use the View Menu to:
a. Create static, dynamic, or geographic visuali-

zations and word clouds
b. Plot: Actor Scatter Plot, Adjacency Matrix 

Plot, Contribution index, Group Centrality 
Measures (degree betweenness, density), 
and

c. Graph: Activity, Sentiment, Emotionality, 
Complexity, Word Usage over time, and a 
temporal social surface view.

SECTION 7

View Menu
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The$View$menu$is$where$users$create$a$sta0c,$dynamic$or$geographic$visualiza0ons,$or$word$clouds,$depending$upon$the$
data$type.$$Using$this$menu$assumes$that$users$have$used$the$File$menu$to$select$a$database$and$have$opened$one$or$
more$datasets.$If$users$wish,$they$can$use$the$Process$dataset$menu$to$filter$or$subset$a$dataset$before$and/or$aCer$a$
visualiza0on$with$one$or$more$of$the$34+$annota0ons$available.$
$

The$View$menu$has$selec0ons$to$create$an$Actor$ScaIer$plot,$Adjacency$Matrix,$and$calculate$three$Group$Centrality$
measures:$Degree$Centrality,$Betweenness$Centrality$and$Density$for$0me$units$of$minutes,$hours,$days,$weeks,$months$
or$years$for$a$user$defined$data$range$with$or$without$history;$the$selec0ons$also$include:$graph$of$a$network’s$Ac0vity,$
Sen0ment$and$Word$usage$of$selected$4$words$over$0me.$It$also$has$a$selec0on$to$create$a$3D$temporal$social$surface$
view$
$

The$View$menu$is$complemented$with$a$set$of$three$tools$to$explore$and$change$the$appearance$of$visualiza0ons.$They$
are:$a$graphical$user$interface$(GUI)$Toolbar$of$seven$tools,$a$side$panel$of$pick$menus$to$change$node$and$edge$
aIributes$for$the$en0re$graph,$and$the$ability$to$right$click$on$a$single$node$or$edge$for$addi0onal$details,$labeling$
op0ons,$coloring,$and$measures$of$the$contribu0on$index,$ac0vity,$sen0ment$or$influence$over$0me.$
$
$
$
The$GUI$Toolbar$enables$users$to$reYlayout$(refresh$or$redraw)$a$graph,$take$a$snapshot$and$send$it$to$the$clipboard,$$
show$or$hide$directed$edge$arrows,$zoom$in$and$out$using$keypad$gestures,$select$and$move$the$whole$graph,$or$pick$a$
single$node$and$reposi0on$it.$The$search$tool$will$highlight$nodes$based$on$a$key$word$or$phrase,$and$an$advanced$op0on$
enables$users$to$selec0vely$color$nodes$using$a$CSV$node$list$file.$
$

The$side$bar$pick$menus$enable$the$en0re$graph$node$and$edge$aIributes$to$be$modified$by$color,$size,$shape$and$labels.$
Nodes$can$be$collapsed$by$proper0es,$such$as,$content,$0tle,$query,$domain$and$snippet.$Depending$upon$the$menu$
op0on$selec0on,$a$legend$will$be$automa0cally$generated.$
$

Datasets$which$have$been$filtered$or$modified$are$flagged$with$a$blue$info$icon$in$the$upper$leC$corner$of$the$ac0ve$
dataset$and$can$be$saved$for$later$reYuse.$$

The$GUI$Toolbar$
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View%menu%1st%%Level%%

Note:&Using&this&menu&
assumes&that&users&have&
used&the&File&menu&to&select&
a&database&and&opened&one&
or&more&datasets.&&
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1.#Sample#Actor#Sca/er#Plot:#Contribu7on#Index#

Note:#Using#this#menu#
assumes#that#users#
have#used#the#File#
menu#to#select#a#
database#and#opened#
one#or#more#datasets.##
#Note:#The#Contribu7on#Index#(CI)#measures#the#degree#to#which#a#person#sends#or#receives#messages.##CI#is#
graphed#on#the#yGaxis#and#ranges#from#+1#at#the#top,#where#someone#only#sends#messages;#to#G1#at#the#bo/om,#
where#someone#only#receives#messages.#A#value#of#0,#in#the#middle#of#the#yGaxis,##means#there#is#an#equal#
balance#of#sending#and#receiving.#The#XGaxis#is#the#number#of#messages.#If#the#cursor#is#hovered#over#a#node,#the#
name#will#be#displayed.#The#CI#graph#can#be#saved#as#a#Portable#Network#Graphics#or#.png#file.#
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Nodes now can be labelled

And, if you drag a mouse over
a node its label will be displayed.
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Note:&Using&this&menu&
assumes&that&users&
have&used&the&File&
menu&to&select&a&
database&and&opened&
one&or&more&datasets.&

New Heatmap option and Node Labels, 
Drag mouse over nodes to display labels 
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Note:&Using&this&menu&
assumes&that&users&have&
used&the&File&menu&to&select&
a&database&and&opened&one&
or&more&datasets.&&
&
Explore&and&change&the&
visualiza<on’s&appearance&
using&the&GUI&Toolbar,&the&
side&panel&node&and&edge&
menus,&and/or&right&click&on&
a&node&and&edge.&

Sample&Enron&Email&Sta<c&View&
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1.#Select#Dynamic#Date#Range,#Time#Unit,#and#History#Op;ons#

Note:#Using#this#menu#assumes#
that#users#have#used#the#File#
menu##to#select#a#database#and#
opened#one#or#more#datasets.##
#
Explore#and#change#the#
visualiza;on’s#appearance#using#
the#GUI#toolbar,#the#
side#panel#node#and#edge#
menus,#and/or#right#click#on#a#
node#and#edge.#
#
Or,#filter#the#network#using#the#
Process#dataset#menu.#

2.#Sample#Enron#Email#Dynamic#View#
#

Note:#Use#Dynamic#controls#at#boPom#of#the#
visualiza;on#to#locate#a#date/;me#period,#
play/stop,#slow#down,#or#speed#up#the#anima;on.#
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1.  Note,(advisory(message(that(instructs(users(to(first(use(
the(Process(data(menu(and(Calculate(Sen;ment(

Note:(Using(this(menu(
assumes(that(users(have(
used(the(File(menu(to(select(
a(database(and(opened(one(
or(more(datasets.((
(
Tip:(First,(use(the(Process(
dataset(menu(to(Calculate(
sen;ment.(

2.(Set(Sen;ment(Mapper(Op;ons;(then(Process(message(appears(

3.(Sample(Word(Cloud(with(Date(Slider(at(boJom,(and(Word(
controls(at(upper(right(to(set(the(maximum(number(of(words(
to(display(and(the(minimum(word(frequency(threshold.(
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3.#Sample#Word#Cloud#with#Date#Slider#at#bo6om,#and#Word#
controls#at#upper#right#to#set#the#maximum#number#of#words#
to#display#and#the#minimum#word#frequency#threshold.#

Word##Controller#

Date#Slider#
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1.#Select#Dynamic#Date#Range,#Time#Unit,##History#
Op:ons#and#Process#Message#appears#

Note:#Using#this#menu#
assumes#that#users#
have#used#the#File#
menu#to#select#a#
database#and#opened#
one#or#more#datasets.##
#

2.#Sample#Group#Centrality#Plot#with#three#centrality#
measures:#Degree,#Betweenness#and#Density#by#Time.#
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2.#Sample#Centrality#Plot#with#three#centrality#measures:#
Degree,#Betweenness#and#Density#by#Time.#

The#Group#Centrality#Plot#can#be#saved#as#a#Portable#Network#Graphics#or#.png#file#
by#right#clicking#on#graph#and#select#“Save#as”.#
#
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1.  Note,(an(advisory(message(may(appear(if(the(dataset(

does(not(have(a(6me(stamp,(such(as(a(web(dataset.(

(((((((((Email(and(Twi>er(are(examples(of(6me(stamped(data.(

2.(Sample(Ac6vity(Plot(with(Average(Messages(per(day(

on(the((YFAxis(and(Time(along(the(XFAxis.(Note:(Using(this(menu(

assumes(that(users(have(

used(the(File(menu(to(

select(a(database(and(

opened(one(or(more(

datasets.(

(

Tip:(Users(can(set(the(Start(

and(End(dates(of(the(

Ac6vity(Plot(when(opening(

the(dataset.((

(

The(Ac6vity(over((6me(Plot(can(be(saved(as(a(Portable(Network(Graphics(

or(.png(file(by(right(clicking(on(graph(and(select(“Save(as”.(

(
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2.#Sample#Ac,vity#Plot#with#Average#Messages#per#day#on#
the##Y<Axis#and#Time#along#the#X<Axis.#

The#Ac,vity#over##,me#Plot#can#be#saved#as#a#Portable#Network#Graphics#
or#.png#file#by#right#clicking#on#graph#and#select#“Save#as”.#
#
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The$Sen'ment$Plot$can$be$saved$as$a$Portable$Network$Graphics$or$.png$file$by$right$
clicking$on$graph$and$select$“Save$as”.$The$data$can$be$exported$as$a$CSV$file$too.$
$

Note:$Using$this$menu$
assumes$that$users$have$
used$the$File$menu$to$select$
a$database$and$opened$one$
or$more$datasets.$$
$

Tip:$First,$use$the$Process$
dataset$menu$to$Calculate$
sen'ment.$

1.  Note,$users$may$get$an$advisory$message$that$they$first$need$
to$use$the$Process$data$menu$and$Calculate$Sen'ment.$

2.$Select$Sen'ment$Mapper$Op'ons;$then$a$Process$message$appears$

3.$Sample$Sen'ment$and$Ac'vity$Plot$with$Average$Messages$per$
day$on$the$$YPAxis$and$Time$along$the$XPAxis.$

Note:$$
Four$measures$
are$op'onally$ploRed:$
Ac'vity,$Sen'ment,$
Emo'onality,$and$
Complexity$(if$selected$
in$Sen'ment$Mapper)$
$

Note:$
There$is$an$$
Export$op'on$
to$save$all$the$$
Values$in$a$.csv$file$
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3.#Sample#Sen+ment#and#Ac+vity#Plot#with#Average#Messages#per#day#
on#the##Y<Axis#and#Time#along#the#X<Axis.#
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3.#Sample#Sen+ment#and#Ac+vity#Plot#with#Average#Messages#per#day#
on#the##Y<Axis#and#Time#along#the#X<Axis.#
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3.#Sample#Word#Usage#Plot#with#Average#Occurrences#per#day#on#the##
Y>Axis#and#Time#along#the#X>Axis.#

Note:#
Details#for#4#selected#
words#are#given#including:#
No.#of#Occurrences,#
No.#of#Users#
Who#First#MenJoned#
Who#Most#InfluenJal,#and#
Who#was#the#Early#Adopter#
for#each#of#the#four#words.#



See: Kidane, Y. Gloor, P. Correlating temporal communication patterns of the Eclipse open source 
community with performance and creativity, Computational & Mathematical Organization Theory. 
Volume 13, Issue 1 (March 2007), ISSN:1381-298X, 17 - 27, 2007 
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ANALYZE MENU

Use the Analyze Menu to: 

Create a collapse graph, term graph; CoolPeople 

SECTION 8

Analyze Menu
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1.#Select#Collapse#Field,#
and#name#of#resul7ng#dataset#

2.#New#dataset#is#created#
and#made#ac7ve#

3.#Use#the#View#Menu#to#Create#a#Sta7c#or#Dynamic#View#

Sta7c#View# Dynamic#View#
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2.#Set#Term#processing#op1ons:#Language,#Node#and#Edge#property#
Name#of#Target#Dataset,#Minimum#no.#of#co>occurrences#for#edge#

Note:#Using#this#menu#
assumes#that#users#
have#used#the#File#
menu#to#select#a#
database#and#opened#
one#or#more#datasets.##
#

1.  Note,#users#may#get#an#advisory#message#that#a#dataset#first#
needs#to#be#loaded.#

3.#Select#terms# 4.#Target#Dataset#
is#open#and#
made#ac1ve#

5.#Use#the#View#Menu#to#
Create#a#Sta1c#View#



152

3.#Use#the#View#Menu#
to#Create#a#Sta4c#View#
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CoolPeople'is's*ll'under'development'



EXPORT MENU

Use the Export Menu to:

Export: Data as CSV files, time series, MySQL 
dump, turn-taking, and dataset properties

SECTION 9

Export Menu
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The$Export$menu$offers$5$op1ons$to$create$an$output$file$of$selected$network$measures$and$node$and$edge$data.$
$
1.   Export)CSV)enables$users$to$export$a$dataset’s$nodes$and$edges$along$with$their$selected$proper1es$into$separate$.csv$

files.$
$

2.   Export).me)series)offers$the$choice$to$export$these$measures:$contribu1on$index,$AWVCI,$betweenness$centrality,$
betweenness$oscilla1on,$graph$density,$turn$taking,$degree$centrality,$ac1vity,$sen1ment,$emo1onality$and$
complexity$into$a$.csv$file,$which$must$be$designated.$The$user$defines$export$parameters$of$a$Time$Unit$(minutes,$
hours,$days,$weeks,$months$or$years),$Date$Range,$with$or$without$History$and$Length$of$1me$units$.$The$dataset$must$
be$1me$stamped,$such$as$in$email$or$TwiOer.$

$
$

3.   Export)as)mysql)dump)is$an$export$of$a$dataset’s$node$and$edge$fields$saved$as$a$.sql$file.$
$

4.   Export)Turn=Taking)is$an$export$of$a$selec1on$of$an$individual$actor’s$turnQtaking$sta1s1cs,$which$are$saved$as$their$
“name.csv”$into$a$designated$folder.$The$turnQtaking$fields$are:$SourceQUUID,$SourceQName,$TargetQUUID,$TargetQ
Name,$Pings$Sender,$Mean$Frame$Time$Sender,$Pings$Receiver,$Mean$Frame$Time$Receiver,$Num$Messages,$and$Num$
Frames.$The$dataset$must$be$1me$stamped,$such$as$in$email$or$TwiOer.$

$

5.   Export)Dataset)Proper.es)is$an$export$of$a$dataset’s$proper1es,$but$they$first$need$to$be$$individually$calculated$using$
the$Process$dataset$menu$op1ons:$Annotate$>$Centrality$Annota1ons$($Betweenness$[weighted],$Degree$
[weighted]$);$;$Annotate$>$$AWVCI;$Annotate$>$Turn$Taking$Annota1ons,$and/or$Annotate$>$Graph$Density$Annota1on.$$
Process$dataset$>$Calculate$Sen1ment$
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1.  Select(Actors(and/or(Links(to(be(exported(to(
designated(.CSV(files,(along(with(selected(
Proper?es(to(be(excluded(

2.(Process(message(appears.(Data(exported(to(.csv(file(s).(

Choose(your((
Field(delimeter(
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Sample'Export'Actor'and'Node'.CSV'files'



159

Note:&Using&this&menu&
assumes&that&users&have&used&
the&File&menu&to&select&a&
database&and&opened&one&or&
more&datasets.&
&
Dataset&should&have&&
:mestamps,&such&as&
Email&or&Twi?er.&&
&
Tip:&An&Export&&file&name&must&
be&given.&The&extension&“.csv”&
is&automa:cally&appended&to&
the&file&name.&
&

2.&Select&Date&Range,&Time&Unit&and&History.&Then&Process&Message&

3.&Sample&Export&Time&Series&Output&

1.&Select&1&of&7&Centrality&Measures&and&create&an&export&filename&
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Note:&Using&this&menu&
assumes&that&users&have&
used&the&File&menu&to&
select&a&database&and&
opened&one&or&more&
datasets.&
&
Tip:&An&Export&file&name&
must&be&given.&The&
extension&“.sql”&is&
automaAcally&appended&to&
the&file&name.&
&

1&Choose&an&Export&File&Name&&

2.&Click&Next&to&Export&to&designated&file&
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Export'as'MySQL'dump''
Node'and'Edge'field'lengths'

Node'field'lengths' Edge'field'lengths'
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Note:&Using&this&menu&
assumes&that&users&have&used&
the&File&menu&to&select&a&
database&and&opened&one&or&
more&datasets.&
&
Tip:&An&Export&FOLDER&name&
must&be&given.&Actors&selected&
will&have&an&individual&file&
created&for&them.&

1&Choose&an&Export&Folder.&&

2.&Select&Actors&to&Export&individual&results&saved&as&
&their&“name.csv”&into&the&previous&designated&folder&

3.&Sample&Export&Turn&Taking&File&output&for&selected&actors..&&

4.&Sample&Turn&Taking&Output&&
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1.  To%Export%a%dataset’s%proper0es,%they%first%need%to%be%%individually%
calculated%using%the%%
Process%dataset%menu%op0ons:%%
•  Annotate%>%Centrality%Annota0ons%(%Betweenness%[weighted],%

Degree%[weighted]only%one%metric%is%saved%);%%
•  Annotate%>%Turn%Taking%Annota0ons%(Average%Group%ART%[h],%

Group%ART%Variance%[h],%Average%Group%Nudges%un0l%
responses%[h],%Group%Nudges%Variance%un0l%responses%[h]and%%

•  Annotate%>%Graph%Density%Annota0on%
•  Annotate%>%AWCVI%annota0ons%
•  Calculate%Sen0ment%

Sample%Export%dataset%proper0es.csv%file%
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In#addi'on#to#the#Export#menu,#Condor#has#2#other#export#op'ons:#
#
1.   File'menu'>'Export'dataset'as#a#.cdf#(Condor#data#format)#for#transfer#to#

other#computers#or#to#share#with#other#Condor#users,#and#
2.   View'menu'>'Sen9ment'over'9me'can#export#the#data#to#a#.csv#file#which#

includes:#Ac'vity,#Sen'ment,#Emo'onality,#and#Complexity#(if#selected#in#the#
Sen'ment#Mapper)#

#
Condor#can#also#save#images,#graphs#and#plots#as#follows:#
1.  The#GUI#Toolbar#enables#users#to#save#a#View#menu#sta'c#image#to#the#

clipboard#by#clicking#on#the#camera#icon#
2.  The#View#menu#>#Actor#ScaMer#Plot,#Contribu'on#Index,#Group#Centrality#

Measures,#Ac'vity#over#'me,#Sen'ment#over#'me,#and#Word#usage#over#
'me,#all#can#be#“Saved#As”#as#a#Portable#Network#Graphics#or#.png#file#by#
right#clicking#on#the#image.#

Note:#To#export#a#View#Dynamic#movie,#users#need#to#use#a#third#party#screen#
capture#tool,#such#as,#Snapz#Pro.#



HELP MENU

The Help menu has two selections:

1. About defines Condor 3’s version name, 
release date, build number, and displays the 
user’s License Key

2. Manuals includes two download links for a  
Condor 3 YouTube instructional videos links 
file and a Condor 3 PDF User manual file.

3. Unregister computer enables the user to 
transfer their License key to another computer.

SECTION 10

Help Menu
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Help%>%About%Condor%0%defines%Condor%3’s%version%number,%release%date,%build%
number,%and%display’s%the%user’s%License%key.%
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Unregister)license)enables)users)to)move)their)license)to)another)computer.)
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CHAPTER 8

Graphical 
User 
Interface  

Condor 3 has three Graphical User Inter-
face (GUI) controls:
1. Graph Toolbar
2. Node and Edge Menus
3. Keypad Gestures

1.  Graph(Toolbar(
2.  Node(and(Edge(Menus(
3.  Keypad(Gestures(
(

Condor 3 Graphical User Interface Controls
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2.#Node#and#Edge#
Color,#Shape,#&#Label#Menus#

Graph#Area#

1.#Graph#Toolbar#

Node#Info#Display#

3.#Keypad#gestures#

•  Zoom#in#&#out.##
•  Right#Click#on#a#single#node#or#edge#

to#display#details#and#label#a#node#
•  Hover#cursor#over#node#to#display#

Info#in#lower#right#corner#window#

Relayout,#Take#Snapshot,#Show#Arrows,#
Select#&#Move#enMre#graph,#Pick#a#single#

node#or#edge,#Search#text#&#highlight#
nodes,##Advanced#colors#nodes#with#list#

Condor 3 Graphical User Interface Controls:
1.The Graph Toolbar
2. Node and Edge menus
3. Keypad Gestures



GRAPH TOOLBAR OVERVIEW

The Graph Toolbar enables the user to:

1. Relayout the  graph

2. Take a Snapshot

3. Show Arrows

4. Select & Move the entire graph

5. Pick a single node or edge

6. Search text to highlight nodes that have a 
match,  and 

7. Advanced coloring option to color nodes from 
a list.

SECTION 1

Graph Toolbar
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Graph&Toolbar:&Click&an&icon&to&ac2vate&or&toggle&on/off&
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Graph&Toolbar:&Click&an&icon&to&ac2vate&or&toggle&on/off&

The$Graph$toolbar$enables$users$to:$
1.$Re4layout$(refresh$or$redraw)$a$graph$
$
2.$Take$a$snapshot$and$send$it$to$the$clipboard$$$
$
3.$Show$or$hide$directed$edge$arrows$
$
4.$Select$and$move$the$whole$graph$$
$
5.$Pick$a$single$node$or$edge,$and$reposiHon$it$
$
6.$The$search$tool$will$highlight$nodes$based$on$a$key$word$or$phrase$using$
Boolean$logic$

$
7.$Advanced$opHon$enables$users$to$selecHvely$color$nodes$using$a$node$list$
$$
$8.$Zoom$in$and$out$with$keypad$gestures;$right$click$to$display$node$&$edge$info$
$
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Graph&Toolbar:&Click&an&icon&to&ac2vate&or&toggle&on/off&

The$search$tool$will$highlight$nodes$and$links$based$on$a$key$word$or$phrase$using$
Boolean$logic$
$
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Sample'Visualiza-on'of''
'Web,'Wikipedia','and'Twi8er'Datasets'

Based'on''Query:'Sochi'2014'on'February'19,'2014'

Node%Info%Display%

Node%Color:%
Original%Dataset%
will%display%in%Legend%%

Dataset%Graphs%

•  List%of%open%%
datasets.%

•  Green%check%
indicates%ac=ve%
dataset.%

•  Switch%to%another%
dataset%by%clicking%on%it%

See%more%.%.%.%



CONDOR 3 NODE AND EDGE MENUS

The  Condor 3 Node and Edge menus effect the 
entire graph. Users can change a graphs:

1. Node and Edge Color

2. Node and Edge Legend

3. Node Shape

4. Node Size by fields

SECTION 2

Node and Edge Menus
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Node and Edge Menus
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Node%and%Edge:%Color,%Shape%&%Label%Menus%&%Sub8menus%

Node%and%Edge:%
Color%Picker%

Node%and%Edge:%
Legend%Op1ons%

Node:%Shape%Display%Op1ons%

Node:%Size%by%fields%
varies%by%data%type%

Node:%Size%%
min%and%max%adjusters%

Note:%
Menus%
affect%the%en8re%
graph.%
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Node%and%Edge%Label%Op/ons,%Plus%Node%Collapse%Op/ons%

Node%Label%
Op,ons%

Edge%Label%
Op,ons%

Node%Collapse%
Op,ons%

Note:%%
Node%and%Edge%
op/ons%are%
based%on%a%dataset’s%
proper/es.%
%
Op/ons%will%change%
based%on%a%dataset’s%
type%(email,%web,%%
TwiBer,%Facebook,%etc.)%
and%if%any%metrics%%
have%been%computed.%
%



CONDOR 3 KEYPAD GESTURES

1. Zoom in & out. 

2. Right Click on a single node or edge to display 
details and label a node

3. Hover cursor over node to display Info in lower 
right corner window

 

SECTION 3

Keypad Gestures
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3.#Keypad#gestures#
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Keypad'Gestures'

•  Two'finger'swipe&up&to&Zoom,in&a'graph'
•  Two'finger'swipe&down&to&Zoom,out&a'graph'
•  '''''''''One'finger'Tap&and&Hold&a&node&to&move'the'en7re'graph''
•  Right&Click&a&Single&Node&to'Label,'Change'Color,'Show'Node'

'Details,'Show'Contribu7on'Index'over'7me,''or'Show'
'Ac7vity'and'Sen7ment'Over'Time''

•  Right&Click&a&Single&Edge&to'Show'Edge'Details'which'depends'
upon'the'data'type.'

•  Hover&cursor&over'a'node'to'display'node'details'in'lower''
right'window'
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Two$finger$swipe&up&to&Zoom,in&a$graph$

Before$Zoom/in$ A'er$Zoom/in$
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Two$finger$swipe&down&to&Zoom-out&a$graph$

Before$Zoom/out$ A'er$Zoom/out$
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!One!finger!Tap$and$Hold$a$node$
$to$move!the!en-re!graph!!

Before!Graph!Move! A'er!Graph!Move!
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Right&Clicking&on&a&Single&Node&or&Edge&
Display(&(Label(Op.ons(

Email(Example(

Single&Node,(Right(Click(for(Display(and(Label(Op.ons( Single&Edge,(Right(Click(to(show(details(

Note:&&
Node&and&Edge&display&and&label&op2ons&are&
based&on&a&dataset’s&proper2es.&
&
Op2ons&will&change&
with&dataset’s&a&type&(email,&web,&&Twi>er,&
Facebook,&etc.),&and&if&any&metrics&&have&been&
computed.,&such&as,&&Sen2ment&and&Influence&
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Right&Clicking&on&a&Single&Node&to&
Show&Contribu6on&Index&Over&Time&,&or&
Show&Ac6vity&and&Sen6ment&Over&Time&!

Single&Node,!
!Right!Click!Show&Contribu6on&Index& Single&Node,!

!Right!Click!Show&Ac6vity&and&Sen6ment&Over&Time&&
!
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Hover&cursor&over&node&&
to&display&details&in&lower&right&window&

Note:&details&vary&by&dataset&type.&
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Use$the$date$slider$to$explore$a$network$view.$If$you$click$on$the$
positon$dot$you$can$move$forward/back$the$view$one$frame$at$a$<me$
by$clicking$on$your$keyboard$right/le>$$arrow$keys$

TIP:$Dynamic$View$D$Keypad$Right/Le>$Arrow$Keys$
Moves$View$One$Frame$atDaD<me$$$

Use$Le>$Arrow$to$
Move$Back$A$Frame$

Use$Right$Arrow$to$
Move$Forward$A$Frame$



CHAPTER 9

Examples

The following are Condor 3 network ex-
amples which include:
Email, Facebook, Web, Twitter, Twitter 
Accounts , Wiki Evolution, and Wikipe-
dia categories.



MAIL EXAMPLE

Fetch your email using the Fetch menu.

Note: In preparation , you must know your email 
host IMAP server name. 

For example: 

Google’s gmail: imap.gmail.com

Apple iCloud: imap.mail.me.com

Tip: to find your IMAP server name try a search at 
Google.com for: “XXXX imap server name” 

where XXXX is the name of your email.

Or, contact your email support.

Tip: If your email has over 10,000 mails, it may 
take several hours to process.

SECTION 1

Mail Example
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1.#Dataset#Name#

2.#Email#Parameters#

3.#Select#Email#Folders#

4.#Processing##
#####Message#

Note:##
To#use#the#Fetch#Menu,#
first#use#the#File#Menu#to#create#or#
switch#to#a#Database#and#create#or#
open#a#dataset.#
#
Otherwise,#users#will##get#this#error#
message.#

There#is#a#sequence#of#4#windows.#

The next example uses the Enron small email dataset.
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Email&four&part&example&

Part&1:&Sta3c&View&Ini3al&Look&
Part&2:&Add&Annota3ons&&&Export&Nodes&
Part&3:&Dynamic&View&
Part&4:&Add&Influence&Measures&
&
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Part%1:%Condor%3%Mail%Example%Analysis%8%Sta:c%View%Ini:al%Look%

1.  Start%MySQL%and%Condor%3%
2.  Use%File%menu%to%create%a%Mail%database%and%dataset%
3.  Use%Fetch%%>%Fetch%mailbox%…%to%import%your%email%(Note:%Collec:ng%%content%takes%longer)%
4.  Use%Process%dataset%>%Node%merging%>%Auto%and/or%Manual%mode%

%Note:%This%will%merge%actors%who%have%more%than%one%email%address.%%
% %Save%the%merge%list%to%a%.CSV%file%to%check%for%accuracy/edi:ng%and%later%reuse%
%Tip:%Click%on%the%Name%Up/Down%Arrow%to%sort%ascending/descending%which%makes%it%
%easier%to%%scroll%through%the%lists%and%find%actors%with%more%than%one%email%address%

%
%
5.  Use%View%>%Create%Sta:c%View%%…%and%use%Condor%3’s%GUI%controls%to%examine%the%graph%

Note:%This%will%give%you%an%overall%view%of%the%structure%of%the%en:re%network%
Tip:%use%the%two%finger%zoom8in/out,%hover%over%a%node%to%review%the%details,%and%right%
click%on%node%to%selec:vely%label%with%their%name%or%other%a[ribute%

6.  Enter%a%term%into%the%search%textbox%and%review%its%distribu:on%in%the%network%
7.  Use%Node/Edge%pick%menus%to%color%nodes%by%domain%or%other%a[ribute%
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Email&Network&–&Sta0c&View&with&Nodes&Colored&by&Domain,&
Search&for&“California”,&Node&Size&Increased,&and&Hover&Cursor&over&Node&to&see&Details&

Select&
a&Node&field&to&
Color&

Enter&a&search&term&

Vary&&
the&nodes&
size&&

Hover&cursor&&
over&Node&
To&See&Details&
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1.  Use&Process&dataset&>&Annotate&>&Centrality&annota5ons&>&Betweenness&&
2.  Use&Process&dataset&>&Annotate&>&Centrality&annota5ons&>&Degree&
3.  Use&Process&dataset&>&&Calculate&&>&Sen5ment&&

&Tip:&Use&the&“comm_content”&field&for&the&Edge&Property&to&analyze,&and&set&&
Language&=&Detect&automa5cally,&Node&property&to&analyze&=&none,&check&add&
complexity&&&emo5onality,&Check&remove&html&first&

4.  Right&click&on&Ac5ve&file&with&a&“Blue&Dot”&to&“Save&dataset&as”&with&all&the&
annota5ons&for&reuse.&

&
&
&
5.  Use&File&>&Open&the&saved&dataset&
6.  Use&Export&>&data&>&…&and&export&nodes&and&use&a&spreadsheet&program&to&sort/

review&actors&by&&Centrality/Sen5ment&measures&
7.  Use&View&>&Create&Sta5c&View&&…&and&use&Condor&3’s&GUI&controls&to&examine&the&

graph&
8.  Use&Node/Edge&pick&menus&to&color&nodes&by&organiza5on,&Node&Size&by&

Betweenness,&etc.&

Part&2:&Condor&3&Mail&Example&Analysis&–&Add&Annota5ons&&&Export&Nodes&
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Email&Network&with&Nodes&Colored&by&Organiza8on,&
And&Node&Size&by&Betweenness&Centrality&&

Select&
a&Node&field&to&
Color&

Select&
a&Node&field&to&
Size&
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1.  Use&View&>&Create&Dynamic&View&&…&&
Note:&Reset&Start&Date&and&End&Dates&to&match&your&dataset’s&dates,&because&Condor&
resets&the&Start&Date&to&Dec&31,&1969&and&the&End&Date&to&Sep&10,&2013,&which&is&
most&likely&incorrect.&
TiP:&use&the&date&slider&to&explore&the&network&view.&If&you&click&on&the&posiOon&dot&
you&can&move&the&view&forward/back&one&frame&atQaQOme&by&clicking&on&your&
keyboard&right/leS&&arrow&keys&
&
&
&
&
&
&
&
&
&

2.  Use&Node&color&pick&menu&and&explore&
3.  Use&Node&Size&pick&menu&to&examine&Betweenness,&Degree,&Complexity,&EmoOonality,&

SenOment&
4.  ConOnue&to&explore&the&email&network&using&the&File&>&Open&dataset&and&the&2&stage&

filtering&of&the&nodes&and&links&and/or&prune&using&the&Process&dataset&menu.&

Part&3:&Condor&3&Mail&Example&Analysis&–&Dynamic&View&
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MOVIE 9.1 

Part 3: Condor 3 Mail Example Analysis – Dynamic View 
Sample Video with Node Size by Betweenness Centrality
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1.  Use&File&menu&to&Open&your&saved&dataset&with&your&Annota9ons&from&Part&2&

2.  Use&Process&dataset&>&&Calculate&&>&Influence&

3.  Tip:&Set&Langauge&…&=&Detect&Automa9cally;&Edge&Property&…&=&comm_content;&Check&“create&new&

dataset”;&and&edit&new&dataset&name,&click&Next&

&

&

&

&

&Note:&ATer&the&Influence&measures,&the&saved&dataset&will&open&as&the&ac9ve&dataset&as&indicated&

&with&the&green&checkmark&next&to&its&name.&

&

&

&

5.  Use&View&>&Create&Sta9c&View&&…&and&use&Condor&3’s&GUI&controls&to&examine&the&graph&

Note:&The&Influence&annota9on&will&create&a&revised&set&of&edge/link&connec9ons.&

Tip:&use&the&two&finger&zoom\in/out,&hover&over&a&node&to&review&the&details,&and&right&click&on&

node&to&selec9vely&label&with&their&name&or&other&a^ribute&

4.  Use&Node&color&pick&menu&and&explore&

5.  Use&Node&Size&pick&menu&to&examine&Total&Influence,&average&influence&per&message,&etc.&

6.  Con9nue&to&explore&the&email&network&using&the&File&>&Open&dataset&and&the&2&stage&filtering&of&

the&nodes&and&links&and/or&prune&using&the&Process&dataset&menu.&

Part&4:&Condor&3&Mail&Example&Analysis&–&Add&Influence&Measures&
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MOVIE 9.2 

Part 4: Condor 3 Mail Example Analysis – Dynamic View 
Sample Video with Node Size by Average Influence Per Message



FACEBOOK EXAMPLE

Follow these suggested steps to Fetch and 
Visualize your Facebook Network.

See page 57 for Fetch Steps. 

SECTION 2

Facebook Example

197



Condor 3 Facebook Profile Example Analysis

Suggested Steps:

1. Start MySQL and Condor 3

2. Use File menu to create a Facebook database and dataset

3. Use Fetch  > Fetch Facebook profile (suggest to uncheck 
Groups and Likes for your first fetch because it may take a 
very long time depending upon the size of that extended 
network)

4. Use Process dataset > Node merging > Manual node to 
merge possible duplicate user profiles and save merging 
to a .CSV file for later reuse if needed

5. Use View > Create Static View and use Condor 3 GUI con-
trols to examine the graph

6. Use Process dataset > Annotate > Centrality annotations 
> Betweenness 

7. Use Process dataset > Annotate > Centrality annotations 
> Degree

8. Use Process dataset >  Calculate  > Sentiment and use the 
“aboutMe” field for the Node Property to analyze (check 
complexity & emotionality option) Note: Influence cannot 
be calculated because there is no over time data.

9. Right click on Active file with a “Blue Dot” to save with all 
the annotations for reuse.

10. Use Export > data > and export nodes and sort/review ac-
tors by  Centrality/Sentiment measures

11. Use View > Create Static View  and again use Condor 3 
GUI controls to examine the graph:

12. Use Node color and explore: gender and locale

13. Use Node Menu Size to examine Betweenness, Degree, 
Complexity, Emotionality, Sentiment

14. Use Process dataset > Remove specific actors and remove 
yourself to examine how connected the members of your 
network are without you.

15. Use View > Create Static View  and again use use Condor 
3 GUI controls to examine the graph

16. Repeat steps 3-12, but collect Groups and Likes this time

17. Continue to explore your Facebook network using the File 
> Open dataset and the 2 stage filtering of the nodes and 
links and/or prune using the Process dataset menu.

The next pages provide some sample visualizations.
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Facebook(Network(with(Nodes(Colored(by(Locale(

Select(
a(Node(field(to(
Color(

For(28digit(country(locale(key(see:(h=p://www.worldatlas.com/aatlas/ctycodes.htm(
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Facebook(Network(with(Nodes(Colored(by(Gender(

Select(
a(Node(field(to(
Color(
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Facebook(Network(with(Node(Labels(using(“aboutMe”(

Select(
a(Node(field(to(
Label(
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Facebook(Network(with(Nodes(Colored(by(Gender,(
Node(Size(by(Emo;onality(and(Label(with(Emo;onality(Score(

Use(
Node(and((
Edge(
Pick(menus(
to(augment(
graph(
(



WEB EXAMPLES

Follow these suggested steps to Fetch and 
Visualize a Web Query using the Google Ajax and/
or Google CSE.

Note: To use the Google CSE option you must have 
a Google CSE Key. See page 22.

SECTION 3

Web Example
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&
or&switch&to&a&Database&and&
create&or&open&a&dataset&

1.#Dataset##

2.#Parameters#

3.#Select#
#####First#Layer#

4.#Process#
#####Message#

Note:&&
Google&CSE&requires&
an&API&Key.&
&
&
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Condor&3&Web&Example&Analysis&
Suggested&Steps:&
&
1.  Start&MySQL&and&Condor&3&
2.  Use&File&menu&to&create&a&Web&database&and&dataset&
3.  Use&Fetch&&>&Fetch&Web&(Select&Google&AJAX&for&your&1st&search,&Note:&you&need&a&Google&CSE&Key&to&

use&the&Google&CSE&opMon.&&Enter&Query,&such&as,&“IOT”&for&“Internet&of&Things.”&&Set&the&following:&
Results&per&query&=&100,&Max&depth&…&=&2,&Check:&Save&snippet,&Uncheck:&Save&content,&Uncheck:&Only&
consider&domain&level,&and&leave&other&opMons&blank.&&
Note:&Unchecking:&“Only&consider&domain&level”&will&result&in&capturing&the&full&URL&of&the&web&page&
from&the&Query&search,&which&you&can&copy&and&paste&into&your&browser&and&read&the&full&text.&

4.  Use&View&>&Create&StaMc&View&and&use&Condor&3&GUI&controls&to&examine&the&graph&
5.  Use&File&menu&to&create&another&dataset&(Same&database)&
6.  Repeat&Fetch&&>&Fetch&Web&(Select&Google&CSE,&Enter&the&same&Query&again&with&these&se`ngs:&

Results&per&query&=&100,&Max&depth&…&=&2,&Restrict&to&recent&results&(Only&CSE)&Mme&unit:&=&Months,&
Time&quanMty:&=6,&Restrict&to&specific&language&…=&English&or&other&choice;&Restrict&to&specific&country&
=&Blank&or&choose&a&country;&&Check&Save&snippet,&Uncheck&Save&content,&Uncheck:&Only&consider&
domain&level,&and&leave&other&opMons&blank.&&

7.  Use&View&>&Create&StaMc&View&&and&again&use&Condor&3&GUI&controls&to&examine&the&graph:&
8.  Use&File&>&Dataset&>&Merge&datasets&(&Pick&two&or&more&datasets&to&merge)&
9.  Use&View&>&Create&StaMc&View&and&use&Condor&3&GUI&controls&to&examine&the&merged&datasets&graph&

and&assess&the&difference&between&the&two&Google&search&engine&results.&
10.  ConMnue&to&explore&the&Google&CSE&opMons&and&repeat&the&same&Query&and&determine&what&new&web&

nodes&and&edges&are&being&updated&or&added&over&Mme.&
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Fetch&>&Fetch&Web&using&Google&Ajax&
Op8ons&Selec8ons&&

Note:&
Unchecking:&
“Only&consider&
domain&level”&will&
result&in&
capturing&the&full&
URL&of&the&web&
page&from&the&
Query&search,&
which&is&then&
available&in&the&
Node&details&to&
copy&and&paste&
into&your&browser&
and&read&the&full&
text.&
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View%>%Sta*c%View%using%Google%Ajax%
Query:%IOT%on%July%10,%2014%%
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Fetch&>&Fetch&Web&using&Google&CSE&
Op7ons&Selec7ons&&
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View%>%Sta*c%View%using%Google%CSE%
Query:%IOT%on%July%10,%2014%%
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View%>%Sta*c%View%of%Merged%Google%Ajax%and%CSE%datasets%
Query:%IOT%on%July%10,%2014%%
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Tip:%Right%Click%on%a%Node,%Select%Node%Details%and%copy%and%paste%URL%into%your%
Browser%to%read%the%full%ar@cle.%



TWITTER EXAMPLE

Follow these suggested steps to Fetch and 
Visualize a Twitter Query in a Static or Dynamic 
View.

The Twitter Fetch has options for repetitive 
fetching with a designated time delay and a 
geolocation restriction with a radius setting.

Note: To use the Fetch > Twitter option you must 
have installed the four Twitter API Keys. 

See page 34.

SECTION 4

Twitter Example
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&&
Twi:er&requires&
&4&Twi:er&API&Keys.&

1.#Dataset##

3.#Twi-er#4#Keys#
6.#Process#Message#

4.#Repe::ve#Op:ons#

7.#Wait#Message#
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Condor&3&Twi+er&Example&Analysis&

Suggested&Steps:&

&

1.  Start&MySQL&and&Condor&3&

2.  Use&File&menu&to&create&a&Twi+er&database&and&dataset&

3.  Use&Fetch&>&Fetch&Twi+er&(Note:&you&need&4&Twi+er&API&Keys&to&use&this&opMon).&

4.  Enter&a&Query,&such&as,&“IOT”&for&Internet&of&Things.&Set&the&following:&Check:&Only&collect&retweets&as&

communicaMon&links,&#Results:&250,&Uncheck&all&other&opMons.&

4.  Use&View&>&Create&StaMc&View&and&use&Condor&3&GUI&controls&to&examine&the&graph&

5.  Use&Process&dataset&>&Annotate&>&Centrality&AnnotaMons&>&Betweenness&Centrality&

7.  Right&click&on&file&with&the&Blue&Dot&and&SAVE&AS,&edit&filename&or&accept&default&name,&for&reuse&

8.  Use&View&>&Create&Dynamic&View.&Select&Time&Unit&=&Minutes,&Set&Start&and&End&Dates&and&Times.&&

&TIP:&Use&Export&>&Export&data&for&Links&to&.CSV&file.&Open&file&and&select&column&field&“created_at”.&

&Then&Format&>&Cells&>&Time&format&&as&“&7/11/2014&9:29:52&AM,”&which&makes&it&a&readable&date&and&sort&

&oldest&to&newest&and&note&start/end&dates&and&Mmes&to&use&with&Dynamic&View&form&sedngs.&

7.  Use&Condor&3&GUI&Dynamic&controls&to&examine&the&graph&by&minute&and&change&Node&Colors&by&

locaMon&and&Node&Size&by&Betweenness&or&other&desired&data&measures.&

8.  Use&File&menu&to&create&another&dataset&within&the&same&Twi+er&database&

9.  Repeat&Fetch&>&Fetch&Twi+er&and&use&repeMMve&fetching&and/&or&geolocaMon&restricMon&to&add&to&your&

inquiry.&

10.  Then&use&File&menu&>&Merge&datasets&to&combine&two&or&more&datasets&and&conMnue&to&explore&

graph.&

11.  &Use&Process&dataset&to&add&AnnotaMons,&SenMment&and&Influence&Measures&and&explore&graph&

12.  Export&>&Export&data&for&nodes&and&links&to&examine&annotaMons&and&other&measures&with&addiMonal&

soiware.&
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Fetch&>&Fetch&Twi+er&
Example&Se4ngs&for&Query&“IOT”&or&Internet&of&Things&
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Sta$c&View&+&“IOT”&or&Internet&of&Things&Tweets&
Node&Colors&by&Geoloca$on,&Node&Size&by&Betweeness&Centrality&&
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View%>%Dynamic%View%Se.ngs%%
Query:%IOT%on%July%11,%2014%%

Tip:%Use%Export%>%Export%data%for%Links%to%.CSV%file.%Open%file%and%select%column%field%“created_at”.%
Then%Format%>%Cells%>%Time%format%%as%“%7/11/2014%9:29:52%AM,”%which%makes%it%a%readable%date/
Xme%and%sort%from%oldest%to%newest%and%note%the%start/end%dates/Xmes%to%use%with%Dynamic%View%
form%se.ngs.%
%
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View > Dynamic View By Minute 
Query: IOT on July 11, 2014  

MOVIE 9.3 Twitter Dynamic view
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Sample'IOT'Link.csv'file'with'field'“created_at”'reforma>ed'Time.''

Tip:'Use'Export'>'Export'data'for'Links'to'.CSV'file.'Open'file'and'select'column'field'“created_at”.'
Then'Format'>'Cells'>'Time'format''as'“'7/11/2014'9:29:52'AM,”'which'makes'it'a'readable'date/
Tme'and'sort'from'oldest'to'newest'and'note'the'start/end'dates/Tmes'to'use'with'Dynamic'View'
form'seWngs.'

From' To'



TWITTER ACCOUNTS EXAMPLE

Follow these suggested steps to Fetch and 
Visualize a Twitter Accounts Query in a Static or 
Dynamic View.

The Twitter Accounts Fetch has options to include 
multiple Twitter names/Ids at one time and set the 
number of results desired per person.

Notes:

This example uses the previous Twitter Example as 
a starting point.

To use the Fetch > Twitter Accounts option you 
must have install the four Twitter API Keys. See 
page 26

SECTION 5

Twitter Accounts
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&&
Twi:er&Accounts&requires&
&4&Twi:er&API&Keys:&

1.#Dataset##

2.#Parameters#

3.#Twi1er#4#Keys#

4.#Process#Message#

Note:&Collect&one&or&more&
Twi0er&Accounts&with&a&
single&query&by&separa;ng&
Id(s)&with&a&comma&“,”&
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Condor&3&Twi+er&Accounts&Example&Analysis&
Suggested&Steps:&
Note:&This&Example&starts&by&using&the&Twi+er&Actor.csv&export&file&from&the&previous&Twi+er&Example.&If&you&have&not&completed&a&
Twi+er&Query&search,&then&you&need&to&have&at&least&one&Twi+er&user&name/Id&to&proceed&with&this&example.&
&
1.  Start&MySQL&and&Condor&3&
2.  Use&File&menu&and&switch&to&your&Twi+er&database&and&open&the&dataset&used&in&the&previous&Twi+er&Example&

&Note:&If&you&do&not&have&a&previous&Twi+er&database,&then&create&one&and&a&new&dataset&
3.  Use&Export&>&Export&data,&select&Actors&to&export,&create&a&.csv&filename&and&export.&
4.  Open&the&Actors.csv&file&and&sort&on&Betweenness&Centrality&from&largest&to&smallest.&
5.  Note&the&Twi+er&account&Name(s)/Id(s)&you&wish&to&collect&
6.  Use&Fetch&>&Fetch&Twi+er&Accounts&(Note:&you&need&4&Twi+er&API&Keys&to&use&this&opWon).&
7.  Enter&the&Twi+er&Account&Name(s)/ID(s&)&separated&by&a&comma&“,”.&&
8.  Enter&the&number&of&desired&results&per&person,&such&as,&100.&
9.  Enter&your&4&Twi+er&keys,&if&blank,&otherwise&Click&Next&and&a&process&message&will&appear.&
10.  Use&View&>&Create&StaWc&View&and&use&Condor&3&GUI&controls&to&examine&the&graph&
11.  Use&Process&dataset&>&Annotate&>&Centrality&AnnotaWons&>&Betweenness&Centrality&
12.  Right&click&on&file&with&the&Blue&Dot&and&SAVE&AS,&edit&filename&or&accept&default&name,&for&reuse&
13.  Use&View&>&Create&Dynamic&View.&Select&Time&Unit&=&Minutes,&Set&Start&and&End&Dates&and&Times.&&

TIP:&Use&Export&>&Export&data&for&Links&to&.CSV&file.&Open&file&and&select&column&field&“created_at”.&Then&Format&>&Cells&>&Time&
format&&as&“&7/11/2014&9:29:52&AM,”&which&makes&it&a&readable&date&and&sort& &oldest&to&newest&and&note&start/end&dates&and&
Wmes&to&use&with&Dynamic&View&form&seengs.&

14.  Use&Condor&3&GUI&Dynamic&controls&to&examine&the&graph&by&minute&and&change&Node&Colors&by&locaWon&and&Node&Size&by&
Betweenness&or&other&desired&data&measures.&

15.  Use&File&menu&to&create&another&dataset&within&the&same&Twi+er&Accounts&database&
16.  Repeat&Fetch&>&Fetch&Twi+er&accounts&&
17.  Then&use&File&menu&>&Merge&datasets&to&combine&two&or&more&datasets&and&conWnue&to&explore&graph.&
18.  Use&Process&dataset&to&add&AnnotaWons,&SenWment&and&Influence&Measures&and&explore&graph&
19.  Export&>&Export&data&for&nodes&and&links&to&examine&annotaWons&and&other&measures&with&addiWonal&sohware.&
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Iden%fying*Twi-er*Name(s)/Id(s)*to*be*used*in**
Fetch*>*Twi-er*Accounts*from*a*previous*Twi-er*search*

Exported*Twi-er*dataset*Actors.csv*file*sorted*by*Betweeness*Centrality*

Enter*the*Twi-er*Name(s)/Ids*into*Twi-er*Accounts*fetch*form*separa%ng*the*
Names/Ids*with*a*comma*“,”.*
For*example*from*the*above*file:*CharlesKriete,*NetOfEverything,*TheIoT*
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Sta$c&View&–&Twi-er&Accounts&from&“IOT”&Internet&of&Things&
Previous&Twi-er&Query&

Node&Colors&by&Geoloca$on&
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Sample'Link.csv'file'with'field'“created_at”'reforma;ed'Time.''

Tip:'Use'Export'>'Export'data'for'Links'to'.CSV'file.'Open'file'and'select'column'field'“created_at”.'
Then'Format'>'Cells'>'Time'format''as'“'7/11/2014'9:29:52'AM,”'which'makes'it'a'readable'date/
Sme'and'sort'from'oldest'to'newest'and'note'the'start/end'dates/Smes'to'use'with'Dynamic'View'
form'seVngs.'

From' To'
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View%>%Dynamic%View%Se.ngs%%

Query:%From%May%29,%2014%to%July%12,%2014%

Tip:%Use%Export%>%Export%data%for%Links%to%.CSV%file.%Open%file%and%select%column%field%“created_at”.%

Then%Format%>%Cells%>%Time%format%%as%“%7/11/2014%9:29:52%AM,”%which%makes%it%a%readable%date/

Wme%and%sort%from%oldest%to%newest%and%note%the%start/end%dates/Wmes%to%use%with%Dynamic%View%

form%se.ngs.%

%
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View%>%Dynamic%View%By%Weeks%
Query:%Twi6er%Accounts%from%May%29,%2014%to%July%12,%2014%C%

MOVIE 9.4 Twitter Accounts Dynamic View



WIKI EVOLUTION EXAMPLE

Wiki Evolution is one of Condor 3’s most unique 
and sophisticated fetch options.

Wiki Evolution creates a network graph based on 
how articles have been internally linked over time. 

Follow these suggested steps to Fetch and 
Visualize a Wiki Evolution Query in a Static or 
Dynamic View.

Wiki Evolution uses the Condor 3 Wizard to step 
the user through a sequence of seven form options 
to refine the resulting network. 

SECTION 6

Wiki Evolution Example

Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

1.#Dataset##

2.#Language#

3.#Query#

4.#Ar4cle#Selec4on#

5.#Limita4on#Op4ons##

6.#Sta4c/Dynamic##

7.#Bidirec4onal#

8.#Content#Op4ons#

9.#Process#Message#
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Wiki Evolution is one of Condor 3’s most unique and sophisticated fetch options.

First, Wikipedia is an encyclopedia of articles (http://en.wikipedia.org/ ) in many different languages. 

Wiki Evolution uses an article’s edit history to construct a Wikipedia article internal link network of references over 
time. This enables a user to visualize the historical evolution for a single article or set of articles in Wikipedia. The re-
sult is an article  link network movie or “Wiki-Evolution.”  The network consists of only Wikipedia article internal 
links and not an article’s text edits. No external Web URL links are included because they lack timestamps for when 
they were added. 

Wiki Evolution uses the Condor 3 Wizard to step the user through a sequence of seven form options to refine the re-
sulting network. The seven forms include: 1. a choice of eight different languages; 2. the use of Wikipedia's Query 
search engine for searching a topic; 3. an article selection picker to add or remove articles from the initial query 
search results; 4. an option to  limit the final results by date or number of article revisions; 5. a Static/Dynamic for-
mat selection; 6. a choice to only use  bidirectional links for a static view; and, 7. three content selection choices. 
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http://en.wikipedia.org
http://en.wikipedia.org
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!
1.   Language:*eight!choices!are!available:!English,!German,!Spanish,!Italian,!

Russian,!Korean,!Indonesia,!and!Vietnamese.!
2.   Query:*Condor!3!uses!Wikipedia’s!sophisCcated!query!search!engine!for!very!

precise!searching!of!arCcles!and!its!contents!using:!
•  Boolean!logic!(AND,!OR);!!
•  Phrases!in!double!quotes;!!
•  Exclusion!to!exclude!terms;!!
•  Wildcard!for!characters!to!take!the!place!of!other!characters;!and!!
•  Fuzzy!to!match!words!with!similar!spellings.!

!
!In!addiCon,!searches!can!take!advantage!of!Wikipedia’s!!“inCtle,”!or!
“category,”!or!“prefix”!parameters!to!refine!a!search.!!
!
The!Wikipedia!default!search!uses!stemming,!which!can!be!turned!off!is!
some!cases!with!double!quotes!around!the!term!for!an!exact!match.!For!
more!informaCon!on!searching!see:!

Wiki!EvoluCon!seven!form!opCons!include:!

http://en.wikipedia.org/wiki/Help:Searching

http://en.wikipedia.org/wiki/Help:Searching
http://en.wikipedia.org/wiki/Help:Searching


3.   Limita(ons:-A"user"has"two",me"frame"op,ons"to"construct"the"internal"link"
network:""
a.  History"by"date:"From"X"Start"date"To"Y"End"date;"or""
b.  History"by"last"number"of"revisions"with"the"default"set"to"the"last"250"

revisions."
Note:"Wikipedia"itself"was"started"in"January"of"2001"and"will"not"have"any"
dates"prior"to"that"date."
"

4.   Ar(cle-Selec(on:-An"ar,cle"picker"enables"users"to"add"or"remove"one"or"more"
ar,cles"for"the"network"construc,on"

"

5.   Sta(c/Dynamic:"Three"choices"are"offered:"Sta,c"only,"Dynamic"only,"or"Sta,c"
and"Dynamic"

"

6.   Bidirec(onal:-Op,on"to"only"fetch"bidirec,onal"links"for"crea,ng"a"sta,c"network"
Note:-If-you-uncheck-this-op(on-to-collect-nonCbidirec(onal-links,-the-search-may-take-a-very,-very,-long-(me,-even-
exceeding-24-hours,-because-some-ar(cles,-such-as-for-a-country,-have-a-very-large-link-network.--So,-when-unchecking-this-
op(on-you-may-wait-a-very-long-(me-for-the-search-to-finish.-
"

7.   Content-Op(ons:-Three"choices"are"offered:"Do"not"fetch"content;"Complete"
Content;"and"Only"snippets"

Wiki"Evolu,on"Seven"Form"Op,ons"(con,nued)"
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Condor&3&Wiki&Evolu/on&Example&
Suggested&Steps:&
&
1.  Start&MySQL&and&Condor&3&
2.  Use&File&menu&to&create&a&Wiki&Evolu/on&database&and&dataset&
3.  Use&Fetch&>&Fetch&Wiki&evolu/on.&Suggested&seGngs&for&the&7&form&op/ons:&

a.  Language:&English&
b.  Query:&“Internet&of&Things”&Note:&with&double&quota/on&marks&
c.  Ar/cle&Selec/on:&Add&only&one&ar/cle:&“Internet_of_Things”&&
d.  Limita/ons:&Start&Date:&Jul&11,&2014&&End&Date:&Jul&18,&2014&
e.  Sta/c/Dynamic:&Sta/c&&
f.  Bidirec/onal:&Check&
g.  Content:&Snippet&
Note:&This&took&a&few&minutes&to&run&and&resulted&in&66&ar/cle&nodes&and&1,978&links.&
&

TIP:&Wikipedia’s&API&is&very&slow&and&a&very&popular&topics&will&have&thousand&of&ar/cle&links,&thus&
your&search&may&take&many&hours&to&run.&It&is&suggested&to&start&with&a&short&/meframe&to&obtain&a&
result&in&a&few&minutes,&then&expand&your&/me&frame.&

&

4.  Use&View&>&Create&Sta/c&View&and&use&Condor&3&GUI&controls&to&examine&the&graph&
5.  Use&Process&dataset&>&Annotate&>&Centrality&Annota/ons&>&Betweenness&Centrality,&Degree&Centrality&

and&Sen/ment&
6.  Use&Condor&3&GUI&controls&to&explore&graph&by&changing&Node&size,&Node&Labels,&Right&click&on&a&Node&

to&show&the&node&details&and&read&an&ar/cle’s&snippet,&which&may&be&quite&long&
7.  Right&click&on&file&with&the&Blue&Dot&and&SAVE&AS,&edit&filename&or&accept&default&name,&for&reuse&
8.  Export&>&Export&CSV&for&actors&and&edges&to&examine&with&addi/onal&soeware.&
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Condor&3&Wiki&Evolu/on&Example&
Internet&of&Things&–&July&11&to&18,&2014&with&Node&Size&by&Sen/ment&
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Condor&3&Wiki&Evolu/on&Example&
Internet&of&Things&–&July&11&to&18,&2014&with&Node&Size&by&Sen/ment&

Zoomed&in&view&with&Node&Names&
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Condor&3&Wiki&Evolu/on&Example&
Internet&of&Things&–&July&11&to&18,&2014&with&Sample&Export&Actor&and&Edge&Files&with&

Betweenness&Centrality,&Degree&Centrality&and&Sen/ment&Measures&

Actor&Export&CSV&file&contents&

Edge&Export&CSV&file&contents&
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9.  Use&File&menu&to&create&another&Wiki&Evolu7on&dataset&within&the&same&database&

10.  Use&Fetch&>&Fetch&Wiki&evolu7on.&Suggested&se@ngs&for&the&7&form&op7ons:&

a.  Language:&English&

b.  Query:&“Internet&of&Things”&Note:&with&double&quota7on&marks&

c.  Ar7cle&Selec7on:&Add&only&one&ar7cle:&“Internet_of_Things”&&

d.  Limita7ons:&Start&Date:&Jul&11,&2014&&End&Date:&Jul&18,&2014&

e.  Sta7c/Dynamic:&Sta7c&and&Dynamic&

f.  Bidirec7onal:&Uncheck&

g.  Content:&No&Content&

&

Note:&This&took&a&few&minutes&to&run&and&resulted&in&235&ar7cle&nodes&and&2,952&links.&

&

TIP:&Wikipedia’s&API&is&very&slow&and&a&very&popular&topics&will&have&thousand&of&ar7cle&

links,&thus&your&search&may&take&many&hours&to&run.&It&is&suggested&to&start&with&a&short&

7meframe&to&obtain&a&result&in&a&few&minutes,&then&expand&your&7me&frame.&

&

4.  Use&View&>&Create&Dynamic&View&and&use&Condor&3&GUI&controls&to&examine&the&graph&

7.  Use&Condor&3&GUI&Dynamic&controls&to&examine&the&graph&by&day&and&view&Node&Labels&by&

name&

8.  Export&>&Export&CSV&for&actors&and&edges&to&examine&with&addi7onal&so`ware.&

Condor&3&Wiki&Evolu7on&Example&(con7nued)&
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Condor&3&Wiki&Evolu/on&Example&
Internet&of&Things&–&July&15&to&19,&2014,&Dynamic&View&

MOVIE 9.5 Wiki Evolution Dynamic Example



WIKI CATEGORIES

Follow these suggested steps to Fetch and 
Visualize a Wiki Categories search in a Static View.

Wikipedia Categories (along with other features 
like cross-references, lists, and infoboxes) help you 
to find information, even if you don't know what 
exists or what it's called. 

http://en.wikipedia.org/wiki/Portal:Contents/Categories

 

SECTION 7

Wiki Categories Example
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&
For&details&on&Wikipedia&Categories:&
See:&

1.#Dataset##

2.#Language,#Category,#Depth#

3.#Process#Message#

http://en.wikipedia.org/wiki/Portal:Contents/Categories

http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories


237

What%are%Wiki%Categories?%
%

First,%Wikipedia%is%an%encyclopedia%of%ar8cles%(h:p://en.wikipedia.org/%)%in%many%
different%languages.%%
%

Wikipedia%Categories%(along%with%other%features%like%crossCreferences,%lists,%and%
infoboxes)%help%you%to%find%informa8on,%even%if%you%don't%know%what%exists%or%what%
it's%called.%The%following%is%a%list%of%the%12%main%categories%of%Wikipedia's%coverage.%

See: http://en.wikipedia.org/wiki/Portal:Contents/Categories

http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
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Society(and(social(
sciences(is#one#of##the#12#
main#content#categories#

Linguis1cs#is#a#
subcategory#of#Society#
and#social#sciences#and#
has#71#subcategories#

Quan1ta1ve(linguis1cs(
is##a#subcategory#of#
Linguis2cs#and#has#21#pages#

12#Main#Content#Categories#
http://en.wikipedia.org/wiki/Portal:Contents/Categories

http://en.wikipedia.org/wiki/Portal:Contents/Categories#
Society_and_social_sciences

http://en.wikipedia.org/wiki/Category:Linguistics

http://en.wikipedia.org/wiki/Category:Quantitative_linguistics

http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories#Society_and_social_sciences
http://en.wikipedia.org/wiki/Portal:Contents/Categories#Society_and_social_sciences
http://en.wikipedia.org/wiki/Portal:Contents/Categories#Society_and_social_sciences
http://en.wikipedia.org/wiki/Portal:Contents/Categories#Society_and_social_sciences
http://en.wikipedia.org/wiki/Category:Linguistics
http://en.wikipedia.org/wiki/Category:Linguistics
http://en.wikipedia.org/wiki/Category:Quantitative_linguistics
http://en.wikipedia.org/wiki/Category:Quantitative_linguistics


TIP:%Other%helpful%Wikipedia%links%are:%
Category%Tree:%
%
Searching:%
%
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!
1.   Language:*three!choices!are!available:!English,!German,!Spanish!
!
2.   Category:*See:**

Wiki!Categories!Fetch!op;ons!include:!

3.*Depth:*The!maximum!number!of!steps!from!a!category.!The!root!category!is!
at!depth!1,!first!pages!and!subcategories!are!at!depth!2.!

!
4.*Directed*Tree:*Check,!if!wish!to!have!pages!with!several!parents!or!mul;ple!

copies!result!in!a!directed!tree.!
!

http://en.wikipedia.org/wiki/Special:CategoryTree

h"p://en.wikipedia.org/wiki/Portal:Contents/Categories

http://en.wikipedia.org/wiki/Help:Searching

http://en.wikipedia.org/wiki/Special:CategoryTree
http://en.wikipedia.org/wiki/Special:CategoryTree
http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Help:Searching
http://en.wikipedia.org/wiki/Help:Searching
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Note:&&
To&use&the&Fetch&Menu,&
first&use&the&File&Menu&to&create&or&
switch&to&a&Database&and&create&or&
open&a&dataset&

Note:&
For&details&on&Wikipedia&Categories:&
See:&

1.#Dataset##

2.#Language,#Category,#Depth#

3.#Process#Message#

h"p://en.wikipedia.org/wiki/Portal:Contents/Categories

http://en.wikipedia.org/wiki/Portal:Contents/Categories
http://en.wikipedia.org/wiki/Portal:Contents/Categories
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Condor&3&Wiki&Evolu/on&Example&
Suggested&Steps:&
&
1.  Start&MySQL&and&Condor&3&
2.  Use&File&menu&to&create&a&Wiki&Categories&database&and&dataset&
3.  Use&Fetch&>&Fetch&Wiki&evolu/on.&Suggested&seGngs&for&the&7&form&op/ons:&

a.  Language:&English&
b.  Category:&Linguis/cs&
c.  Depth:&3&
d.  Tree&Structure:&Check&
Note:&This&took&a&few&minutes&to&run&and&resulted&in&23,322&nodes&and&23,321&links&
TIP:&Review&the&Wikipedia&Category&structure&to&help&determine&star/ng&category.&

&

4.  Use&View&>&Create&Sta/c&View&and&use&Condor&3&GUI&controls&to&examine&the&graph:&
&Note:&There&is&no&dynamic&view&because&the&links&are&not&/mestamped.&

8.  Export&>&Export&CSV&for&actors&and&edges&to&examine&with&addi/onal&soVware.&
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Condor&3&Wiki&Categories&
Example&Category:&Linguis9cs;&&
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Condor&3&Wiki&Categories&
Example&Category:&Linguis9cs&
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Condor&3&Wiki&Categories&
Example&Category:&Linguis9cs&>&Quan9ta9ve&Linguis9cs,&Pages&&ZoomAin&
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TIP:%To%retrieve%a%Wikipedia%Category/Sub8category%or%Page%
In%Condor,%click%on%a%node,%then%double%click%the%name%or%?tle%in%the%node%display%in%
the%lower%right%corner.%Next,%Copy%and%Paste%the%node’s%Title%into%the%Wikipedia%
Search%Box%and%press%enter%and%the%page%will%be%retrieved.%

Wikipedia%page%is%retrieved%.%.%.%

http://en.wikipedia.org/wiki/
George_Kingsley_Zipf

http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
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TIP:%Or,%use%a%node’s%“pagedid”%to%retrieve%a%single%page,%by%using%this%URL%prefix%
and%append%the%pageID.%%

Wikipedia%page%is%retrieved%.%.%.%

https://en.wikipedia.org/wiki?curid=768770

http://en.wikipedia.org/wiki/
George_Kingsley_Zipf

https://en.wikipedia.org/wiki?curid=768770
https://en.wikipedia.org/wiki?curid=768770
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
http://en.wikipedia.org/wiki/George_Kingsley_Zipf
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Actor&Export&CSV&file&contents&

Edge&Export&CSV&file&contents&

Condor&3&Wiki&Categories&
Example&Category:&Linguis>cs&

&Sample&Actor&and&Edge&Export&.CSV&files&
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TIP:%Edit%the%Actors%Category%.csv%file%and%create%a%Wiki_Category_page_URL%column%by%inserDng%a%
Wikipedia%URL%prefix%%(https://en.wikipedia.org/wiki?curid=%)%%column%and%merging%it%with%the%
pageId,%%then%copy%and%paste%this%Wiki_Category_page_URL%%into%your%browser%to%retrieve%any%page%from%
the%file.%
1.  Insert%two%columns:%URLprefix%and%Wiki_Category_page_URL%
2.  Copy%the%URLprefix%(https://en.wikipedia.org/wiki?curid=%)%down%the%enDre%column%
3.  Insert%a%merge%cell%formula:%D2&E2%into%the%Wiki_Category_page_URL%column%and%paste%it%down%

the%enDre%column%

4.%Next,%select%the%enDre%Wiki_Category_page_URL%%column%and%Edit%>%Copy%and%PASTE%SPECIAL%>%paste%
VALUES%to%replace%the%merge%cell%formula%with%the%actual%value.%Save%the%file.%

5.%Copy%the%desired%Wiki_Category_page_URL%and%paste%into%your%browser%to%
retrieve%the%Wiki%page%%
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Tip:%Use%Wikipedia’s%Special%Page:%Category)Tree)to%become%familiar%with%an%area%

Enter%a%Category%

Click%Show%Tree%

http://en.wikipedia.org/wiki/Special:CategoryTree

http://en.wikipedia.org/wiki/Special:CategoryTree
http://en.wikipedia.org/wiki/Special:CategoryTree


CHAPTER 10

Condor 3 
Updates

The purpose of this Chapter is to docu-
ment recent updates. Updates are in 
chronological order.

Users may Login to the  
Condor License Manager at:  

http://guardian.galaxyadvisors.com/guardian/

A Welcome Messages appears.
Enter your Login Username and Password  
and Click Sign in.

http://guardian.galaxyadvisors.com/guardian/
http://guardian.galaxyadvisors.com/guardian/


Condor-3.0.1.jar release dated: 9/29/2014 Build 2237 
was an early version.  
The Help menu About option did not display your license key 
and did not have an “Unregister computer” menu option.

Note: Users who are using the early Condor-3.0.1.jar dated 
9/29/2014 will need to download the later version dated  
10/19/2014 in order to install the new release of 
Condor-3.0.2.jar dated 12/19/2014. Use this link to down-
load the 10/19/2014 Condor-3.0.1.jar to replace your earlier 
9/29/2014 release.

http://91.250.82.108:8080/condor/Condor-3.0.1.jar

Otherwise when starting the Condor-3.0.2.jar it will give a 
message that your license key is already in use. By replacing 
the Condor-3.0.1.jar with the later release dated 10/19/2014 
it will resolve this error.
To check what Condor version you are running, click on the 
Help menu then About to see the version date and build num-
ber.
If you are running Condor-3.0.1.jar dated 10/19/2014 you 
should be able to start the Condor-3.0.2.jar without any prob-
lem.

 Condor-3.0.1.jar release dated: 10/19/2014 Build 
2155 does display your License Key and does have the 
“Unregister license” menu option under the Help menu.

The “Unregister license” option enables users to move their 
Condor License Key to another computer.
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Condor 3.0.2.jar release dated: 12/19/2014 Build 1111 had 6 
notable changes as follows: 

1.  NEW File > MySQL Import: experimental import from MySQL 
databases with node and edge tables 

2.  NEW network visualization coloring for nodes and edges –  
Color by Top Value Properties 

3.  IMPROVED Export  > Export CSV: now includes the fields:  
Starttime and Endtime 

4.  IMPROVED File > Import CSV: adds more flexibility in field selection 
and configuration 

5.  IMPROVED text wrapping for easy reading of content when right 
clicking on a node or edge to show details 

6.  IMPROVED social network analysis algorithms and visualization 
performance using more parallelism 

NEW File > Import MySQL 
 

1.  2.  

3.  4.  5.  

NEW File > Import MySQL 
 

Tip: Open an existing Condor 3 Database/Dataset and Export it using the 
Export > Export MySQL Dump and then use the File > Import MySQL. 

Suggested Steps: 
1.  Use MySQL Workbench to identify the existing Condor 3 Database 

“characterset” and “collation,” such as, latin1 and latin1_swedish_ci  
2.  Start Condor 3 and open the existing Database/dataset and Export 

using the Export > Export MySQL to a “name.sql” file 
3.  Use MySQL Workbench to create a new Database and import the 

“name.sql” file and set the “characterset” and “collation” with the 
previous values 
 Note: Use this database/dataset tables to access node or edge fields,  
 because they are no longer in the default blob format.  

4.  Use Condor 3 to create a new database and then import the MySQL 
file created in step 3 with the File > Import MySQL menu and follow 
the prompts.   
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NEW network visualization coloring for nodes and edges 
Color by Top Value Properties 

Sample Actors.csv output with Starttime and Endtime fields 

Sample Links.csv output with Starttime and Endtime fields 

IMPROVED Export > Export CSV 
Now includes the Actor and Link fields: Starttime and Endtime 

IMPROVED File > Import CSV: adds more flexibility in field selection 
and configuration 

Click + to add a field 

Click + to add a field 

Note: Select a field 
to rename or edit 
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IMPROVED Export  > Export CSV 
Now includes the Actor and Link fields: Starttime and Endtime 



IMPROVED social network analysis algorithms and visualization 
performance using more parallelism 

•  Annotations calculate faster 
•  Graphical user interface visualizations have improved performance  
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Condor 3.1.1.jar released date 03/08/2015 Build 1048 
had three notable updates as follows:

1. NEW Process dataset Actor and Link filtering options
2.  NEW Process dataset Location annotation
3.  NEW Help Manuals download links



1. [Fetch] Microsoft Outlook Exchange Email import with EWS option 
 

a. Fetch > Fetch mailbox  

b. Select Dataset (New/Open)  

c. Select Exchange (EWS) 
And complete form 

d. Select Start/End Date Restrictions 

e. Select desired folders  

2. [Fetch] Microsoft Outlook Exchange Calendar import  
 

a. Fetch > Exchange calendar 

b. Select Dataset (New/Open)  

c. Complete Exchange Calendar form 
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Condor 3.2.0 .jar released date 08/03/2015 Build 
1913 had these notable updates as follows:

Nine New Features or Options include:
1. [Fetch] Microsoft Outlook Exchange Email import  

with Exchange Web Services (EWS) option
2. [Fetch] Microsoft Outlook Exchange Calendar import 
3. [Process dataset] Endpoint based edge filters 
4. [File] Imports numbers from CSV 
5. [File] Optional random uuid generation for CSV import 
6. [View] Temporal social surface view 
7. [Export] Export time series for: Contribution index,  

AWVCI, betweenness centrality, betweenness oscillation,  
graph density, and turn taking 

8. [Process dataset] Sentiment analysis for Italian and Portuguese 
9. [Analyze] Collapse by original dataset

Four Improvements include:
1. [View] Better adjacency matrix with heat map and labeling op-

tions
2. [View] Labels in scatter plot 
3. Faster graph layouts
4. Better UTF-8 support for Simplified Chinese



3. [Process dataset] Endpoint based edge filters (Link Properties Option) 
 

a. Process dataset > Link filter 

b. Select Link Filter option: 

c. Select Link Properties 

3. [Process dataset] Endpoint based edge filters (Boolean Option) 
 

a. Process dataset > Link filter 

b. Select Link Filter option: 

c. Select Link Properties 

4. [File] Imports numbers from CSV  
 

a. File > Import CSV  

b. Enter name of new dataset 

c. Select CSV field delimiter and 
    Actor and Link files 
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4. [File] Imports numbers from CSV (continued) 
5. [File] Optional random uuid generation for CSV import  
  
 

d. To import a field as a number: 
Click  “Use as” to the right of the field, 
Select “other int (64 bit) field” or “float (64-bit)” 
 

e. Note:  If you receive a warning 
message 

Check both options at the bottom of the form 



6. [View] Temporal social surface view  
  
 

a. View > Create temporal social surface  
 

See: Kidane, Y. Gloor, P. Correlating temporal communication patterns of the Eclipse open source 
community with performance and creativity, Computational & Mathematical Organization Theory. 
Volume 13, Issue 1 (March 2007), ISSN:1381-298X, 17 - 27, 2007 

Betweenness Centrality 
High 

Low 

Pattern of Creativity 

Betweenness Centrality 
High 

Low 

Pattern of Performance 

High 

Low 
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How can you identify the actors in the  
3D Temporal Social Surface View? 

1.  Process dataset > Annotate > Centrality > Betweenness Centrality 
2.  Export > Time series > Betweenness Centrality 
3.  Select CSV file (create a name) 
4.  Export data (Select Time Unit, Start/End dates, With or Without History) 
5.  Open saved.CSV file  
6.  Create a row sum variable for the Betweenness Centrality for each actor 
7.  Sort the row sum variable from largest to smallest 
Result is listing of actors ranked by Betweenness Centrality 

7. [Export] Export time series for: Contribution index, AWVCI, betweenness 
centrality, betweenness oscillation, graph density, and turn taking  
  
  
 

a. Export > time series 

b. Select property to export, then select CSV file. 

Note: 
First, use Process dataset 
to calculate desired 
measure to export. 

8. [Process dataset] Sentiment analysis for Italian and Portuguese  

a. Process dataset > 
 Calculate sentiment 

b. Italian and Portuguese are new selections. 

9. [Analyze] Collapse by original dataset 
  

a. Analyze > Create collapsed graph 

Before Collapse After Collapse by Domain 
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Four Improvements include: 
1. [View] Better adjacency matrix with heat map and 
              labeling options 
2. [View] Labels in scatter plot  
3. Faster graph layouts 
4. Better UTF-8 support for Simplified Chinese 

1. [View] Better adjacency matrix with heatmap and labeling options 
 

a. View > Adjacency matrix  
Note: New Heatmap option and Node Labels, 
Drag mouse over nodes to display labels 

2. [View] Labels in scatter plot 

a. View > Actor scatter plot  Note: New Scatter Plot Label options 

3. Faster graph layouts 

Faster Layouts 
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4. Better UTF-8 support for Simplified Chinese 
 

UTF-8 means: Universal Transformation Format—8-bit. 
 

UTF-8 is a character encoding capable of encoding all possible characters. 
 
Condor 3 now better supports Simplified Chinese throughout the entire 
program.  
 

For more information on UTF-8 see: 
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https://en.m.wikipedia.org/wiki/UTF-8

https://en.m.wikipedia.org/wiki/UTF-8
https://en.m.wikipedia.org/wiki/UTF-8


CHAPTER 11

Geocoding 
with Twitter 
Fetch

Condor 3’s Fetch > Fetch Twitter option enables the 
user to fetch tweets restricted to a given geolocation.

This chapter explains how to use the website: 
http://www.gpsvisualizer.com/geocoder/
to find a city’s geocodes, map it and draw a range ring 
around it to have a sense of the geographic coverage of 
your Twitter Fetch. It also explains how to obtain a free 
Bing Map key to obtain 5 or more city geocodes at one 
time.

http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/


Condor 3’s Twitter Fetch option enables the user to restrict the collection of tweets around a specified geolocation using a city’s geo-
codes of latitude and longitude. Thus, how do you find a city’s geocodes? One solution is to use the free website: 
http://www.gpsvisualizer.com which enables users to obtain a city’s geocodes of latitude and longitude by entering in their names 
at: http://www.gpsvisualizer.com/geocoder/. It also can map the location of the cities with a pin marker and save the map for later 
reuse, as well as, draw a range ring around a city given a radius in miles or kilometers at: 
http://www.gpsvisualizer.com/calculators. 

If you wish to geocode 5 or more locations at time, you will need a free Bing Map Key.

This chapter includes three sections:

Section 1 explains how to obtain a city’s geocodes of  latitude and longitude when using Condor 3‘s menu: Fetch > Fetch Twitter ... 
Enable geolocation restriction.

Section 2 explains how to draw a map with a range ring around a city.

Section 3 explains the steps to obtain a Bing Map Key, which enables users to geocode 5 or more cities at a time.

Note: Geocoding is the process of finding associated geographic coordinates (often expressed as latitude and longitude) from other geographic 
data, such as street addresses, or ZIP codes (postal codes). With geographic coordinates the features can be mapped. 
(http://en.wikipedia.org/wiki/Geocoding)
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http://www.gpsvisualizer.com
http://www.gpsvisualizer.com
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/calculators
http://www.gpsvisualizer.com/calculators
http://en.wikipedia.org/wiki/Geographic_coordinates
http://en.wikipedia.org/wiki/Geographic_coordinates
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Longitude
http://en.wikipedia.org/wiki/Longitude
http://en.wikipedia.org/wiki/Street_address
http://en.wikipedia.org/wiki/Street_address
http://en.wikipedia.org/wiki/ZIP_codes
http://en.wikipedia.org/wiki/ZIP_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Geocoding
http://en.wikipedia.org/wiki/Geocoding


HOW TO OBTAIN A CITY’S GEOCODES?

First, What is geocoding?

Geocoding is the process of finding associated 
geographic coordinates (often expressed as 
latitude and longitude) from other geographic 
data, such as street addresses, or ZIP codes (postal 
codes). With geographic coordinates the features 
can be mapped. (http://en.wikipedia.org/wiki/
Geocoding)

We will use the website: http://
www.gpsvisualizer.com/geocoder/

to find a city’s geocodes and  map it. 

The next section will explain how to draw a range 
ring around it to have a sense of the geographic 
coverage of a Twitter Fetch.

SECTION 1

How to obtain a city’s geo-
codes
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 http://www.gpsvisualizer.com/geocoder/

Convert City Names or addresses to latitude 
and longitude coordinates to use with 
Twitter Fetch

http://en.wikipedia.org/wiki/Geographic_coordinates
http://en.wikipedia.org/wiki/Geographic_coordinates
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Longitude
http://en.wikipedia.org/wiki/Longitude
http://en.wikipedia.org/wiki/Street_address
http://en.wikipedia.org/wiki/Street_address
http://en.wikipedia.org/wiki/ZIP_codes
http://en.wikipedia.org/wiki/ZIP_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Postal_codes
http://en.wikipedia.org/wiki/Geocoding
http://en.wikipedia.org/wiki/Geocoding
http://en.wikipedia.org/wiki/Geocoding
http://en.wikipedia.org/wiki/Geocoding
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Latitude
http://en.wikipedia.org/wiki/Longitude
http://en.wikipedia.org/wiki/Longitude
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Condor&3&How&to&obtain&a&City’s&Geocodes&

Suggested&Steps:&
&

1.  Go&to&GPS&Visualizer’s&website&at:&h@p://www.gpsvisualizer.com/geocoder/&

2.  In&the&Input:&box&enter&the&name&of&a&city&or&an&address,&one&per&line,&up&to&five&names&or&addresses.&If&

more&than&5,&then&you&need&a&Bing&Map&Key&

&For&example:&

3.  Click&"Start&geocoding"&to&find&their&laQtude&and&longitude,&which&will&be&displayed&in&the&
Results&as&text:&

&For&example:&

4.&Click,&Draw&map&and&check&Labels&on&map&to&visualize&geolocaQons&
5.&When&using&Fetch&>&Twi@er&with&geolocaQon&opQon,&enter&laQtude&and&longitude&
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Sample'Geocoding'of'5'City'Names'
h7p://www.gpsvisualizer.com/geocoder/'
'

Enter'a'city'name'or'address,'one'per'line'
1.'

2.'

3.'Geocodes' 4.'Map'
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Note:&The&map&is&temporarily&available&to&view&or&download&from&GPSVisualizer.com.&
For&example:&file:///Users/Ken/Downloads/20140716084117L25141Lmap.html&
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When using Fetch >Twitter with geolocation option,
Enter Latitude and Longitude results obtained from GPS Visualizer geo-
coding

Enter a radius and choose unit of miles (mi) or kilometers (km)



HOW TO DRAW A RANGE RING AROUND A CITY

Follow these suggested steps to draw a range ring 
around a city to approximate the geographic 
coverage of your Twitter Fetch using the radius 
option.

 

SECTION 2

How to draw a range ring 
around a city

Use$GPS$Visualizer$Calculators$to$Draw$a$Range$Ring$Around$a$City$
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http://www.gpsvisualizer.com/calculators

http://www.gpsvisualizer.com/calculators
http://www.gpsvisualizer.com/calculators
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Condor&3&How&to&draw&a&range&ring&around&a&city&
Suggested&Steps:&
&
1.  Go&to&GPS&Visualizer’s&Calculators&page&at:&h?p://www.gpsvisualizer.com/calculators&
2.  Scroll&down&to&the&secDon:&Draw&a&range&rings&around&a&point&

&Enter&the&laDtude&and&longitude&for&your&desired&city.&
&For&example,&London&England&the&Lat.,Lon&is:&51.5064316,P0.12719&

3.  Enter&a&radius,&such&as&100Km&
4.  Click&Draw&a&Map&
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Use$GPS$Visualizer$Calculators$to$Draw$a$Range$Ring$Around$a$City$

http://www.gpsvisualizer.com/calculators

Sample'Range'Ring'of'100km'around'London'

1.'Enter'Lat.'Lon' 2.'Enter'Radius' 3.'Draw'Map'

http://www.gpsvisualizer.com/calculators
http://www.gpsvisualizer.com/calculators
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Google&Maps&output!

Note:!The!map!is!temporarily!available!to!view!or!download!from!GPSVisualizer.com.!

Sample'Range'Ring'of'100km'
'around'London'



HOW TO OBTAIN A BING MAY KEY

Follow these suggested steps to obtain a Bing Map 
Key to use with the GPS Visualizer website to 
geocode more than 5 cities or addresses at one 
time.

Note:

These instructions are for getting a BING key, 
however, a MapQuest or Google key will work too.

SECTION 3

How to obtain a Bing Map 
Key
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How to get a BING Map Key for 
http://www.gpsvisualizer.com/geocoder/

Overview: If you wish to obtain 5 or more geocodes at one 
time, you will need to get a map key for: Bing, MapQuest, or 
Google .

These instructions are for getting a BING Map Key:

1. Go to http://www.gpsvisualizer.com/geocoder/

Click,'Get'a'key'

2. Click on the GET BING option: 
http://www.gpsvisualizer.com/geocoder/key.html#bing

!

3. Click on the link: http://www.bingmapsportal.com

Which will take you to the Bing Maps Account Center.

4. Sign in with your Microsoft account (formerly Windows 
Live account) or click on “New User” to create an account.  

5. After clicking on the previous Sign in, a new Sign In win-
dow opens. Sign in here.

6. In the left hand side panel, click on, “Create or view keys”

Click&
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http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/
http://www.gpsvisualizer.com/geocoder/key.html#bing
http://www.gpsvisualizer.com/geocoder/key.html#bing
http://www.bingmapsportal.com
http://www.bingmapsportal.com


7.  A Create key application window opens

!

8. Enter an application name, such as, GeocodingWithBing

You may skip the Application URL, or enter, 
http://www.gpsvisualizer.com/geocoder/

9. Under “ * Key type,” select “Basic.”

10. Under “ * Application type,” select “Public website.”

11. Type in the “new image” code.

12. Click “Submit.”

13.Your Bing Map Key will then appear at the bottom under 
the Create Key form.

A"very"long"Bing"Map"Key"will"be"here."Copy"it"
App#Name#

 
14. Copy the Bing Maps API Key and go to

 http://www.gpsvisualizer.com/geocoder

15. Paste your key into the Bing Maps API Key box:

Paste&in&your&
Bing&Key&here&
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http://www.gpsvisualizer.com/geocoder
http://www.gpsvisualizer.com/geocoder


16. In the Input box:

 Enter your City names to geocode, one per line, such as:

Sochi,'Russia'
Berlin,'Germany'
San4ago,'Chile'
San'Francisco,'California'
New'York,'New'York'
Chicago,'IL'
Tokyo,'Japan'
London,'England'
Amsterdam,'Netherlands'
Sydney,'Australia'
Buenos'Aires,'Argen4na'
Vancouver,'Bri4sh'Columbia'
Montreal,'Quebec'
Seoul,'Korea'
Oslo,'Norway'
Vienna,'Austria'
Zurich,'Switzerland'
Paris,'France'

17. Click, Start Geocoding

!!!!!!!!!!!!Insert!Bing!Map!Key!here!

Results!will!appear!here!

18. See results in text box:
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19. Full view of Sample Results

20. Check Labels on Map, Click Draw Map

21. Map will be drawn with Labels

22. You can download the Google Map by clicking on the 
download button:

Click&to&down&load&map&.html&file&

23. A  “XXXX ~ -map.html” file will be downloaded and saved 
into your downloads folder.
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24. Sample saved map.html in browser

Hover cursor over map pins to see labels, Zoom – in/out

277



CHAPTER 12

Node and 
Edge 
Properties

Node and Edge Properties for 
Condor 3 Data Fetch Options:
1. Email 
2. Web_Ajax_or_CSE 
3. Twitter 
4. Twitter Accounts 
5. Facebook
6. Wiki_Evolution 
7. Wikipedia_Categories 
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Email Node and Edge Properties
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Facebook Node and Edge Properties
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Twitter Node and Edge Properties
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Twitter Node and Edge Properties (continued)
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Twitter Accounts Node and Edge Properties 
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Twitter Accounts Node and Edge Properties 
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Web Ajax or CSE  Node and Edge Properties
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Wiki Evolution Node and Edge Properties
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Wiki Categories Node and Edge Properties



CHAPTER 13

Structure and 
Content Measures

The purpose of this chapter is define the 
Structure and Content Measures used in 
analyzing a given network. 
Section 1 defines the network structure 
measures or centralities for individual 
measures of betweenness, closeness and 
degree, and the group measures of  group 
betweenness, group degree and  density. 
Section 2 defines the five content meas-
ures of activity, sentiment, emotionality 
complexity, and influence.
Section three articulates the Coolhunting 
and Coolfarming Collaborative Innova-
tion Networks (COINs) and their analyt-
ics as described in the introduction 
movie by Peter Gloor.

Condor 3’s  
Structure & Content Measures
Condor 3 calculates five individual centrality measures:

1. Betweenness
2. Betweenness Weighted
3. Closeness (Under development)
4. Degree, and
5. Degree Weighted.

Condor 3 calculates three Group Centrality measures:
1. Group Betweenness
2. Group Degree, and
3. Density.

Condor 3 calculates five Content measures:
1. Activity
2. Sentiment
3. Emotionality
4. Complexity, and
5. Influence



STRUCTURE MEASURES

The purpose of this section is to explain and illustrate the 
individual and group centralities or structure measures 
that Condor 3 calculates. Understanding these measures 
will help the user to interpret the variation in individual 
and group centrality scores. Centrality measures can be 
calculated, visualized and exported in Condor 3.

Condor 3 calculates five individual centrality measures:
1. Betweenness
2. Betweenness Weighted
3. Closeness (Under development)
4. Degree, and
5. Degree Weighted.

Condor 3 calculates three Group Centrality measures:
1. Group Betweenness
2. Group Degree, and
3. Density.

SECTION 1

Structure Measures
Note: 

This section is based on Wasserman, Stanley and Faust, Kath-
erine (1994) Social Network Analysis Methods and Ap-
plications, Chapter 5, Centrality and Prestige,  pp. 169-216.  
Cambridge: Cambridge University Press. 

In addition to using the Star, Circle, and Line graphs as ex-
amples; two more graphs have been added: Semi-Connected 
and Connected, each with 7 nodes.

For additional material on network structures or centralities 
see: Newman, M.E.J. (2010). Networks: An Introduction. 
Oxford: Oxford University Press.

And, the website of Tore Opsahl: 
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http://toreopsahl.com/tnet/weighted-networks/node-centrality/

http://toreopsahl.com/tnet/weighted-networks/node-centrality/
http://toreopsahl.com/tnet/weighted-networks/node-centrality/
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Condor 3’s  Centrality Measures are calculated from the Process dataset menu 
Process dataset > Annotate > Centrality annotations 

Centrality Calculations 
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Centrality Measures can be Exported  
 
For Individual Measures 
Export > Export Actors 
Sample Actor Centrality Measures output 
 
 
 
 
 
 
For Group Measures 
Export > Export > Export dataset properties 
Sample Group Centrality Measures Output 

Export of Centrality Measures 



Visualize and Label Centrality Measures 
Visualize by Betweenness with Node Name 

Visualize by Betweenness with Node Value 

Change Node Size by 
Individual centrality 
Measure: 
1.  Betweenness 
2.  Betweenness Weighted 
3.  Closeness 
4.  Degree 
5.  Degree Weighted 

Label Node by 
Individual centrality 
Measure: 
1.  Betweenness 
2.  Betweenness Weighted 
3.  Closeness 
4.  Degree 
5.  Degree Weighted 
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Centrality Definitions 
Individual centrality measures are used to explain the position of 
individual actors in the structure of a network.  

Degree centrality is simply a count of the number of links or connections 
an individual has to others in the network.  
A degree centrality value can range from 0 to n, where 0 means an actor 
has no connections to others in the network and is referred to as an 
isolate, and n is some positive number. 

Note: A graph is a weighted graph if a number (weight) is assigned to 
each edge.  

Degree centrality weighted is ….  

See; http://en.wikipedia.org/wiki/Graph_(mathematics)

For a more detailed discussion of centrality and weights see:
Tore Opsahl ‘s website at: 
http://toreopsahl.com/tnet/weighted-networks/node-centrality/

http://en.wikipedia.org/wiki/Graph_(mathematics
http://en.wikipedia.org/wiki/Graph_(mathematics
http://toreopsahl.com/tnet/weighted-networks/node-centrality/
http://toreopsahl.com/tnet/weighted-networks/node-centrality/
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Centrality Definitions (Continued) 
Betweenness centrality measures the degree to which a person is on 
the shortest path between all actors in the network.  The higher the 
number, the greater the number of actors who pass through that person 
to get to others in the network, or the more that person lies between 
others in the network. A betweenness centrality value can range from 0 
to n, where 0 means an actor is not between anyone on the shortest path 
between any two actors, such is the case for actors at the end points of 
of a star network, and to n which is a positive number. 

Betweenness centrality weighted is the betweenness centrality 
multiplied or weighted by a node’s number of degrees. This helps to 
distinguish two nodes with the same betweenness scores but vary in the 
number of degrees or the count of other actors which they are 
connected. 
A betweenness centrality weighted value, likewise can range from 0 to n. 
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Centrality Definitions (Continued) 

Closeness centrality is a measure of the degree to which an actor is 
close to other actors in the network. The idea is that an actor can reach 
another actor without going through many others.  A Closeness centrality 
value ranges from 0 to n, where 0 means that there is no path to reach 
another actor, which is the case if a network has more than one group or 
component and there is no bridges or liaisons connecting the two 
separate groups. 
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Comparison of Individual Centrality Measures 
And their Value Ranges 
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Group Centrality Definitions 

Group Degree Centrality values range from 0 to 1.  When all actors in 
the network connect to only one central person the degree centrality is at 
its maximum value of 1, and the network looks like a star.  When all 
actors have the same number of links to others in the network, the 
network looks like a circle and the group degree centrality is 0.   

Group Betweenness Centrality values also, range from 0 to 1. A value 
of  0 indicates that all actors in the network have the same betweenness 
centrality as all the others in the network, which is the case in a circle 
graph, and 1 indicates that there is one person who sits between 
everyone else, as in a star graph.  A line graph has a group betweenness 
centrality of .311.  

Group centrality measures characterize the variability or heterogeneity 
of the network as a whole.  In other words, how different are the actors 
from one another. 
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Note: 
 
At the group level, betweenness and degree are measures to determine 
the variability of these scores among actors across the whole network. 
 
It might seem that betweenness centrality and degree centrality are the 
same.  However, that is not the case.  They are similar, but there is an 
important distinction.  Betweenness measures the path between actors 
in the network or how much actors sit between others in the network, 
whereas degree measures the number of links each actor in the network 
has, or how well connected the actors are.  It is possible to have a high 
betweenness score with a low degree score. See the SemiConencted 
graph as an example. 
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Group Centrality Definitions (Continued) 

Density is a group centrality measure of the connectedness of the whole 
network. Density is simply the ratio of the actual number of links in the 
network over the total possible number of links in the network. The total 
number of links in a network is calculated as n*(n-1), where n is the 
number of nodes in network. This means that a node’s self links are not 
counted and are excluded excluded in calculating density. In matrix terms 
this means the diagonal is excluded (links 1 to 1, 2 to 2, etc.) 
 
If everyone is connected to everyone else in the network, the network 
has the maximum density of one.  Density also varies from 0 to 1, where 
0 indicates that there are no network connections and everyone is an 
isolate, and where 1 means that everyone in the network is connected to 
everyone else. 
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Five Sample Graphs for comparing Individual and Group Centralities 

Star Circle 

Line 

SemiConnected Connected 
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Five Sample Graphs for comparing Individual Centralities 

Star Circle 

Line 
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SemiConnected Connected 

Five Sample Graphs for comparing Individual Centralities 
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Five Sample Graphs for comparing Group Centralities 
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Star Example with Betweenness Centrality by Actor Size and Labels 

n=7 
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Star Example with Closeness Centrality by Actor Size and Labels 

n=7 
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Star Example with Degree Centrality by Actor Size and Labels 

n=7 
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Circle Example with Betweenness Centrality by Actor Size and Labels 

n=7 
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Circle Example with Closeness Centrality by Actor Size and Labels 

n=7 
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Circle Example with Degree Centrality by Actor Size and Labels 

n=7 



310

Line Example with Betweenness Centrality by Actor Size and Labels 

n=7 
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Line Example with Closeness Centrality by Actor Size and Labels 

n=7 
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Line Example with Degree Centrality by Actor Size and Labels 

n=7 
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SemiConnected Example with Betweenness Centrality by Actor Size and Labels 

n=7 
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SemiConnected Example with Closeness Centrality by Actor Size and Labels 

n=7 
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SemiConnected Example with Degree Centrality by Actor Size and Labels 

n=7 
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Connected Example with Betweenness Centrality by Actor Size and Labels 

n=7 
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Connected Example with Closeness Centrality by Actor Size and Labels 

n=7 
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Connected Example with Degree Centrality by Actor Size and Labels 

n=7 



CONTENT MEASURES

There are five content measures that  
Condor 3 calculates: 

1. Activity,

2. Sentiment,

3. Emotionality 

4. Complexity, and

5. Influence.

SECTION 2

Content Measures
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Activity is simply the count of the number of messages sent by an actor 
in the network.  Activity per day is the average number of messages sent 
per day. Note: Condor 3 uses one calculation for uppercase “Messages 
sent” for the Contribution Index, and a different calculation for lowercase 
“messages sent” for the Influence measure. Specifically, Influence 
doesn’t count empty messages and counts messages to multiple people 
as just one, determined by content. In contrast, the Contribution Index 
lets the user select a field for the deduplication. 
  
Sentiment is a measure with a value between 0 and 1, where a 0 
indicates that the message is very negative and where a 1 indicates the 
message is very positive (Brönnimann, Lucas (2013) Multilanguage – 
sentiment analysis of Twitter data on the example of Swiss politicians, p. 
2.  Windisch.).  Sentiment is calculated as the average score for the 
whole text; in this case the text is email. 

Condor 3’s Content Measure Definitions 

See: http://www.twitterpolitiker.ch/Paper_Swiss_Politicians_On_Twitter.pdf

http://www.twitterpolitiker.ch/Paper_Swiss_Politicians_On_Twitter.pdf
http://www.twitterpolitiker.ch/Paper_Swiss_Politicians_On_Twitter.pdf
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Emotionality is calculated on individual text segments and 
measures the degree of emotion expressed in the segment.  It is 
an important measure that elaborates sentiment.  Sentiment can be 
neutral, because the positive and negative text segments can 
balance each other out.  However, there can still be a high degree 
of emotionality being expressed in the text. 
  
Complexity looks at the probability or rarity of a term or word, or 
the likelihood that a single word will occur in a corpus of text.   The 
more rare words there are in a text, the higher the complexity 
score. 

Condor 3’s Content Measure Definitions (continued 
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Influence is the most complex measure. 
It is a combination of similarity, importance, and time delay.   
 
Simply, A can be said to influence B when: 
1.  There is a similarity between a message A sends B,  
        and subsequent messages that B sends anyone, in their use of particular terms 
2.  B did not use those terms in prior messages, and 
3.  B sends the new messages within four days of the first message from A. 
  
Similarity is measured by examining the similarity of the language in a message sent by person A 
to receiver B, to the language in the subsequent message sent by the receiver B. 
 
Importance uses the complexity measure in its calculation, comparing the language or terms in a 
message to all the previous messages in the network.  If the receiver B of a message sent by A 
has previously often used the terms in the message A sent, then the importance is low.  If the 
receiver B has not previously used the terms in the message sent by A, then the importance is 
high. 
 
Time delay looks at the difference in time between receipt of the message from A and the 
response by B to others, which is measured in Condor as a period of 4 days, where 1 would be 
an immediate response from B on receipt of a message from A, and 0 would be no response 
from B on receipt of a message from A. 
  
For a more detailed description of the influence measure see Lucas Bröniman’s masters thesis 
at: 

Condor 3’s Content Measure Definitions (continued) 

http://www.twitterpolitiker.ch/Master_Thesis_Lucas_Broennimann.pdf.

http://www.twitterpolitiker.ch/Master_Thesis_Lucas_Broennimann.pdf
http://www.twitterpolitiker.ch/Master_Thesis_Lucas_Broennimann.pdf
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Four Content Measures can be plotted in a single graph: 
Activity, Sentiment, Emotionality, and Complexity, and Exported 
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Four Content Measures can be plotted in a single graph: 
Activity, Sentiment, Emotionality, and Complexity, and Exported 
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Influence measures have multiple uses and outputs: 
1. Influence measures are displayed in the View > Word Usage over time  
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Influence measures have multiple uses and outputs: 
2. In the View menu  > Static View to change a Nodes Size or Labels  
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Influence measures have multiple uses and outputs: 
3. In the Process dataset > Graph pruning to prune a network 

Prune with: 
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Influence measures have multiple uses and outputs: 
4. In the File > Open dataset 1st stage filtering 
Filter Actors with Influence Measures and/or 

Filter Links with Influence Measures 
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Influence measures have multiple uses and outputs: 
5. In the Export > Export .CSV  for actors and links 

 



ANALYTICS

Condor 3 enables researchers the ability to Coolhunt 
and Coolfarm Collaborative Innovation Networks  or 
COINs at the global, organizational and individual 
levels using data mining from the Web, Facebook, 
Twitter, Email, Wikipedia and other data sources 
along with structure, content and time analytics.

Four steps of knowledge flow optimization are 
capable, which include the ability to analyze a 
COIN’s:

1. Structure of communication to identify the most 
central actors, bridges, bottlenecks or structural 
holes;

2. Honest signals of actors using six metrics to 
identify: central leaders, degree of contribution, 
evidence of rotating leadership, speed of response, 
sentiment and innovative language;

3.  Calibration with outcomes; and

4.  Interventions for behavior change.

SECTION 3

Coolhunting and  Coolfarm-
ing COINs
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Condor 3 enables researchers the ability to Coolhunt 
and Coolfarm Collaborative Innovation Networks  or 
COINs at the global, organizational and individual lev-
els using data mining from the Web, Facebook, Twitter, 
Email Wikipedia and other data sources, such as, social 
badges *.

 *http://hd.media.mit.edu/badges/

A sociometric badge (commonly known as a "sociometer") 
is a wearable electronic device capable of automatically 
measuring the amount of face-to-face interaction, conver-
sational time, physical proximity to other people, and 
physical activity levels using social signals derived from vo-
cal features, body motion, and relative location.

http://hd.media.mit.edu/badges/
http://hd.media.mit.edu/badges/
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The results from your Coolhunting can be visualized in a 
static network map or a dynamic movie using one or more 
data sources. 

Specifically use Condor 3’s:
• Fetch menu to acquire Web, Facebook, Twitter, Email 

and Wikipedia data, and the
• File menu to import your own data using the Import 

CSV or MySQL options
• Next use the Process dataset menu to annotate with 

structure and content measures, and then
• Use the View menu to visualize the results, and
• Use the Export menu for additional analysis.

Creating Collaborative Innovation Networks or 
COINs is two step process of:
Coolhunting which means hunting email, Wikipedia, 
Twitter, Facebook, blogs etc, to discover who are mem-
bers of the collaborative innovation networks or COINs. 
And then,
Coolfarming or growing and strengthening those 
COINs by using a Virtual Mirror to feedback to the 
group their interactions and metrics to improve their 
performance.
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Condor 3 calculates six Honest Signals:
1. The Structure metric of Central Leaders is calculated 

from the Process dataset Menu > Annotate> Centrality 
Annotations> Betweenness Centrality and Degree Cen-
trality

2. The Structure metric of Balanced Contribution is calcu-
lated from the Process dataset menu >  Annotate > Con-
tribution Index Annotations.

3. The Time  metric of Rotating Leadership is calculated 
from the Process dataset menu > Annotate > Oscillation 
Annotations

4. The Time  metric of Rapid Response is calculated from 
the Process dataset menu > Annotate > Turn-taking An-
notations

5. The Content metric of  Honest Sentiment is calcu-
lated from the Process dataset menu > Calculate Sen-
timent

6. The Content metric of  Innovative Language is calcu-
lated from the Process dataset menu > Calculate In-
fluence

Then:
Use the View menu to visualize the results, and
Use the Export menu for additional analysis.
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Four steps of knowledge flow optimization enable users to 
assess a COINs:

1. Structure of communication to identify the most 
central actors, bridges, bottlenecks or structural 
holes;

2. Honest signals of actors using six metrics to 
identify: central leaders, degree of contribution, 
evidence of rotating leadership, speed of response, 
sentiment and innovative language;

3. Calibration with outcomes can be conducted by ex-
porting metrics and making statistical correlations 
with key performance indicators, such as, customer 
satisfaction ratings.

4.    Interventions for behavior change are conducted  
        and monitored to assess there impact and  
        effectiveness.



For additional reading see:
Swarm Creativity
http://www.amazon.com/Swarm-Creativity-Compet
itive-Collaborative-Innovation/dp/0195304128/ref=
sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-
1&keywords=swarm+creativity
Coolhunting
http://www.amazon.com/Coolhunting-Chasing-Do
wn-Next-Thing/dp/0814473865/ref=pd_sim_b_1
Coolfarming
http://www.amazon.com/Coolfarming-Turn-Your-
Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
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http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2


CHAPTER 14

YouTube 
Links
The following is a list of the Condor 3 YouTube links, 
which includes a welcome message from Peter Gloor 
and click-by-click instructions to enable  
users to:
• Install Condor 3 on a Mac, PC or AWS Workspaces
• See examples of how to use the Fetch menu for visual-

izing, analyzing and measuring email, Facebook, 
Web, Twitter and Wikipedia data

• Gain an overview of the Condor seven menu func-
tions and the three graphical user interface controls 
for a quick start on learning how to use the software.

• Understand the basics of social networks
• How to obtain geocodes of cities and addresses to use 

with the Twitter GeoLocation option
• How to obtain a Bing and/or Google Map Key
• And, how to create a Google Earth file (kml/kmz).

Welcome to Condor 3 by Peter Gloor (13:51)

http://youtu.be/vfWfeywCsk

http://youtu.be/vfWfeywCskQ
http://youtu.be/vfWfeywCskQ


Condor 3 YouTube LinksThe following is a list of the 

Condor 3 YouTube links, which provide click-by-click instruc-
tions to enable  
users to:

• Install Condor 3 on a Mac, PC or AWS Workspaces
• See examples of how to use the Fetch menu for visualizing, 

analyzing and measuring email, Facebook, Web, Twitter and 
Wikipedia data

• Gain an overview of the Condor seven menu functions and 
the three graphical user interface controls for a quick start 
on learning how to use the software.

• Understand the basics of social networks
• How to obtain geocodes of cities and addresses to use with 

the Twitter GeoLocation option
• How to obtain a Bing and/or Google Map Key
• And, how to create a Google Earth file.

Below each YouTube video there is a “Show more” text box, 
which contains all the links used within the videos. Users can 
then copy and past these links into their browsers for easy ac-
cess to the information or resources described.

There are two types of YouTube links:

1. Playlists are a collection of videos which enable users to 
use a singe link to step through a sequence of videos, or pick 
and choose a single video from the collection, and

2. Individual video links that are standalone.

At the end of each YouTube video title there is a time indica-
tor for the video length in minutes and seconds in the format 
(XXmins:YYseconds). For example, (10:20) indicates the 
video is 10 minutes and 20 seconds in length.

This chapter presents the YouTube Playlists first, followed by 
the individual videos next including the within video links for 
easy user access.

The updates to the YouTube videos are as of August 11, 2015.
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Condor 3 YouTube Playlists

1. Condor 3 – How to install on a Mac Playlist  
          (43 minutes)

https://www.youtube.com/playlist?list=PLKq_-djPdTiVJtn7
6xeV_j-tevZoJ7uFn

The Condor 3 How to install on a Mac Playlist consists of 6 vid-
eos, which walks the user through the click-by-click steps 
needed to install Condor 3 on a Mac including obtaining a 
Google CSE API Key and four Twitter API Keys.

They six videos are:

1. Condor 3 Three steps to install on a Mac Updated  
     12/27/2014 (8:03)

2. How to install MySQL on a Mac Updated 12/27/2014 (7:28)

3. Condor 3 How to install Condor on a Mac V3 Updated  
    12/29/2014 (9:56)

This video updated with instructions on how to obtain a Con-
dor 3 license key.

In addition, it is recommended to install the following:

4. Condor 3 How to install MySQL Workbench on a Mac 
(4:04)

5. Condor 3 How to obtain a Google CSE Key Updated 8/11/
2015 V 1 (5:48)

6. Condor 3 How to obtain the four Twitter API Keys (8:40)

After completing the six videos Condor 3 will be installed and 
ready to use including conducting a Google CSE Fetch and a 
Twitter Fetch.

Playing all 6 videos takes about 43 minutes, however it will 
most likely take the user 1-3 hours to complete all the installa-
tions depending upon their computer skills, Internet speed 
and previous software installations.

Note: The URLs or links contained in the videos are available 
in the "Show More" box beneath the videos. Users just need to 
copy and paste these links into their browser.
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https://www.youtube.com/playlist?list=PLKq_-djPdTiVJtn76xeV_j-tevZoJ7uFn
https://www.youtube.com/playlist?list=PLKq_-djPdTiVJtn76xeV_j-tevZoJ7uFn
https://www.youtube.com/playlist?list=PLKq_-djPdTiVJtn76xeV_j-tevZoJ7uFn
https://www.youtube.com/playlist?list=PLKq_-djPdTiVJtn76xeV_j-tevZoJ7uFn


2. Condor 3 – How to install on a PC Playlist  
     (36 minutes)

https://www.youtube.com/playlist?list=PLKq_-djPdTiVI9JrP
RuUpTRIsuvZO7QEP

The Condor 3 How to install on a PC Playlist consists of 4  
videos which walks the user through the click-by-click steps 
needed to install Condor 3 on a PC including obtaining a  
Google CSE API Key and four Twitter API Keys.

The 4 videos are:

1. Condor 3 How to install Condor 3 on a PC Part 1 of 2 (7:48)

2. Condor 3 How to install Condor 3 on a PC Part 1 of 2  
Updated 12/28/2014 (15:12)

This video has been updated with the Condor 3 license instruc-
tions.

Note: MySQL Workbench is installed with the MySQL server 
on Part 2 of 2.

In addition, it is recommended to install the following

3. Condor 3 How to obtain a Google CSE Key Updated 8/11/
2015 V 1 (5:48)

4. Condor 3 How to obtain the four Twitter API Keys (8:40)

After completing the four videos Condor 3 will be installed 
and ready to use including conducting a Google CSE and a 
Twitter fetch.

Playing all 4 videos takes about 36 minutes, however it will 
most likely take the user 1-3 hours to complete all the installa-
tions depending upon their computer skills, Internet speed 
and previous software installations.

Note: The URLs or links contained in the videos are available 
in the "Show More" box beneath the videos. Users just need to 
copy and paste these links into their browser.
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https://www.youtube.com/playlist?list=PLKq_-djPdTiVI9JrPRuUpTRIsuvZO7QEP
https://www.youtube.com/playlist?list=PLKq_-djPdTiVI9JrPRuUpTRIsuvZO7QEP
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3. Condor 3 – Fetch Examples Playlist  
       (1 hour 38 minutes)

https://www.youtube.com/playlist?list=PLKq_-djPdTiWxmZ
w2V2QTyJhSaGVLfCJs

This Condor 3 playlist consists of six videos which demon-
strate how to use the Fetch menu for collecting, visualizing, 
analyzing and measuring networks from: email, Facebook, 
Web, Twitter and Wikipedia.

1. Condor 3 Fetch Mailbox Menu Example 01 (23:44)

2. Condor 3 Facebook Profile Menu Example 01 (8:21)

3. Condor 3 Web Example 01 (18:56)

4. Condor 3 Twitter Example 01 (19:08)

(Note: the Twitter video convers both the Fetch Twitter and 
the Fetch Twitter Accounts menus)

5. Condor 3 Wiki Evolution Example 01 (15:36)

6. Condor 3 Wikipedia Categories Example 01 (12:52)

4. Condor 3 – Menus and GUI Controls Playlist  
     (48 minutes)

https://www.youtube.com/playlist?list=PLKq_-djPdTiWAwO
zRflN1sUfNkAI-sfWT

This Condor 3 Playlist consists of two videos, which describes 
the seven menu functions and the three graphical user inter-
face or GUI controls that users will be using in the software 
for network analysis.

1. Condor 3’s Menus At-A-Glance V1 (37:20)

2. Condor 3 GUI Controls (11:29)
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https://www.youtube.com/playlist?list=PLKq_-djPdTiWxmZw2V2QTyJhSaGVLfCJs
https://www.youtube.com/playlist?list=PLKq_-djPdTiWxmZw2V2QTyJhSaGVLfCJs
https://www.youtube.com/playlist?list=PLKq_-djPdTiWxmZw2V2QTyJhSaGVLfCJs
https://www.youtube.com/playlist?list=PLKq_-djPdTiWxmZw2V2QTyJhSaGVLfCJs
https://www.youtube.com/playlist?list=PLKq_-djPdTiWAwOzRflN1sUfNkAI-sfWT
https://www.youtube.com/playlist?list=PLKq_-djPdTiWAwOzRflN1sUfNkAI-sfWT
https://www.youtube.com/playlist?list=PLKq_-djPdTiWAwOzRflN1sUfNkAI-sfWT
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Condor 3 YouTube Standalone Videos

This videos are listed in order of Installation for a Mac, PC or 
AWS Workspaces and then the Menus and GUI Controls.

How to install Condor 3 on a Mac (6 videos)

1. Condor 3 Three steps to install on a Mac Updated  
        12/27/2014 (8:03)

http://youtu.be/WB6ta-NwCfg

Links within video are:

http://galaxyadvisors.com

Java Background:

http://www.java.com/en/download/faq/whatis_java.xml

http://www.java.com/en/download/faq/java_mac.xml#java6

Java Download Link for the Mac:

http://java.com/en/download/manual.jsp#ma

Java Test Link:

http://java.com/en/download/installed.jsp

Note: Mac Yosemite users need to install the Java Develop-
ment Kit (JDK) to run Condor 3 with the Terminal app: 

Java JDK Download link:

http://www.oracle.com/technetwork/java/javase/downloads
/jdk8-downloads-2133151.html

2. How to install MySQL on a Mac Updated  
     12/27/2014 (7:28)

http://youtu.be/CVvPxJXsvrU

Updated video, which explains how to install MySQL on a 
Mac. 

Note: The MySQL 10.9 and 10.8 dmg files have just one install 
package and no separate preference pane package. 

The one package now installs both MySQL and the Preference 
Pane in one install.  At the Installation Summary page you 
may get a message that “The Installation Failed.” This is not 
true. 

• Click on the Black Apple in the upper left corner. 
• Choose System Preferences. 
• Find the MySQL icon and click on it. 
• At the MySQL window, Click on “Start MySQL”. 
• Enter your Computer’s password. 
• The MySQL now says it is running in green.
Links within video are:

http://galaxyadvisors.com

MySQL Download Link:

http://dev.mysql.com/downloads/mysql/

MySQL PDF manual download link:

http://downloads.mysql.com/docs/refman-5.6-en.a4.pdf
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For more YouTube videos on MySQL:

a. Goto: https://www.youtube.com/ 

b. In the YouTube search box, type in: how to get started with 
mysql

3. Condor 3 How to install Condor on a Mac V3  
     12/29/2014 (9:55)

http://youtu.be/RxbzhvzXqzo

This video describes how to install Condor 3 on a Mac up-
dated with the license key instructions.

Updated December 29, 2014

a. Users need to install Java 7 or Java 8. Java 6 is not sup-
ported

b. To start Condor 3 on a Mac with Yosemite using the Termi-
nal app, users need to install the Java Development Kit (JDK).  

The Java JDK download link is at:

http://www.oracle.com/technetwork/java/javase/downloads
/jdk8-downloads-2133151.html

The Java Development Kit (JDK) name is like “jdk-8u25-
macosx-x64.dmg”. The update version may change.

Click to Accept License Agreement. 

Double click on the jdk-8u25-macosx-64.dmg to begin the in-
stall and follow the on screen instructions. 

Then when you issue the Java command:

 Java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar

in the Terminal window Condor 3 will start.

This video describes how to install Condor 3 on a Mac up-
dated with the license key instructions.

Links within the video are:

http://galaxyadvisors.com

Condor 3 Sign up form link to obtain license key:

http://guardian.galaxyadvisors.com/guardian/

Sample Condor 3 Terminal Start text:

Java -Xmx2G -Djava.library.path=. -jar Condor-3.2.0.jar
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4. Condor 3 How to install MySQL Workbench on a 
Mac (4:03)

http://youtu.be/TlnJrcqpYv8

Instructions on how to install MySQL Workbench on a Mac.

Links within the video:

MySQL Workbench Product

http://www.mysql.com/products/workbench/

MySQL Workbench download link:

http://dev.mysql.com/downloads/workbench/

MySQL Workbench Tutorial Link:

https://www.youtube.com/watch?v=X_umYKqKaF0

MySQL Workbench Manual link:

http://downloads.mysql.com/docs/workbench-en.pdf

Galaxy Advisors

http://galaxyadvisors.com

5. Condor 3 How to obtain a Google CSE Key Updated 
8/11/2015 V1 (5:48)

https://youtu.be/zME1-j9yPvI

The Google Console link 
https://code.google.com/apis/console/ has a new web design 
and this video has been updated as of 08/11/2015 to reflect 
these changes.

Instructions on how to obtain a Google CSE Key .

Links within the video are:

http://galaxyadvisors.com

Create Google Account Link:

https://accounts.google.com/signup?service=mail

Google Console Link:

https://code.google.com/apis/console/

Google Billing Link:

https://developers.google.com/console/help/new/#billing

Condor CX key: 000229616349723713761:mlcaolv1mpw
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6. Condor 3 How to obtain the four Twitter API Keys 
(8:39)

http://youtu.be/6zMW7YEKJzw

Links within video are:

http://galaxyadvisors.com

Twitter Login:

https://twitter.com/login

Twitter App Page:

https://apps.twitter.com

Twitter V1.1. Rate Limits page:

https://dev.twitter.com/docs/rate-limiting/1.1

How to install Condor 3 on a PC or AWS Workspaces  
(4 Videos). Numbers 7,8,9 and 10 below.

7. Condor 3 How to install Condor 3 on a PC  
     Part 1 of 2 (7:47)

http://youtu.be/_zPT1b_i9qY

Instructions on How to install Condor 3 on a PC part 1 of 2.

Links within the video are:

http://galaxyadvisors.com

About Windows 7 from Wikipedia:

http://en.wikipedia.org/wiki/Windows_7

About Java:

http://www.java.com/en/download/faq/whatis_java.xml

Java Test:

http://www.java.com/en/download/testjava.jsp

Java Download:

http://www.java.com/en/

http://www.java.com/en/download/manual.jsp?locale=en
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8. Condor 3 How to install Condor 3 on a PC  
     Part 2 of 2 V2 Updated 12/28/2014 (15:12)

http://youtu.be/p8ANaPKggtg

This video has been updated with the Condor 3 license key in-
structions.

Links within video are:

http://galaxyadvisors.com

MySQL installation:

http://dev.mysql.com/downloads/mysql/

MySQL Download

http://dev.mysql.com/downloads/windows/installer/5.6.htm
l

MySQL Manual

http://downloads.mysql.com/docs/refman-5.6-en.a4.pdf

Condor 3 Sign up form link to obtain license key:

http://guardian.galaxyadvisors.com/guardian

After the 14 day trial period ends, users need to email Peter 
Gloor at: pgloor@galaxyadvisors.com 

Sample Condor3.bat file:

set path=%path%;C:\Program Files (x86)\Java\jre7\bin

java –Xmx2G -jar Condor-3.2.0.jar

9. Condor 3 How to obtain a Google CSE Key Updated 
8/11/2015 V1 (5:48)

https://youtu.be/zME1-j9yPvI

The Google Console link 
https://code.google.com/apis/console/ has a new web design 
and this video has been updated as of 08/11/2015 to reflect 
these changes.

Instructions on how to obtain a Google CSE Key.

Links within the video are:

http://galaxyadvisors.com

Create Google Account Link:

https://accounts.google.com/signup?service=mail

Google Console Link:

https://code.google.com/apis/console/

Google Billing Link:

https://developers.google.com/console/help/new/#billing

Condor CX key: 000229616349723713761:mlcaolv1mpw
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10. Condor 3 How to obtain the four Twitter API Keys 
(8:39)

http://youtu.be/6zMW7YEKJzw

Links within video are:

http://galaxyadvisors.com

Twitter Login:

https://twitter.com/login

Twitter App Page:

https://apps.twitter.com

Twitter V1.1. Rate Limits page:

https://dev.twitter.com/docs/rate-limiting/1.1

Condor 3 Fetch Menu Examples (6 videos)

Numbers 11, 12, 13, 14, 15, 16 below.

11. Condor 3 Fetch Mailbox Menu Example 01 (23:43)

http://youtu.be/BFo57cz9Jx0

This video provides an example of how to use the Condor 3 
Fetch Menu for email to create a virtual mirror. Condor 3 can 
analyze email for a single person, a team, a department or an 
entire company or organization.

12. Condor 3 FaceBook Profile Menu Example (8:20)

http://youtu.be/jYUVwwBckhg

This video provides an example of how to use the Condor 3 
Fetch Facebook profile menu.

For 2-digit country locale key see: 
http://www.worldatlas.com/aatlas/ctycodes.htm
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13. Condor 3 Web Example V01 (18:55)

http://youtu.be/MzPy78UXcVw

This video provides an example of how to use the Condor 3 
Fetch Menu for the Web. Note: there are over 1 billion web-
sites in 2014, estimated to double every 18-24 months.

Links within the video are:

http://galaxyadvisors.com

Website Growth:

http://www.internetlivestats.com/total-number-of-websites/

http://toni.org/2012/05/03/1-billion-web-sites-in-2013/

http://www.internetlivestats.com/total-number-of-websites/

Google APIs:

AJAX

https://developers.google.com/web-search/docs/reference

CSE

https://developers.google.com/custom-search/

Google CSE 239 Country List:

https://developers.google.com/custom-search/docs/xml_res
ults#countryCollections

Google Search Operators:

https://support.google.com/websearch/answer/136861

Google Punctuations and Symbols:

https://support.google.com/websearch/answer/2466433

Backlinks:

http://www.backlinkwatch.com

14. Condor 3 Twitter Example 01 (19:07)

http://youtu.be/imVo9EKQefo

This video provides an example of how to use the Condor 3 
Fetch Menus for Twitter. There are two Twitter Fetch menu 
options:

1. The Fetch Twitter menu is designed to fetch tweets based 
upon a user query, which includes three search options:

a. Language of 21 selections, 

b. Repetitive searching with a designated time delay, and 

c. Geolocation based upon latitude and longitude within a ra-
dius of X miles or kilometers.
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2. The Fetch Twitter Accounts menu enables a user to fetch a 
designated user(s) tweets. More than one Twitter user account 
or name can be collected in a single fetch.

Links within the video are:

For the number of Tweets sent today see:

http://www.internetlivestats.com

Twitter Reference Links:

https://twitter.com

http://en.m.wikipedia.org/wiki/Twitter

http://abcnews.go.com/Business/twitter-ipo-filing-reveals-5
00-million-tweets-day/story?id=20460493

Geocoding:

http://www.gpsvisualizer.com/geocoder/

GPS Visualizer Calculators can be used to Draw a Range Ring 
Around a City

http://www.gpsvisualizer.com/calculators

Galaxy Advisors

http://galaxyadvisors.com

15. Condor 3 Wiki Evolution Example 01 (15:35)

http://youtu.be/hIC-8OgfdJw

This video provides an example of how to use the Condor 3 
Fetch Wiki Evolution Menu.

Links within the video are:

http://galaxyadvisors.com

Wikipedia:

http://en.wikipedia.org/

 Wikipedia Searching:

http://en.wikipedia.org/wiki/Help:Searching
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16. Condor 3 Wiki Categories Example 01 (12:51)

http://youtu.be/Ehe-2XPRLOA

This video provides an example of how to use Condor 3’s 
Fetch Wikipedia Categories Menu.

Wiki Categories helps you to understand how your topic or 
area of interest is classified and fits into a hierarchical tree 
structure of articles.

Links within the video are:

Galaxy Advisors

http://galaxyadvisors.com

Wikipedia:

http://www.wikipedia.org

Wikipedia's 12 Main Content Categories

http://en.wikipedia.org/wiki/Portal:Contents/Categories

Wikipedia Society and Social Sciences Category (1 of the 12 
main content categories)

http://en.wikipedia.org/wiki/Portal:Contents/Categories#So
ciety_and_social_sciences

Wikipedia Linguistics Sub-Category of Society and Social Sci-
ences

http://en.wikipedia.org/wiki/Category:Linguistics

Wikipedia Quantitative Linguistics Sub-Category of Linguis-
tics

http://en.wikipedia.org/wiki/Category:Quantitative_linguisti
cs

Wikipedia Page for George Kingsley Zipf, which is a page un-
der the Quantitative Linguistics Sub-Category

http://en.wikipedia.org/wiki/George_Kingsley_Zipf

Wikipedia Category Tree page

http://en.wikipedia.org/wiki/Special:CategoryTree

Wikipedia Help Searching Page:

http://en.wikipedia.org/wiki/Help:Searching
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Condor 3’s Menus and GUI Controls

Two videos. Numbers 17 and 18 below.

17. Condor 3's Menus At-A-Glance V1 (37:19)

http://youtu.be/QOPuXicKgao

This video provides:

1. An overview of Condor 3's seven main menu items 

2. The three graphical user interface tools, and

3. Basic process steps the user will use to analyze their net-
work datasets.

18. Condor 3 GUI Menus (11:28)

http://youtu.be/7fJ1nZuvQqs

This video describes Condor 3's three graphical user interface 
(GUI) controls.

19.  How to create a Google Earth .kmz file 

http://youtu.be/EUMcPI019ug

This video explains how to create a Google Earth .kmz file.

Overall three steps:

1. Obtain a Google Map API Key

2. Enable Google Maps JavaScript API v3, and

3. Use the site: http://www.gpsvisualizer.com/geocoder

To geocode an address or city name and create a Google Earth 
.kmz file for viewing and reuse.

Links within the video are:

gpsvisualizer

http://www.gpsvisualizer.com/geocoder

Google Console

https://code.google.com/apis/console
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Condor 3 YouTube UPDATES as of August 11, 2015

1. Condor 3 How to obtain a Google CSE Updated 8/
11/2015 V1 Key

https://youtu.be/zME1-j9yPvI

The Google Console link 
https://code.google.com/apis/console/ has a new web design 
and this video has been updated as of 08/11/2015 to reflect 
these changes.

2. How to install MySQL on a Mac UPDATE

http://youtu.be/REowrvnGoyw

Two UPDATES when installing Mac OS S 10.9 (x86, 64bit), 
DMG Archive:

a. The MySQL download package now has just one package 
“mysql-5.6.21 –osx10.8-x86_64.pkg” and no separate prefer-
ence pane package. The one package now installs both MySQL 
and the Preference Pane in one install.

b. At the Installation Summary page you will get a message 
that “The Installation Failed.” This is not true. Click on the 
Black Apple in the upper left corner. Choose System Prefer-
ences. Find the MySQL icon and click on it. At the MySQL 
window, Click on “Start MySQL”. Enter your Computer’s 
password. The MySQL now says it is running in green.

3. Condor 3 How to install Condor on a Mac V2

http://youtu.be/yugwSj4JprU

Two UPDATES:

a. Users need to install Java 7 or Java 8.  
Java 6 is no longer supported.

b. To start Condor 3 on a Mac with Yosemite (10.10) using the 
Terminal app, users need to install the Java Development 
Kit (JDK).  This is at the 4:02 timing mark.

Now, goto 
http://www.oracle.com/technetwork/java/javase/downloads
/jdk8-downloads-2133151.html 

to download the Java Development Kit, which for the Mac is 
like “jdk-8u25-macosx-x64.dmg”. The update version may 
change.

Click to Accept License Agreement. Double click on the 
jdk-8u25-macosx-64.dmg to begin the install and follow the 
on screen instructions. Then when you issue the Java com-
mand (Java -Xmx2G -Djava.library.path=. -jar 
Condor-3.2.0.jar) in the Terminal window it will work.

Thus, users should install the Java Runtime Environment 
(JRE) jre-8u25-macosx-z64.dmg to start the Condor 3~.jar 
with a double click.
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4. Condor 3 Three steps to install on a Mac

http://youtu.be/FcN8UTlEZHI

UPDATE: Condor 3 no longer supports Java 6. 

Users must install Java 7 or Java 8 for Condor 3 to run.

5. Condor 3 How to install Condor on a Mac V2 (6:53)

http://youtu.be/yugwSj4JprU

Condor 3 installation now requires an email verification step 
and at the end of the 14 day trail period users need to email  
Peter Gloor at: pgloor@galaxyadvisors.com and request a 
yearly license for a commercial use or a free academic license.

Overall, these are the four main steps:

http://guardian.galaxyadvisors.com/guardian/ 
 

1.  Complete Condor 3’s Sign up Form to obtain your license key: 

2.  Validate your email address 

4. Start Condor 3 and enter your license key: 

3. Download Condor 3 from the License Manager link  

Additional YouTube videos by Peter Gloor.

Swarmcreativity Lecture Series:

The Foundation of Swarmcreativity (8:29) 
http://youtu.be/8fZWPA8ObAU

Thee Dimensions of Collaborative Communication (15:28) 
http://youtu.be/8fZWPA8ObAU

Six Honest Signals of Creative Communication (22:12) 
http://youtu.be/dMXa8CiD6aM

Coolhunting Principles Overview (44:35) 
http://youtu.be/eyw9VLaJsMA

Condor Overview Video Series:

Condor E-Mail Analysis Intro (8:27) 
http://youtu.be/1iWUCxZ7a2U

Condor E-Mail Analysis 6 HonestSignals (13:08) 
http://youtu.be/-FiT5ngsZrs

Condor E Mail Content Analysis & Data Export (9:37) 
http://youtu.be/ZyZEmt6j9As

Condor Twitter Analysis (10:22) 
http://youtu.be/RdAQ8WBWsDM

Condor Blog Analysis (7:48)  
http://youtu.be/dtToIvYtO0Q

Condor Wikipedia Example (12:39) 
http://youtu.be/EFM-RwVfAIY

Condor Facebook Example (3:31) 
http://youtu.be/QqzD1puxbTM

351

http://youtu.be/FcN8UTlEZHI
http://youtu.be/FcN8UTlEZHI
http://youtu.be/yugwSj4JprU
http://youtu.be/yugwSj4JprU
mailto:pgloor@galaxyadvisors.com
mailto:pgloor@galaxyadvisors.com
http://youtu.be/8fZWPA8ObAU
http://youtu.be/8fZWPA8ObAU
http://youtu.be/8fZWPA8ObAU
http://youtu.be/8fZWPA8ObAU
http://youtu.be/dMXa8CiD6aM
http://youtu.be/dMXa8CiD6aM
http://youtu.be/eyw9VLaJsMA
http://youtu.be/eyw9VLaJsMA
http://youtu.be/1iWUCxZ7a2U
http://youtu.be/1iWUCxZ7a2U
http://youtu.be/-FiT5ngsZrs
http://youtu.be/-FiT5ngsZrs
http://youtu.be/ZyZEmt6j9As
http://youtu.be/ZyZEmt6j9As
http://youtu.be/RdAQ8WBWsDM
http://youtu.be/RdAQ8WBWsDM
http://youtu.be/dtToIvYtO0Q
http://youtu.be/dtToIvYtO0Q
http://youtu.be/EFM-RwVfAIY
http://youtu.be/EFM-RwVfAIY
http://youtu.be/QqzD1puxbTM
http://youtu.be/QqzD1puxbTM


CHAPTER 15

Social 
Netwok 
Basics

The purpose of this chapter is to provide 
social network newbies an orientation to 
the field of Social Network Analysis, 
which includes: a brief history, the basic 
vocabulary, professional associations, 
and references.  

YouTube Video:
Social Network Analysis – The Basics:
http://www.youtube.com/watch?v=ei3YEn8xUnI&feat
ure=youtu.be

http://www.youtube.com/watch?v=ei3YEn8xUnI&feature=youtu.be
http://www.youtube.com/watch?v=ei3YEn8xUnI&feature=youtu.be
http://www.youtube.com/watch?v=ei3YEn8xUnI&feature=youtu.be
http://www.youtube.com/watch?v=ei3YEn8xUnI&feature=youtu.be


Brief History 

Linton C. Freeman 

Lin Freeman’s 2004 book The Development of Social 
Network Analysis: A Study in the Sociology of Science 
provides a great history of how social network analysis 
developed. Here are few links to Freeman’s site and his 
book.

The Tower of Babel 
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http://moreno.ss.uci.edu/
http://moreno.ss.uci.edu/pubs.html
http://www.amazon.com/dp/1594577145/ref=rdr_
ext_tmb

 Social Network Network analysis is multi-
disciplinary including the fields of:
• Anthropology
• Sociology
• Mathematics
• Communications
• Physics
• Computer Scientists
• ….
Consequently, there are strengths and weaknesses 
with its development. A fundamental issue is that the 
most basic terms have resulted in a “Tower of Babel.” 
People refer to a “dot” or a “line” by many different 
names which often leads to confusion and often peo-
ple who are unfamiliar with different terms are heard 
saying, “what are you talking about?”

http://moreno.ss.uci.edu
http://moreno.ss.uci.edu
http://moreno.ss.uci.edu/pubs.html
http://moreno.ss.uci.edu/pubs.html
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The Tower of Babel 

Node        Link 
Vertex      Edge 

Tie 

Arc 

Actor 
Connection 

A “dot” is often referred to as a node, vertex, or actor 
and a “line” is often referred to as a link, edge, tie or 
arc. Something so basic has many different names. The 
point is to be familiar with the all the different ways to 
call the two basic concepts.

The Node 

Email = person’s mail address 

Condor’s  Actor 

Web = URLs, http://….. 

Wikipedia = Articles, URLs 

Twitter name 

Facebook name 

Condor 3 uses the term Actor and Node interchangeable. Dif-
ferent kinds of data use different data elements for nodes. Spe-
cifically, Condor 3 defines a node as a person’s email address, 
a Web URL or link, Wikipedia Articles and URLs, Twitter 
names or Ids, and Facebook names.

A node can have properties, attributes or characteris-
tics too. For example, a person’s email address can 
have, a domain, such as: .com, .edu. .org, .net, etc.

See Chapter 10 for a listing of node and edge proper-
ties.
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The Link 

Email: Message Source/From - Target/To 

Condor’s  “Edges” 

Web: URL Source/From - Target/To 
  
Wikipedia: Articles or urls Source/From - Target/To 
 

Twitter: Tweet Source/From - Target/To 
  
Facebook: Name Source/From - Target/To 

Condor 3 uses the term Edge, Link and Connection in-
terchangeable. Different kinds of data use different 
data elements for edges. Specifically, Condor 3 defines 
an edge as a person’s mail message, a Web URL Source 
and Target, Wikipedia Articles URLs Source and Tar-
get, Twitter names or Ids Source and Target, and Face-
book names Source and Target.

An edge can have properties, attributes or characteris-
tics too. For example, a person’s email message can 
have, a sentiment, emotionality etc.

See Chapter 10 for a listing of node and edge proper-
ties.

Navicat: Condor 3 Databases and Datasets 

Database name 

The figure above is an example how Navicat display’s 
Condor 3’ universal database and dataset table struc-
ture regardless of the kind of data. 
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Link: Undirected Vs Directed 

Undirected 

Directed 

A link can be undirected, which means it is assumed 
that a relation goes both ways, such as between friends. 
Or, a link can be split in two, and be directed as shown 
in the figure above. Condor 3’s Influence measure is a 
directed link where someones influence may not be the 
same in both directions.

Reciprocal Links 

Links can also be described as reciprocal. 

For example, person A sends a message to person B, 
and B sends a reply back to A. 

Condor ‘3 Process data > Annotation > Turn-taking an-
notation calculates a measure called: ART (h) which 
stands for Average Response Time in hours for nodes 
or actors.
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Unreciprocated Link 

Links can be also unreciprocated, where A sends a mes-
sage to B, but B does not reply. 

Basic Vocabulary 

!  Network Measures 
! Degree 
! Density 
!  Bridge 
! Centrality 
!  Betweenness 
!  TRIADS 

There are six fundamental social network vocabulary 
or terms  that need to be understood as indicated in the 
figure above. The next pages define these measures.
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Degree 
The count of the number of ties to other actors 

in the network.  
!  Indegree is a count of the number of ties 

directed to the node (popularity). 
 
 
!  Outdegree is the number of ties that the node 

directs to others (gregariousness).  

See: 
http://en.wikipedia.org/wiki/Centrality#Degree
_centrality

!  In mathematics, a dense graph is a graph 
in which the number of edges is close to 
the maximal number of edges.  

 

!  A graph with only a few edges, is a 
sparse graph. 

6 actual /6 possible = 1 

2 actual /6 possible  =.33 

Density 

See: http://en.wikipedia.org/wiki/Dense_graph

http://en.wikipedia.org/wiki/Centrality#Degree_centrality
http://en.wikipedia.org/wiki/Centrality#Degree_centrality
http://en.wikipedia.org/wiki/Centrality#Degree_centrality
http://en.wikipedia.org/wiki/Centrality#Degree_centrality
http://en.wikipedia.org/wiki/Dense_graph
http://en.wikipedia.org/wiki/Dense_graph


Bridge 
!  An edge is said to be a bridge if deleting it 

would cause its endpoints to lie in different 
components of a graph 

Centrality 
!  This measure gives a rough indication of 

the social power of a node based on how 
well they "connect" the network. 
"Betweenness,� and "Degree" are all 
measures of centrality. 
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See: http://en.wikipedia.org/wiki/Bridge_(graph_theory See: 
http://en.wikipedia.org/wiki/Betweenness#Betweenness
_centrality

http://en.wikipedia.org/wiki/Bridge_(graph_theory
http://en.wikipedia.org/wiki/Bridge_(graph_theory
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality


Betweenness 
!  The extent to which a node lies between 

other nodes in the network.  

TRIADS 
A group of three nodes with directed links.  
There are 16 possible combinations 

In sociology a triad is a group of three people. It is one 
of the simplest human groups that can be studied and 
is mostly looked at by microsociology. The study of tri-
ads, as well as dyads, was pioneered by German sociolo-
gist Georg Simmel at the end of the nineteenth century.

MultiNet, a social network program, can create a Triad 
Census Profile based on the 16 unique triad communi-
cation types, which are shown in figure above 
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See: 
http://en.wikipedia.org/wiki/Betweenness#Betweenness
_centrality

See: http://en.wikipedia.org/wiki/Triad_(sociology)

http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Betweenness#Betweenness_centrality
http://en.wikipedia.org/wiki/Triad_(sociology
http://en.wikipedia.org/wiki/Triad_(sociology


The triads are characterized by a three-digit Mutual, 
Asymmetric, and Null (MAN) index number.

The first digit represents Mutual, which gives the num-
ber of reciprocal dyads within the triad. Reciprocal 
means that the communication is happening both ways 
(two-way communication).

The second digit represents Asymmetric, which gives 
the number of directed dyads within the triad (one-way 
communication).

The third digit represents Null, which gives the number 
of dyads that have no interaction within the triad (no 
communication, Isolate).

A fourth digit (alpha) is sometimes added to the MAN 
index number to specify a directional or hierarchical re-
lationship which is present with the triad. See cases #4, 
5, 6, 7, 8, 9,10,12,13 and 14.
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Professional Associations 
 

The International Network for Social Network Analysis 
is the GOTO site for social network analysis.

Collaborative Innovation Networks 
Conference (COINs) 

See:
COINs2009
http://www.coinsconference.org/coins09-savannah-usa/

COINs2010

http://www.coinsconference.org/coins10-savannah-usa/

COINs2011

http://www.coinsconference.org/coins11-basel-switzerland/

COINs2015

http://www.coinsconference.org/coins15-tokyo-japan/

COINs2016 Rome, Italy June 8-10,2016
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http://www.insna.org
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SOCIAL NETWORK BOOKS

This section presents a variety of Social Network 
Books including: Massive Open Online Classes or 
MOOCs, Theory and  Popular reading. 

SECTION 1

Social Network Books
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Books for Massive Open Online Courses (MOOC)  regarding Social Networks 

364

http://www.amazon.com/Leskovec-Mining-
Massive-Datasets-Hardcover/dp/B00SCTW
KF4/ref=sr_1_1?s=books&ie=UTF8&qid=14
36209669&sr=1-1&keywords=mining+of+m
assive+datasets+2nd+edition

http://www.amazon.com/Visual-Insights-Practical-Gui
de-Making/dp/0262526190/ref=sr_1_1?s=books&ie=U
TF8&qid=1436210074&sr=1-1&keywords=visual+insigh
ts
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http://www.amazon.com/Visual-Insights-Practical-Guide-Making/dp/0262526190/ref=sr_1_1?s=books&ie=UTF8&qid=1436210074&sr=1-1&keywords=visual+insights


The printed version of 
the book will be 
published by 
Cambridge University 
Press in 2015. In the 
coming months the 
website will be 
expanded with an 
interactive version of 
the text, datasets, and 
slides to teach the 
material. 

Forthcoming Dec 2015, but chapters available now as pdf downloads 
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http://barabasi.com/networksciencebook/

http://barabasi.com/networksciencebook/
http://barabasi.com/networksciencebook/


http://barabasilab.neu.edu/courses/phys5116/ 

http://barabasilab.neu.edu/courses/
phys5116/content/
phys5116_syllabus_2014.pdf 
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http://www.amazon.com/Network-Science-Albert-L-225
-Barab/dp/1107076269/ref=sr_1_1?s=books&ie=UTF8&
qid=1436378104&sr=1-1&keywords=Network+Science
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Knowledge Machines: 
Digital Transformations of the Sciences 
and Humanities (Infrastructures), 
 April 2015 
 
By 
Eric T. Meyer and  Ralph Schroeder  

COINs and e-Research 

…. digital tools and data, used collectively 
and in distributed mode -- which they term 
e-research -- have transformed not just the 
consumption of knowledge but also the 
production of knowledge.  
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http://www.amazon.com/Knowledge-Machines-
Transformations-Humanities-Infrastructures/d
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qid=1436394631&sr=1-1&keywords=Knowledge
+Machines%3A
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published at the time when this was written. (Wells, 
2013). Companion to Science Fiction almost exclu-
sively ... to inexpensive magazines. 1 PROCEEDINGS, 
COINs13 The term science ficti ... 

http://arxiv.org/abs/1308.1292

Tomoki Furukawazono, Shota Seshimo, Daiki Mura-
matsu et al., Designing a Pattern Language For Surviv-
ing Earthquakes (2013)

abstract: ... have not been passed down sufficiently. 
This paper presented the four patterns of the Survival 
Language: "Daily Use of R ... language has been a tool 
for collaboration since it was presented by Christopher 
Alexander.

http://arxiv.org/abs/1308.1175

394

http://arxiv.org
http://arxiv.org
http://arxiv.org/abs/1308.1028
http://arxiv.org/abs/1308.1028
http://arxiv.org/abs/1308.1292
http://arxiv.org/abs/1308.1292
http://arxiv.org/abs/1308.1175
http://arxiv.org/abs/1308.1175


Jorge Fabrega, Javier Sajuria, The Emergence of Politi-
cal Discourse on Digital Networks: The Case of the Oc-
cupy Movement (2013)

PROCEEDINGS, COINs13 THE EMERGENCE OF PO-
LITICAL DISCOURSE ON DIGITAL ... Iba??ez Diago-
nal Las Torres 2640 Pe??alolen, Santiago, Chile ... to 
reach mainstream media outlets (Sajuria 2013; Theo-
charis 2012). In that way, the actions ??? and ... 

http://arxiv.org/abs/1308.1176

Peter A. Gloor, Maria Paasivaara, COINs change lead-
ers - Lessons Learned from a Distributed Course 
(2013)

PROCEEDINGS, COINs13 Maria ??Paasivaara ?? Peter 
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ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Social and Information Networks (cs.SI); 
Computers and Society (cs.CY)
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8. arXiv:1503.00288 [pdf]

Success factors for Crowdfunding founders and fun-
ders

Yang Song, Robert van Boeschoten

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Computers and Society (cs.CY); Human-
Computer Interaction (cs.HC); Social and Information 
Networks (cs.SI)

9. arXiv:1503.00197 [pdf]

Emerging Methods and Tools for Sparking New Global 
Creative Networks

Jeff Horon

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Computers and Society (cs.CY); Human-
Computer Interaction (cs.HC)

10. arXiv:1503.00174 [pdf]

CSCW Principles to Support Citizen Science

Julia Katherine Haines

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Computers and Society (cs.CY); Human-
Computer Interaction (cs.HC)

11. arXiv:1502.05264 [pdf]

Measuring Creativity of Wikipedia Editors

Pentti Launonen, KC Kern, Sanna Tiilikainen

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Social and Information Networks (cs.SI); 
Physics and Society (physics.soc-ph)
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12. arXiv:1502.05263 [pdf]

Comparing Online Community Structure of Patients of 
Chronic Diseases

Hanuma Teja Maddali, Peter A. Gloor, Peter Margolis

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142

Subjects: Social and Information Networks (cs.SI); 
Physics and Society (physics.soc-ph)

13. arXiv:1502.05260 [pdf]

Lessons from the Coinseminar

Peter Gloor, Maria Paasivaara, Christine Miller

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Social and Information Networks (cs.SI); 
Computers and Society (cs.CY)

14. arXiv:1502.05256 [pdf]

Cultural Anthropology Through the Lens of Wikipedia 
- A Comparison of Historical Leadership Networks in 
the English, Chinese, Japanese and German Wikipedia

Peter Gloor, Patrick De Boer, Wei Lo, Stefan Wagner, 
Keiichi Nemoto, Hauke Fuehres

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Social and Information Networks (cs.SI)

15. arXiv:1502.04997 [pdf]

Measuring Organizational Consciousness Through E-
Mail Based Social Network Analysis

Peter A. Gloor, Andrea Fronzetti Colladon

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)
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Subjects: Social and Information Networks (cs.SI); 
Computers and Society (cs.CY); Physics and Society 
(physics.soc-ph)

16. arXiv:1502.04312 [pdf]

WIKI THANKS: Cultural Differences in Thanks Net-
work of Different-Language Wikipedias

Keiichi Nemoto, Ken-ichi Okada

Comments: Proceedings of the 5th International Con-
ference on Collaborative Innovation Networks CO-
INs15, Tokyo, Japan March 12-14, 2015 
(arXiv:1502.01142)

Subjects: Social and Information Networks (cs.SI)

17. arXiv:1502.01142 [html]

Proceedings of the 5th International Conference on Col-
laborative Innovation Networks COINs15, Tokyo, Ja-
pan March 12-14, 2015

Keiichi Nemoto, Peter A. Gloor, Cristobal J. Garcia, 
Julia Gluesing, Takashi Iba, Casper Lassenius, Chris-
tine Miller, Maria Paasivaara, Ken Riopelle

Subjects: Social and Information Networks (cs.SI)

Note: Selected papers will be published in a forthcom-
ing special issue of  International Journal of Organisa-
tional Design and Engineering. 
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COINS CONFERENCES WEBISTES

This Section  contains the links to the COINs 
Conference Websites

SECTION 1

COINs Conference                  
Websites
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COINs2009

http://www.coinsconference.org/coins09-savannah-usa/
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http://www.coinsconference.org/coins09-savannah-usa/
http://www.coinsconference.org/coins09-savannah-usa/


COINs2010

http://www.coinsconference.org/coins10-savannah-usa/
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http://www.coinsconference.org/coins10-savannah-usa/
http://www.coinsconference.org/coins10-savannah-usa/


COINs2011

http://www.coinsconference.org/coins11-basel-switzerland/
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http://www.coinsconference.org/coins10-savannah-usa/
http://www.coinsconference.org/coins10-savannah-usa/


COINs2015

http://www.coinsconference.org/coins15-tokyo-japan/
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http://www.coinsconference.org/coins15-tokyo-japan/
http://www.coinsconference.org/coins15-tokyo-japan/


COINs2016 will be held in Rome, Italy

When: Jun 8-10, 2016

Where: Tor Vergata University of Rome, Rome, Italy http://web.uniroma2.it

Papers: Paper submission deadline February 29, 2016

Workshops: Proposal submission deadline February 29, 2016

Artifacts: Proposal submission deadline February 29, 2016

Web: http://rome16.coinsconference.org

Conference Chair: Agostino La Bella (Tor Vergata University)

Local Chair: Andrea Fronzetti Colladon (Tor Vergata University)
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CHAPTER 17

Books

The following are recommended books.
Swarm Creativity
http://www.amazon.com/Swarm-Creativity-
Competitive-Collaborative-Innovation/dp/0
195304128/ref=sr_1_1?s=books&ie=UTF8&
qid=1347046646&sr=1-1&keywords=swarm
+creativity

http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
http://www.amazon.com/Swarm-Creativity-Competitive-Collaborative-Innovation/dp/0195304128/ref=sr_1_1?s=books&ie=UTF8&qid=1347046646&sr=1-1&keywords=swarm+creativity
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Coolhunting
http://www.amazon.com/Coolhunting-Chasing-Do
wn-Next-Thing/dp/0814473865/ref=pd_sim_b_1

Coolfarming
http://www.amazon.com/Coolfarming-Turn-Your-
Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2

http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolhunting-Chasing-Down-Next-Thing/dp/0814473865/ref=pd_sim_b_1
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2
http://www.amazon.com/Coolfarming-Turn-Your-Great-Thing/dp/B005DI9X98/ref=pd_sim_b_2


CHAPTER 18

Condor 
Converter

Condor Converter is java program that 
coverts older Condor 2.6.6 databases and 
datasets to the newer Condor 3 universal 
database and dataset format.

The program consists of two files:
1. A CondorConverter.jar,  and 
2.condorconverter.properties file. 
Both files need to be in the same folder.



Create a new folder, such as, CondorConverter and download 
the following two files into it:

a. Download the CondorConverter.jar at:

b. Download the Condor.properties file at:

Here is an example Condor 2.6.6 dataset conversion.

1. Start MySQL

2.Double click the CondorConverter.jar or start from the Ter-
minal app.

The CondorConverter Form Opens

2. Click on the DB to convert dropdown button and select your  
Condor 2.6.6. database to convert. In this example, I have 
selected the EnronSmall database. 

3. Note: the Recognized Type is indicated. Such as, MAIL, in 
this example.

4. Click New to create a new Condor 3 database, such as,  
EnronSmall2.

5.  Select the dataset(s) you wish to convert

6.Click Convert

7. A “100% Finish” message displays when completed.

8. Start Condor 3 

9. Click File > Switch database and choose your new database

10.Click File > Open dataset and your converted dataset(s) 
will open.
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CHAPTER 19

Frequently 
Asked 
Questions 
(FAQ)

The purpose of this chapter is to answer 
frequently asked Condor 3 questions.

Condor 3



Frequently asked Questions (FAQ)

1. How much time does it take to get started with 
Condor 3?

Answer: Getting started with Condor 3 requires roughly the 
following time commitments:

First, installing the Software and Keys (Chapters 3 & 4 for 
Mac users, or Chapters 5 & 6 for PC users):
a. 1-3 hours to install the prerequisite software of Java, 

MySQL, MySQL Workbench, and Condor 3 itself. 
b. Add another hour for Getting the Google CSE Key and 

the four Twitter Keys (Chapter 3 Sections 4 & 5).

Second, if needed, reviewing Social Network Basics takes 
about 30 minutes (Chapter 15).

Third reviewing the Condor 3 Menus and GUIs takes an-
other 1-2 hours (Chapters 7 & 8).

Fourth trying out a few examples takes another 2-3 hours 
(Chapter 9).

In sum, getting started from scratch takes about 5-10 hours 
depending upon your computer skills, internet speed and 
background in social networks.

You do not need to repeat any of the one-time software in-
stallation steps.

2.What is a typical error that users encounter 
when starting out working with Condor 3?

A typical error is not starting MySQL server first before 
starting Condor 3. If so, you get this error message. The 
text in Set Database credentials turns all red

To fix the error, simply start MySQL.
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3.How do you print a map or visualization?
There is no print function in Condor 3. You can take a 
screenshot or export the network as .CSV files (Node and 
Link) and use another network program to print your map.
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4.Can you run Condor 3 from an iPad, Android or 
Amazon Fire tablet?

First, there is no native Condor 3 iPad or Android app, BUT 
you can use a third party app, like Parallel’s Acess to connect 
to your computer and run Condor remotely.

5.Can Condor 3 run on Amazon Workspaces?
Yes, Condor 3 does run on a Amazon Workspaces and can be 
remotely controlled from a Mac, PC, iPad, Android or  
Amazon Fire tablet using AWS’s custom clients.
see: 
http://aws.amazon.com/workspaces/

https://clients.amazonworkspaces.com

Just setup an AWS Workspaces and following the Condor 3 
install instructions for a PC.

5.Is there a Server version of Condor 3?
Yes, Condor 3 is available in both a desktop version and a 
server version called CondorCore, which is expected to be re-
leased in 2015.

http://aws.amazon.com/workspaces/
http://aws.amazon.com/workspaces/
https://clients.amazonworkspaces.com
https://clients.amazonworkspaces.com
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